IMPORTANT!

You need to reinstall EPSON® Image Authentication System™ (IAS) on your camera if it was installed before your camera was repaired. Please see your EPSON Image Authentication System User’s Guide for instructions.

IAS software lets you check the authenticity of photos taken with your EPSON Photo PC® 700, 750Z, 800, or 850Z camera. IAS detects when even a single bit of digital data in a picture has been altered. If you don’t have IAS installed on your camera and would like to learn more about it, call 1-800-GO EPSON, or visit our website at http://www.epson.com.

CPD 8424R1
IMPORTANT NOTICE
DISCLAIMER OF WARRANTY
Epson America makes no representations or warranties, either express or implied, by or with respect to anything in this manual, and shall not be liable for any implied warranties of merchantability and fitness for a particular purpose or for any indirect, special, or consequential damages. Some states do not allow the exclusion of incidental or consequential damages, so this exclusion may not apply to you.

COPYRIGHT NOTICE
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Epson America, Inc. No patent liability is assumed with respect to the use of information contained herein. Nor is any liability assumed for damages resulting from the use of the information contained herein. Further, this publication and features described herein are subject to change without notice.

TRADEMARKS
EPSON and EPSON Stylus are registered trademarks of SEIKO EPSON CORPORATION.
PhotoPC is a registered trademark and EPSON FaxAdvice, EPSON Photo!3, HyPict, Solar Assist, and Image Authentication System are trademarks of Epson America, Inc. EPSON SoundAdvice is a service mark of Epson America, Inc.
CompactFlash is a trademark of SanDisk Corporation and has been licensed to CFA (CompactFlash Association).
Image Expert and Camio are trademarks of Sierra Imaging, Inc. in the United States and other countries and are used under license.

General notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. EPSON disclaims any and all rights in those marks.

A NOTE CONCERNING RESPONSIBLE USE OF COPYRIGHTED MATERIALS
Digital cameras and scanners, like photocopiers and conventional cameras, can be misused by improper copying of copyrighted material. While some countries' laws permit limited copying in certain circumstances, those circumstances may not be as broad as some people assume. EPSON encourages each user to be responsible and respectful of the copyright laws when using digital cameras and scanners.
Contents

Introduction
PhotoPC 850Z Features 2
Optional Accessories 4

1 Setting Up Your Camera and Software
Unpacking Your PhotoPC 850Z 1-1
Using Rechargeable NiMH Batteries 1-2
Charging Batteries 1-2
Installing Batteries 1-4
Battery Options 1-6
Attaching the Neck Strap 1-7
Installing Your Memory Card 1-8
Setting the Date and Time 1-10
Formatting Your Memory Card 1-12
Removing Your Memory Card 1-12
Choosing Your User Mode 1-13
Adjusting the Viewfinder Focus 1-14
Installing Your Software 1-15
Installing for Windows 1-15
Installing on a Macintosh 1-17

2 Taking Pictures
Using the Camera Dial 2-1
Reading the Status Display Panel 2-2
Taking Pictures With the Viewfinder 2-4
Taking Pictures With the LCD Screen 2-6
Setting Image Quality 2-10
Standard 2-10
Fine 2-11
Super Fine 2-11
HyPict 2-11
Using the Flash 2-12
Auto 2-12
 Forced Flash 2-12
Flash Off 2-12
Red-eye Reduction 2-12
Slow Synchronized Flash 2-13
Taking Pictures With the Timer 2-14
Taking Color or Black and White Pictures 2-15
Adding Sound to Pictures 2-16
Using Quick Playback 2-17
Deleting Pictures 2-19
Playing Audio Recordings 2-19

3 Setting Up Special Shots
Taking Quick Shots 3-1
Continuous Shooting 3-2
Continuous Shooting Using the Timer 3-3
Interval Shooting 3-4
Using Programmed Subject Settings 3-6

4 Framing, Focusing, and Zooming
Taking Digital Zoom Pictures 4-1
Taking Digital Panoramas 4-3
Taking Close-Ups With Macro Mode 4-4
Adjusting the Focus 4-5

5 Adjusting Exposure and Color Settings
Adjusting Exposure 5-1
Changing the Automatic Exposure Value 5-2
Setting Shutter Speed and Aperture 5-3
Using Aperture Priority and Shutter Priority Settings 5-4
Adjusting the Sensitivity Setting 5-6
Adjusting the White Balance Setting 5-8
Setting the Custom White Balance 5-10
Changing the Metering Method 5-11
Exposure and Color Tips 5-12

6 Playing Back Photos
Playing Back Pictures One by One 6-2
Playing Back Multiple Pictures 6-2
Deleting Pictures 6-3
Deleting the Currently Displayed Picture 6-3
Deleting All Pictures 6-4
Deleting Selected Pictures 6-5
Locking Pictures 6-6
Unlocking Pictures 6-8
Adding Audio Recordings 6-9
Playing Back Recordings 6-10
Deleting Audio Recordings 6-11
Magnifying a Picture 6-12
Viewing Picture Information 6-13
Playing Your Pictures as a Slide Show 6-14
Playing Sounds With Your Slide Show 6-15
Excluding Pictures From a Slide Show 6-16
Rotating Pictures in a Slide Show 6-17
Playing Back Pictures on TV 6-18
7 Adjusting Camera Settings

Setting the Auto Power Off Time 7-1
Adjusting the LCD Brightness 7-3
Turning the Camera Alert Sounds On or Off 7-3
Setting the Camera Volume 7-4
Setting the Time and Date 7-4
Setting the Language 7-5
Setting the Broadcast Signal System 7-6

8 Getting Photos Into Your Computer

Connecting the Camera 8-1
Connecting to a Windows PC 8-2
Connecting to a Macintosh 8-3
Connecting the Camera with the USB Cable 8-4
Transferring Photos and Audio Files 8-6
What To Do if You See an Error Message 8-9
Getting Images Into TWAIN-Compliant Applications 8-10
Getting Images That You Can Import 8-12
What To Do If the Camera Is Not Responding 8-14

9 Getting Your Photos Into Documents

Importing Images Into Documents 9-2
Getting Images With Copy and Paste 9-3
Using Drag and Drop From an Album (Windows Only) 9-4
Getting Images With the Camio Viewer (Windows) 9-6
Dragging and Dropping a Picture Into a Document 9-7
Transferring Images Before Placing Them 9-8

10 Working With Photos and Albums

Organizing Image Expert Albums 10-2
Copying and Moving Pictures in Albums 10-2
Renaming a Picture 10-3
Viewing Picture Information 10-3
Printing an Image or Album 10-4
Choosing the Layout Style 10-5
Adding Text 10-6
Choosing Album Images 10-7
Adjusting the Printed Area 10-7
Adding Audio to an Image 10-8
Playing Back Sounds 10-9
Editing Sounds 10-10
Deleting Sounds 10-10
Displaying Albums as Slide Shows 10-11
Using an Album as a Screen Saver 10-12
Setting an Image as Wallpaper 10-12
Copying to Diskette or Zip Disk 10-13
  Viewing the Pictures on Diskette or Zip Disk 10-14
  Sending Pictures and Sound by E-mail 10-15

11 Editing Images
  Viewing and Selecting Images 11-2
  Applying Quick Fix 11-3
  Correcting an Image 11-3
  Cropping an Image 11-5
  Resizing an Image 11-5
  Rotating an Image 11-6
  Flipping an Image 11-7
  Applying Special Effects 11-8
  Changing the Number of Colors 11-9

12 Operating the Camera From Your Computer
  Taking Pictures From Your Computer With Image Expert 12-1
  Using the Self Timer 12-3
  Taking Pictures With EPSON Photo!3 12-4
  Adjusting Camera Settings From Your Computer
    Changing Settings With Image Expert 12-5
    Changing Settings With EPSON Photo!3 12-7

13 Using Your Camera for Presentations
  Uploading Images to the Camera 13-1
    Uploading Images From Your Windows PC 13-2
    Uploading Images From Your Macintosh 13-5
  Converting Presentations 13-8
    Capturing Windows Screens 13-8
    Capturing Macintosh Screens 13-10
  Projecting Your Presentation 13-11

14 Printing Directly From the Camera
  Connecting the Camera to the Printer 14-2
  Starting Direct Print 14-3
  Printing
    Printing Single and Multiple Images 14-4
    Producing Your Printout 14-7
    Printing a Card 14-9
    Printing Album Images 14-11
    Printing Stickers 14-12
    Printing an Index of Your Images 14-14
  Removing the Direct Print Program 14-16
  Reinstalling the Direct Print Program 14-16
  Reading Error and Status Messages 14-17
15 Creating DPOF Files for Processing

Introduction to the DPOF Standard 15-1
Making the DPOF File 15-2
Confirming and Changing the DPOF File 15-5
Deleting the DPOF File 15-6
Removing the Print Mark Program 15-6
Reinstalling the Print Mark Program 15-7
Reading Error Messages 15-8

16 Maintenance and Troubleshooting

Caring for the Camera and Battery Charger 16-1
Cleaning the Camera and Battery Charger 16-1
Storing the Camera 16-2
Solving Camera Problems 16-2
Solving Picture Problems 16-9
Where To Get Help 16-12
Software Support 16-13
Software Licensing 16-13

A Optional Accessories

Using the Optional AC Adapter A-2
Using a Tripod A-3
Attaching an Optional Converter Lens A-4
Attaching an Optional Flash A-5
Using a PCMCIA Adapter A-7
Installing the PCMCIA Adapter A-7
Transferring Photos With the Adapter A-8
Image Authentication System A-8

B Specifications

Camera B-1
Physical Dimensions B-1
Power B-1
Technical B-2
Environmental B-3
Safety B-3
Photographic B-3
Photo Processing Time (approximate) B-4
Memory Card Picture Capacity B-5
NiMH Battery Charger B-5
Physical Dimensions B-5
Technical B-5
Optional Universal AC Adapter B-5
Physical Dimensions B-5
Technical B-5
CompactFlash Card B-6
Storage Capacity B-6
Physical Dimensions B-6
Minimum System Requirements  B-6
Windows Systems  B-6
Macintosh Systems  B-6

C  Regulatory Information and Warranty

Safety Instructions  C-1
Declaration of Conformity  C-4
FCC Compliance Statement  C-5
Warranty  C-6

Index
Your new EPSON® PhotoPC® 850Z is a high resolution, two megapixel, USB and serial digital camera with 3x optical zoom. It includes three different user modes with three levels of control: a manual mode for expert photographers, a programmed mode that gives you control of your shots and saves time, and a fully automatic point-and-shoot mode for no-fuss photography.

The PhotoPC 850Z comes with a built-in microphone and speaker that let you add and play voice messages. Your camera puts you in control of all your shots with exposure, flash, white balance, metering, and focus settings.
The PhotoPC 850Z captures images at 1600 × 1200 pixel resolution in 24-bit color, using a 2.11 megapixel CCD sensor. With EPSON’s HyPict™ image enhancement technology, the images can be interpolated to 1984 × 1488 pixels right inside the camera.

Your PhotoPC 850Z comes complete with cables, batteries, battery charger, neck strap, and 8MB CompactFlash™ memory card. It also comes with a CD-ROM with software and utilities for downloading, editing, organizing, and printing your pictures.

**PhotoPC 850Z Features**

PhotoPC 850Z is a complete system for capturing digital images, and includes the following features:

- 2.11 million pixel CCD sensor
- 3× optical zoom
- Resolutions of 1600 × 1200 pixels, and up to 1984 × 1488 pixels (interpolated) using EPSON’s HyPict image enhancement technology
- 24-bit color or monochrome image capture
- High-speed image processing (one second per image in quick shot mode)
- 8MB EPSON CompactFlash card that holds approximately 24 fine-resolution or 120 standard-resolution images
- Built-in microphone and speaker that let you record and play back an audio recording of up to 10 seconds for each picture
- 2.0-inch, low-temperature, poly-silicon TFT color LCD screen that supports instant preview, playback, delete, and power save mode and has a power-saving Solar Assist™ panel
- Capability to print directly to several EPSON ink jet printers—without using a computer
Video and audio output for playing your pictures back on a TV, VCR, or projector

Macro, 2× digital zoom, panorama, quick shot mode, and interval and continuous shooting

Adjustments for white balance, exposure, sensitivity, aperture, shutter, and focus

Built-in flash with leading and trailing slow synchronized modes for night photography and action photos

Four rechargeable NiMH AA batteries and a fast charger

Automatic shut-off to save batteries

Automatic date and time recording for each picture

Serial and USB cables for transferring photos to your Windows® or Macintosh® computer

Fully USB-compatible

Your camera comes with the PhotoPC 850Z software suite, which includes the following applications for both PC and Macintosh users:

Sierra Imaging Image Expert™ software for transferring, organizing, editing, and printing your pictures

The EPSON Photo!3™ application and TWAIN driver for transferring your pictures

EPSON Photo File Uploader for converting presentation slides into image files and uploading them to your camera

EPSON Photo Program Uploader for installing the Direct Print and Print Mark programs on your camera (Direct Print lets you print directly from the camera to a number of EPSON ink jet printers and Print Mark lets you create DPOF files to give to your local photo finishing lab.)
Optional Accessories

EPSON offers these accessories for the PhotoPC 850Z:

- Universal AC adapter (B867081) for use with any standard (100 to 240 V) electrical outlet
- Additional or replacement NiMH rechargeable batteries (B818113)
- Additional or replacement universal NiMH Power Pak, which includes batteries and charger (B818172)
- EPSON Image Authentication System™ (IAS) software (PPC8–IAS)

Your camera is also compatible with a range of options that can enhance your shots and store more images. You can attach an optional flash to the camera’s hot shoe for portrait photos or photos in places that are dimly lit. You can use the camera with optional lenses for your specialized shots. You can also obtain additional Type I or Type II CompactFlash memory cards and PCMCIA adapters made by leading suppliers, such as Lexar Media,™ Delkin Devices,™ and SanDisk.®

NOTE

Please take a minute to fill out the registration card for the PhotoPC 850Z digital camera and mail it back to us. This enables you to receive special information on accessories, new products, and software upgrades. You'll get immediate attention if you have a problem with your PhotoPC 850Z.
Setting Up Your Camera and Software

Before you can start using your PhotoPC 850Z, you need to charge the batteries. You must also format your CompactFlash memory card and prepare the camera. This chapter describes the following:

- Unpacking your PhotoPC 850Z
- Using rechargeable NiMH batteries
- Attaching the neck strap
- Installing the CompactFlash memory card
- Setting the date and time
- Formatting your memory card
- Removing your memory card
- Choosing your user mode
- Adjusting the viewfinder focus
- Installing your PhotoPC 850Z software

Unpacking Your PhotoPC 850Z

Make sure you have all the parts shown below.
Using Rechargeable NiMH Batteries

Your PhotoPC 850Z comes with a charger and four rechargeable NiMH batteries that can be recharged hundreds of times.

NOTE

New batteries need to be fully charged three times before you use them. This process takes approximately five or six hours—but you only need to do it once. When you need to recharge your batteries in the future, it takes approximately two and a half hours for a full charge.

Charging Batteries

It’s important to fully charge your batteries, so they will last as long as possible before they need recharging.

WARNING

Shock hazard. Make sure you use the charger only with EPSON rechargeable NiMH batteries (model EU-24). To avoid the danger of leakage or explosion, do not place any other batteries in the charger. Read all safety and handling instructions in the Introduction of this guide before using the charger.

Follow these steps to charge your batteries for the first time:

1. Insert all four batteries, positioning the + and – ends as shown.
2. Connect the battery charger to its power cord, as shown below.

3. Plug the charger into an electrical outlet. The charger light turns red, indicating that the charger is working. When the batteries are charged, after about two and a half hours, the light goes off.

**NOTE**
The charger light flashes to indicate changes in battery temperature and voltage. If the light continues to flash for more than half an hour, the batteries may be damaged or worn out, and should be replaced. Unplug the charger if the batteries are not fully charged after four hours.

4. Now charge your batteries again by unplugging the battery power cord and then plugging it in again.

5. Charge the batteries a third time. After the charger light goes off, unplug the charger. To avoid overcharging, don’t leave the charger plugged in for long periods of time after the light goes off.

6. Wait one hour until the batteries cool before removing them from the charger.

**WARNING**
Batteries are very hot (149 °F [65 °C]) after charging.

7. Before storing the charger, disconnect the power cord and remove the batteries.

(For subsequent charges of your NiMH rechargeable batteries, follow steps 1 through 3, then unplug the charger and follow steps 6 and 7 above.)
Be sure to charge the batteries completely to make them last as long as possible. They can be recharged hundreds of times, so do not dispose of them until they are worn out.

NOTE
To keep the charger terminals clean, unplug the charger and wipe the terminals with a dry cloth. Make sure you charge the batteries before you use them. If you find that your batteries run out faster after you recharge them a few times, make sure you discharge them completely before recharging. If this doesn’t help, replace the batteries.

Installing Batteries
Before you install the batteries, make sure the camera dial is turned to Off.

1  Turn the camera upside down.

2  Hold the battery cover lock down and slide the cover out to open it.
3 Insert four batteries into the compartment, positioning the + and − ends as shown below.

4 Lower the battery cover and slide it in, as shown below.

When the battery power is almost out, a low battery icon appears on the camera’s display panel. Be sure to replace all four batteries at the same time.
Battery Options

If you forget to charge your rechargeable NiMH batteries or if they need to be replaced, the PhotoPC 850Z camera can also accept the following:

- Rechargeable AA NiCad batteries
- Single-use AA lithium batteries (longer life, Energizer® recommended)
- Single-use AA alkaline batteries

WARNING
To avoid the danger of fire or explosion, do not mix different types of batteries. Do not allow the battery contacts to touch metal objects such as coins or keys, which could short out the battery. Read all safety and handling instructions before using batteries.

Note the following when handling batteries:

- Use only the EPSON battery charger (Model EU-38) to charge the batteries that came with your camera.
- Use the batteries that came with your camera only in EPSON digital cameras.
- Do not use manganese batteries.
- Do not mix different types of batteries; this can cause fire or explosion.
- Replace all four batteries at the same time. Do not mix old and new batteries.
- Batteries that have not been used for a long time do not charge well. However, with regular use, the batteries will return to normal.
- Batteries discharge at least 2% per day, whether they are used or not.
- If the batteries are charged in a hot environment, or if they are charged repeatedly without being discharged, they will wear out more quickly.
Do not drop, puncture, disassemble, or mutilate batteries. Do not get them wet or expose them to fire.

When the camera is not used for long periods of time, remove the batteries and store them at a low temperature in a dry location. Store away from the reach of children.

To avoid fire or electric shock, do not use batteries that are leaking or damaged in any way.

If battery acid gets in your eyes or on your skin, immediately rinse the area with water and seek medical treatment. If a battery is swallowed, seek medical treatment immediately.

Dispose of used batteries according to the manufacturer’s instructions and in compliance with all applicable laws. Contact your local government agency for information about battery recycling and disposal.

Battery life varies depending on the battery type, the manufacturer, and other factors.

---

**Attaching the Neck Strap**

Your camera includes a neck strap that attaches to the camera to make it easier to carry.

**WARNING**

To avoid damaging the camera or other objects, do not swing the camera about. Keep the strap away from children. Do not pull or tighten the strap too firmly while wearing it around your hand or neck; this can cause serious injury.
To attach the neck strap, follow these steps:

1. Pass one end of the strap through one of the eyelets on the sides of the camera.

2. Pass the strap through the clamp to secure it.

3. Attach the other end of the strap to the eyelet on the other side of the camera in the same way.

Installing Your Memory Card

Your camera comes with an 8MB CompactFlash memory card that needs to be in the camera to take photos. This card stores your photographs until you transfer them to your computer and delete them.

You can purchase additional memory cards (4MB to 96MB) from leading suppliers like Lexar Media, Delkin Devices, and SanDisk. See page A-7 for more information.

NOTE
The CompactFlash card slot is Type I and Type II compatible.

1. Make sure the camera dial is turned to Off. (To change the dial setting, press the white dial lock in and turn the dial.)
2. Place your thumb or index finger behind the memory card cover latch and pull the cover open.

3. Insert the card all the way into the memory card slot. Make sure the front of the card is facing the same direction as the front of the camera, and the arrow on the card’s label is pointing in.
4  As you insert the card, the eject button pops out. Flip the eject button up and close the memory card cover.

The camera’s date and time need to be set before you can format the memory card.

Setting the Date and Time

Before you use the camera, you need to set its clock. Then the camera will automatically record the date and time for each picture you take. You may need to set the clock again if you don’t use it for extended periods of time.

NOTE
You can also set the camera’s clock through your computer. See page 8-1 for instructions on connecting the camera to your computer, and page 7-4 for instructions on setting the date and time.
Follow these steps to set the date and time:

1. Push the camera dial lock in and turn the camera dial to 1.

2. You see the clock setting screen with the year highlighted in red.

3. Press the + or – button (next to the up and down arrows) to increase or decrease the number, until the year is correct.

4. Press the ISO button (below the left arrow) to select the month and day. Press the W.B. button (below the right arrow) to select the time. Make adjustments as described in the previous step.

5. When you’re finished, press the bottom left button (next to SET). You see the SETUP menu.

Now you’re ready to format the memory card.
Formatting Your Memory Card

You should format your card before you use it. Follow these steps:

1. Turn the camera dial to 1. You see the SETUP menu. Then press the bottom right button (below Memory SETUP). The Memory Card Format menu appears if a memory card is correctly installed in the camera.

2. Press the top left button (next to MEMORY CARD FORMAT) to format the card. You see a message warning you that all data on the card will be deleted.

3. Press the button next to Yes to format the card, or the button next to No to cancel.

Removing Your Memory Card

Turn your camera dial to Off before you remove the card.

CAUTION
Never remove the card while the camera is on. Data in the card may be lost or damaged.

1. Place your thumb or index finger behind the memory card cover latch and pull the cover open.
2 Flip the eject button down and push it in to release the card. Then pull the card out and close the cover.

Choosing Your User Mode

The PhotoPC 850Z has three user modes to give you different levels of control over the camera settings. To use the more advanced features, such as white balance and exposure adjustment, you must be in Program mode or Manual mode.

Full Auto The camera chooses most settings for you. This mode is the default. You can simply point and shoot, or you can adjust some basic settings (for example: image quality, digital zoom, macro mode and panoramic mode).

Program This setting is recommended for photographers who want a moderate amount of control over the camera’s functions. Programmed subjects (Normal, Sports, Portrait, and Landscape) tailor your camera settings to the type of picture you’re taking. You can also use the LCD menus to make your own adjustments to sensitivity, white balance, and exposure.
Manual  This mode is for experienced photographers who want complete control over the camera’s wide array of settings and features. In addition to changing sensitivity and white balance, you can adjust the shutter speed and aperture, choose a spot or matrix metering system, and focus the camera to three feet, ten feet, or infinity.

Follow these steps to choose the camera mode:

1. Push the camera dial lock in and turn the dial to 1.
   You see the SETUP menu:

2. Press the + button to cycle through the three modes.

Adjusting the Viewfinder Focus

You can adjust the viewfinder’s focus using the diopter. This is useful if you wear glasses and want to take pictures with the viewfinder. Follow these steps:

1. Turn your camera dial to 1.

2. Look through the viewfinder and turn the diopter dial until you have a clear view.

NOTE
The viewfinder will not focus when the camera is turned off. Make sure the camera is turned on to adjust the diopter.
Installing Your Software

PhotoPC 850Z comes with everything you need to transfer your pictures from the camera to your computer, and then organize, enhance, and share them. You can also upload pictures and presentations to the camera. The CD-ROM has these applications for Windows and Macintosh:

- Sierra Imaging Image Expert
- EPSON Photo!3 TWAIN and standalone application and EPSON Photo!3 Program Uploader
- EPSON Photo File Uploader

Installing for Windows

You can install the software on your Windows 98, Windows 95, or Windows NT® 4.0 system. (See page B-6 for minimum system requirements.)

NOTE

If you are asked to restart your computer after any installations, you can cancel and wait to restart until you have installed all the PhotoPC 850Z applications.

Follow these steps:

1. Insert the CD-ROM in your drive. The install program starts automatically.

   If it doesn’t start automatically, double-click My Computer. Then double-click your CD-ROM icon.

2. When you see the following screen, click the Install Image Expert button.

3. Follow the instructions on the screen to install Image Expert. When installation is complete, you return to the Setup screen.

Setting Up Your Camera and Software 1-15
4 Click the Install EPSON Photo!3 and Program Uploader button. Follow the instructions on the screen.

5 When you return to the Setup screen, click the Install EPSON Photo File Uploader button. Follow the instructions on the screen.

6 When installation is complete, click Exit.

7 Restart your computer.

**Installing Your Windows 98 USB Driver**

If you’re installing on a Windows 98 system with a USB port, complete the steps above to install your software. The first time you connect the camera to your computer with your USB cable, you’ll see the Add New Hardware Wizard. (See page 8-1 if you need help connecting the camera.)

---

**NOTE**

You may need your Windows 98 system disk for this installation.

---

Follow these steps to install the driver for your camera:

1 Insert your PhotoPC 850Z CD-ROM in your drive.

2 At the first screen in the Add New Hardware Wizard, click Next.

3 Select Search for the best driver for your device, then click Next.

4 Select Specify a location and browse to your CD-ROM drive.

5 Select the Win98E folder if you’re installing the English driver (or the Win98S folder to install the Spanish driver, or the Win98F folder to install the French driver). Click OK.

6 On the following screen, click Next. The wizard locates your camera’s driver.

7 Click Next on the installation screen to install the driver. When installation is complete, click Finish.
Installing on a Macintosh
You can install all the software on your PowerPC™, Power Macintosh® G3, or iMac™ computer. (See page B-6 for minimum system requirements.)

NOTE
◗ If your iMac is running OS 8.1, you’ll need to update your operating system before installing your camera software. Download and install the iMac Update 1.0 or later from Apple® at http://swupdates.info.apple.com. Contact Apple if you have problems installing the update. If your iMac is running OS 8.5 or 8.51, Apple recommends that you download and install iMac Update 1.1. (To find out which operating system your iMac is running, select About This Computer in the Apple menu.)
◗ If you are asked to restart your computer after any installations, you can quit and wait to restart until you have installed all the PhotoPC 850Z applications.

Follow these steps:

1 Insert the CD-ROM in your drive.

2 If necessary, double-click the CD-ROM icon to open it and open the folder for the language you want to use.

3 Double-click the Install Image Expert icon. Click Continue and follow the instructions on the screen.

4 If necessary, open the folder for your language. Then open the EPSON Photo!3 Ver. 1 folder.

5 Double-click the Photo!3 Installer – Part 1 icon and follow the instructions on the screen.

6 If necessary, open the folder for your language. Then open the EPSON Photo File Uploader folder.

7 Double-click the EPSON Photo File Uploader 3 Install icon and follow the instructions on the screen.

8 Restart your computer.

To automatically create preferences for the EPSON Photo File Uploader, start the EPSON Photo!3 program, then close it. You need these preferences to run Photo File Uploader.
Taking Pictures with the PhotoPC 850Z is similar to using a traditional camera. This chapter gives the following basic information for taking pictures:

- Using the camera dial
- Reading the status display panel
- Taking pictures with the viewfinder
- Taking pictures with the LCD screen
- Setting image quality
- Using the flash
- Taking pictures with the timer
- Taking color or black and white images
- Adding sounds to images
- Using quick playback

Using the Camera Dial

The camera dial has an Off position and six other settings: three for taking pictures, and three for performing other functions, such as setting up your photos or playing them back on the LCD screen.

When the dial is in the Off position, press the white dial lock in to turn the dial. (You don’t need to press the dial lock in when another setting is selected.)
Camera dial settings include the following:

- Use this setting for continuous and interval shooting. See pages 3-2 through 3-6 for details.
- Use this setting to take photos with the LCD screen. See page 2-6 for details.
- Use this setting to take photos with the optical viewfinder. See page 2-4 for details.
- Use this setting to play back, delete, and add audio recording to your photos. See Chapter 6 for details.
- Use this setting to print directly from your camera to an EPSON ink jet printer. See Chapter 14. Also use it to create DPOF files with the Print Mark program. See Chapter 15.
- Use this setting to set up or view information about your camera on the Setup screen. See Chapter 7 for information.

### Reading the Status Display Panel

When your camera dial is turned to , , or , the status display panel (on the top of the camera) shows the camera’s current settings and how many additional pictures you can take.

### Checking the Battery

When your battery power is almost out, the low battery icon appears on the display panel. The icon flashes when your battery power is completely out.
You need to recharge or replace the batteries or use the optional universal AC adapter when you see the low battery icon. Although you may be able to use the camera with low batteries, it needs full battery power to operate reliably.

Several factors can affect battery life, including the surrounding temperature and the type of batteries you use. Low temperatures—especially below 50 °F (10 °C)—drain batteries faster. See page 1-2 for battery use instructions.

Checking the Picture Counter
The large number in the lower right of the status display panel shows how many additional pictures you can take.

This number is affected by the image quality setting. Also, if you have any audio recordings stored on your memory card, the number on the display panel may be greater than the actual number of remaining pictures.

When the memory card is full, the number on the display panel reads 0, the status light on the back of the camera flashes orange, and you can no longer use the shutter button.

Before you can take any more pictures, you need to delete some of the images on the memory card. (See page 6-3 for instructions.)

If you want to save your photos before you delete them, connect the camera to your computer and transfer the pictures as described in Chapter 6.

Instead of the number of pictures remaining, you may see one of the following in the lower right corner of the status display panel:

- In quick shot mode, the number of photos taken is displayed in brackets.

- In Program or Manual mode, the exposure value appears on the left and the shutter speed appears on the right when you hold the shutter button down halfway. See page 1-13 for more information about user modes.
When you turn the camera’s dial to **SET** is displayed. No other information appears in the status display panel.

While you make an audio recording, **rEc** appears in this space.

While you take photos using the interval shooting feature, **Int** appears on the display panel.

---

**Taking Pictures With the Viewfinder**

You can capture an image as you would with any point-and-shoot auto-focus camera: look through the optical viewfinder and press the two-step shutter.

---

**NOTE**

One advantage of the optical viewfinder is that it uses less battery power than taking pictures with the LCD screen. However, you need to use the LCD screen when you make audio recordings or use the panorama, macro, and digital zoom features.
Follow these steps:

1. Make sure you are at least 20 inches (50 cm) away from your subject. (If you want to get closer, use macro mode as described on page 4-4.)

2. Turn the camera dial to \( \mathcal{C} \) and wait until the photo capture light turns green.

3. Use the camera’s control buttons to make any changes you want to image quality, the flash, or other basic settings. (Instructions for changing basic settings start on page 2-10.)

4. Look straight through the viewfinder and center your subject within the cross-hairs.

5. Push the optical zoom control to the left (counterclockwise) to zoom in on your subject, or to the right (clockwise) to zoom out.

6. Hold the shutter button halfway down to lock the auto focus. The photo capture light flashes until the lens locks in focus and the camera adjusts the exposure.
While holding down the shutter button, you can reframe your picture and move your subject off-center if you want.

7 Press the shutter button the rest of the way down to take the picture.

8 Hold the camera still until it clicks, then release the shutter button.

NOTE
You may notice a brief delay between the time you press the shutter button and when the camera clicks. To avoid blurring your images, make sure you hold the camera still until it clicks.

After you take a picture, the photo capture light flashes. This indicates that the image was captured and the camera is processing it. When the light stops flashing, the image is saved.

CAUTION
If you set the camera down while the light is still flashing, make sure you handle it carefully. The camera may lose your image if you set it down too hard.

Saved images remain on the memory card even when you turn the camera off or remove the memory card or the batteries.

Taking Pictures With the LCD Screen

The LCD screen lets you see a live preview of what the camera’s lens sees at any moment. Although you can use this setting anytime, you always choose it when you want to use the macro, panorama, or digital zoom features; or when you want to make audio recordings to go with your photos.

NOTE
Before you begin to take pictures, you can use the SETUP menu to turn on audio recording. See page 2-16 for details.
Follow these steps:

1. Make sure you are at least 20 inches (50 cm) away from your subject. (If you want to get closer, use macro mode as described on page 4-4.)

2. Turn the camera dial to \( \mathcal{A} \) to see the View menu. Wait until the camera status light turns green.

You see a preview of your picture on the LCD screen, with the image quality and flash settings in the upper right corner of the screen.

The following screen illustrates what you see if your camera is set to Full Auto user mode, the default setting. The settings look different if you’re using Program or Manual user mode. See page 1-13 to change your setting.
2-8   Taking Pictures

NOTE
If you're using batteries, the camera shuts off automatically after a designated period of inactivity. (The default is 30 seconds. See page 7-1 for instructions on setting the power off interval.) If the image on your LCD screen disappears, press the shutter button to “wake” the camera.

3  Using the preview image to guide you, make changes to the settings on the View menu, if you like.

See Chapter 3 for special shots, see Chapter 4 for framing, focusing, and zooming shots, or see Chapter 5 for color and exposure settings.

NOTE
You can also use the camera’s buttons to change the image quality, flash, or timer. (See the following sections in this chapter for details on these settings.)

4  Push the optical zoom control to the left (counterclockwise) to zoom in on your subject, or to the right (clockwise) to zoom out.

5  Center your subject on the screen, then press the shutter button halfway down to lock the auto focus and exposure.

The camera status light stops flashing and you see a green circle on the screen when the lens locks in focus and the camera locks its exposure settings. While holding the shutter button down, you can reframe your picture if you want.
6 Press the shutter button the rest of the way down to take the picture.

7 Hold the camera still until it clicks. Then release the shutter button. (You may notice a brief delay between the time you press the shutter button and when the camera clicks. To avoid blurring your images, make sure you hold the camera still until it clicks.)

After a few seconds, you see a confirmation screen.

NOTE
You can press the button next to Delete if you don’t want the picture. You can also delete pictures in quick playback (see page 2-19) and in playback mode. (See Chapter 6.)

When the camera status light stops flashing, you’re ready to take another picture. Or, if you’ve turned recording on, you see a countdown of the recording time on the screen. During this time, you can record sound into the microphone on the back of the camera. (See page 2-16 for more information on recording audio.)
NOTE

The LCD screen uses up battery power quickly. If it’s idle for more than the designated power off time, the camera turns off automatically. To turn it back on, press the shutter button, or turn the camera dial to Off and then back to . See page 7-1 to change the power off time.

Even if you don’t speak into the microphone, your camera records ambient noise when audio recording is turned on, and your images take up more space on the memory card. To fit more images on your memory card, make sure you turn recording off when you no longer want to use it.

Setting Image Quality

The PhotoPC 850Z has four image quality (resolution) settings. Press the image quality button on top of the camera to cycle from one setting to the other.

NOTE

The camera dial must be turned to , , or .

The image quality icons appear on the status display panel as described below.

Standard

★ Produces color or black and white images at 640 × 480 pixels. The CompactFlash card holds approximately 120 standard image quality pictures without audio recordings, but the images include less detail when enlarged. This setting is good for pictures that are viewed on screen or on the Internet.
Taking Pictures 2-11

**Fine**

★★ Produces color or black and white images at 1600 × 1200 pixels, with moderate compression. Your pictures include ample detail, and the CompactFlash card holds approximately 24 pictures without audio recordings. These images are best for 4 × 6-inch prints.

**Super Fine**

★★★ Produces color or black and white images at 1600 × 1200 pixels with low compression. Your pictures include greater detail, and the CompactFlash card holds approximately 12 pictures. With less compression, super fine images are better for enlarging for up to 8 × 10-inch prints.

**HyPict**

★★★★ Produces color or black and white images at 1984 × 1488 pixels (interpolated) with moderate compression. Your pictures include excellent detail, and the CompactFlash card holds approximately 10 HyPict pictures. These images are best for enlarging for 11 × 14-inch prints.

The illustration below is an example of how a close-up section of an image might appear at different resolutions:
Using the Flash

The camera’s built-in flash is effective within the range of 8 inches to 8 feet. Press the flash button to cycle through the five flash settings.

An icon for each setting appears on the status display panel, as shown below:

**Auto**

The flash goes off automatically whenever it’s needed for adequate lighting (default setting).

**Forced Flash**

The flash goes off with every picture you take. Use this setting to compensate for backlighting (when you are facing a light source).

**Flash Off**

The flash is disabled, even when lighting is inadequate. Use this setting for special effects, where flash photography is prohibited, or for macro mode close-ups.

**Red-eye Reduction**

Use this setting to eliminate the red-eye effect (the reddish reflection of the flash in your subjects’ pupils) that flash photography often produces.

Your camera has a hot shoe to attach an optional external flash. See Appendix A for more information on where to buy and how to attach an external flash.

**NOTE**

The camera dial must be turned to , , or . You can’t use the flash in continuous shooting mode.
Slow Synchronized Flash

To light up the background as well as your subject, use the leading slow synchronized flash mode when taking pictures at night. Or, use the trailing slow synchronized flash mode for capturing motion. Slow synchronized flash causes the aperture to stay open longer, allowing more light to enter the camera.

Changing the Slow Synchronized Flash Setting

Follow these steps to change the setting:

1. Turn the camera dial to \textcircled{1}. You see the SETUP menu.

2. Press the lower left (Shot SETUP) button.

3. Press the upper left button to change to \textit{Leading} or \textit{Trailing}.

4. Press the \textit{BACK} button to return to the SETUP menu.

\textbf{NOTE}\n
Slow synchronized flash is available only in the Program or Manual user modes. See page 1-13 for information about changing the user mode.

After you take a picture with the flash, the flash icon blinks until it is fully recharged. Your flash setting remains in effect even after you turn off the camera.
Taking Pictures With the Timer

Setting the timer creates a 10-second delay between the time you press the shutter button and the actual image capture. This allows you to take a picture of yourself.

NOTE
You can also combine continuous or interval shooting with the timer for delayed automatic capture of images. This allows you to photograph yourself in motion. See Chapter 3 for more information.

Follow these steps to take a single picture with the timer:

1. Secure the camera on a flat surface or on a tripod. (See page A-3 for information on attaching the camera to a tripod.)

2. Turn the camera’s dial to . Then wait until the photo capture light turns green.

3. Press the timer button on the top of the camera. The timer icon appears in the status display panel.

4. Press the shutter button . The timer icon and the red timer light on the front of the camera flash slowly for eight seconds. Then they flash rapidly for two seconds before the shutter is released.

TIPS

- When you’re using the flash off setting, hold the camera steady or use a tripod to avoid capturing blurry images.
- When you’re taking pictures outdoors, make sure the sun is at your back. In very bright light (at the beach or in snow, for example), your pictures may come out too light. You can adjust the exposure manually to reduce the amount of light entering the camera before you capture images. See page 5-11 for instructions.
The camera clicks when the image is captured. The status light on the back of the camera flashes green as the PhotoPC 850Z processes the image(s).

**NOTE**
To cancel a picture after you’ve pressed the shutter button, press the shutter button again, or press the button.

### Taking Color or Black and White Pictures

You use the Shot SETUP menu to switch between color and black and white pictures.

**NOTE**
There is no difference between the file sizes of color and black and white pictures.

Follow these steps:

1. Turn the camera dial to . You see the SETUP menu.

2. Press the lower left (Shot SETUP) button. You see the Shot SETUP menu.
3. Press the lower left button to change to B/W (monochrome) or Color.

4. Press the BACK button to return to the SETUP menu.

Adding Sound to Pictures

Your camera has a built-in microphone that lets you add an audio recording of up to 10 seconds to each photo. You can make a recording immediately after shooting a photo, or add it later. (For information about adding a recording later, see page 6-9. For instructions on playing back recordings with your camera, see page 2-19.) You can record audio in any user mode.

NOTE
You can only record audio when the LCD screen is turned on. You can’t record audio when taking quick shots.

Follow these steps to add a recording right after taking a picture:

1. Turn the camera dial to \( \text{\textcircled{1}} \) to display the SETUP menu.

2. Press the ISO button (under Camera SETUP). You see the Camera SETUP menu. The current audio setting appears at the bottom of the screen under Rec.
3 Press the W.B. button (under Rec) to choose a different setting. You can record a 3, 5, or 10-second message, or turn recording off.

4 Turn the camera dial to ♂. Center the subject on the LCD screen.

5 Press the shutter button halfway down to lock the auto focus.

6 When the camera status light stops flashing and you see a green circle ○ on the screen, press the shutter button the rest of the way down.

7 Hold the camera still until it clicks. Then release the shutter button.

   After a moment, you see a confirmation message. Then you see the message Sound recording... and a countdown of the recording time.

8 Speak clearly into the microphone. You see another confirmation message indicating that the recording was successful.

Now you can play back your recording. See page 2-19 for instructions.

NOTE
Even if you don’t speak into the microphone, your camera records ambient noise when recording is turned on, and your images take up more space on the memory card. To fit more images on your memory card, make sure you turn recording off when you no longer want to use it. See page 6-11 for instructions on deleting sounds.

Using Quick Playback
You can play your images back quickly, without turning your camera off. The quick playback menu allows you to view your photos, play back audio, and delete individual photos.

NOTE
You can also see your pictures in the camera’s playback menu, with more options such as displaying a slide show, locking and unlocking photos, recording and deleting sounds. See Chapter 6.
Follow these steps to play back your images:

1. Turn the camera dial to 📷.

2. If you are taking pictures in Full Auto or Program mode, press the top left button (next to the 📷 icon).
   If you are taking pictures in Manual mode, press the bottom right button (under Menu Change). From the next menu, press the top left button (next to the 📷 icon).

You see the quick playback screen displaying the last picture you took:

3. Press the + button (next to the right arrow) to display the earliest picture taken. You can continue pressing the + button to view your pictures in order. Press the − button (next to the left arrow) to move backward through your pictures.

4. Press the ISO button (under Multi) once if you want to display four images, or twice if you want to display nine images on the screen. Press it a third time to go back to a single image display.

5. Press the top left button (next to enlargement) to magnify your image. Press the bottom right button (under BACK) to return to the quick playback menu.

NOTE
The enlargement feature works the same way in quick playback as it does in the playback menu. See page 6-12 for more detailed instructions.

To return to the View menu and continue taking pictures, press the bottom right button (under BACK).
Deleting Pictures
If you have images stored on the camera that you want to delete, follow these steps:

1. Follow steps 1 through 3 in the section above to play back the image you want to delete.

2. When you see the image you want to delete on the screen, press the bottom left button (next to Delete).

3. You see a confirmation screen. Press the top left button (next to Yes) to delete the image.

You can also delete multiple photos or lock and unlock photos for deletion using the camera’s playback menu; see Chapter 6 for instructions.

Playing Audio Recordings
You can use the camera’s built-in speaker to play back recorded sounds with your pictures. Follow these steps:

1. Follow steps 1 through 3 under “Using Quick Playback” to play the image with the recording.

2. Press the WB button (under Sound Play) to hear the recording for that image.

You can change or delete your recording for any image in the camera’s playback menu. See Chapter 6 for details.
Your PhotoPC 850Z lets you take special shots for varying, changing, and moving subjects. These include: programmed settings for subject-specific shots, quick shots, continuous shots, and shots taken at timed intervals.

This chapter explains how to use the special features in the following sections:

- Taking quick shots
- Continuous shooting
- Interval shooting
- Using programmed settings

### Taking Quick Shots

After taking a picture, the PhotoPC 850Z normally takes a few seconds to process and save the image on the memory card. In quick shot mode, the camera stores up to 10 images internally in temporary storage while you keep taking pictures. It saves the images to the CompactFlash card after you’re done.

**NOTE**

- You can’t use quick shot mode when battery power or CompactFlash card memory is low.
- HyPict image quality is disabled in quick shot mode.
- When using quick shot mode, you can’t make audio recordings for your images. (To add recordings to images later, see Chapter 6.)
Follow these steps to use quick shot mode:

1. Turn the camera dial to 1. You see the SETUP menu. (Normal Shot appears as the default setting.)

2. Press the – button (next to Normal Shot) to select Quick Shot.

3. Turn the camera dial to  or  and wait until the camera status light turns green. The image quality icon on the status display panel flashes, indicating that quick shot mode is enabled.

4. Press and hold the shutter button to begin taking pictures. When you’re finished, release the button.

Or, you can press the shutter button repeatedly without having to wait for the camera to process each image.

The bracketed number on the status display panel indicates the number of pictures temporarily saved to the camera.

**Continuous Shooting**

In this mode, you can capture a complex motion in a series of steps to create animation sequences. Take two standard or fine resolution pictures each second, with up to ten pictures in sequence (or one super fine resolution picture per second, with up to eight pictures in sequence). Continuous shooting is available for all user modes.

**NOTE**

You can’t use the flash for continuous shooting, so make sure you have adequate lighting for your pictures. In addition, you can’t select the HyPict image quality setting.

1. Make sure you are at least 20 inches (50 cm) away from your subject.
2 Turn the camera dial to CONTINUOUS. Wait until the camera status light turns green.

You see a preview of your picture on the LCD screen, with a red frame around it. CONTINUOUS appears on the screen.

3 Center your subject in the red frame.

4 Press and hold the shutter button all the way down. The camera clicks as it captures each picture.

5 When the camera has captured a sequence of pictures, the sound stops and the camera status light flashes. Release the shutter button.

NOTE
If you continue to hold down the shutter button after the first sequence of pictures, the camera will pause to process the images and then take a second sequence. The camera will continue to take pictures until the memory card is full.

Continuous Shooting Using the Timer

You can also combine continuous shooting with the timer to delay automatic capture of a series of images. This allows you to photograph yourself in motion.

NOTE
You can capture 10 standard (2 per second) or fine (1 per second) images or up to 6 super fine (1 per second) resolution images.

1 Secure the camera on a flat surface or on a tripod. (See page A-3 for information on attaching the camera to a tripod.)

2 Turn the camera dial to CONTINUOUS. Wait until the camera status light turns green.
You see a preview of your picture on the LCD screen, with a red frame around it. **CONTINUOUS** appears on the screen.

3 Center your subject in the red frame.

4 Press the timer button.

   The timer icon **○** appears on the status display panel to indicate that the timer is enabled.

5 Press the shutter button.

   You have 10 seconds to get ready for “action” in front of the camera.

   The timer icon and the red timer light on the front of the camera flash slowly for eight seconds. Then they flash rapidly for two seconds before the shutter is released.

   The camera clicks each time it captures an image, and the timer light on the front of the camera flashes as the images are processed.

**Interval Shooting**

You can use this time lapse feature to capture scenes that change over time, such as a sunset or a busy street corner. Your camera lets you set a time interval from 10 seconds to 24 hours. Interval shooting is available for all user modes.
NOTE
When you’re adding audio recordings or taking pictures with HyPict image quality, the shortest time interval available is 20 seconds.

Follow these steps to use the time lapse feature:

1. Secure the camera on a flat surface or on a tripod. (See page A-3 for information on attaching the camera to a tripod.)

2. Turn the camera dial to . Wait until the camera status light turns green.

   You see a preview of your picture on the LCD screen, with a red frame around it. CONTINUOUS appears on the screen.

3. Press the bottom right button (under Mode Change). You see the following screen:

   The current setting for the time lapse interval (hours, minutes, and seconds) appears in the center of the screen, with seconds highlighted.

4. Press the + or − button (next to the up and down arrows) to change the highlighted setting, then press the ISO button (under the left arrow) to move to the next setting and repeat the process. Continue until you’ve set the correct interval.
3-6 Setting Up Special Shots

NOTE
You can also choose the maximum interval (24 hours) by pressing the top button (next to Max Interval), or the minimum interval (10 seconds) by pressing the bottom button (next to Min Interval).

5 Press the shutter button to take the first picture.

The camera turns off automatically after you take the first picture, then turns on again after the selected interval to take the next photo.

While the camera is on in this mode, Int appears in the display panel.

6 To stop taking pictures, turn the camera’s dial to Off.

NOTE
The number of photos you can take is limited by the space on the CompactFlash card. With a higher capacity card, you can store more pictures. (See Appendix A for more information.)

Using Programmed Subject Settings

The Program user mode provides four programmed settings that let you choose the type of shot you’re taking. The camera automatically assigns the optimum exposure, metering method, and sensitivity for your subject.

Normal
Appropriate for most photographs. Uses the following settings: auto exposure, matrix metering.

Sports
Recommended for action photographs. Uses the following settings: high shutter speed, automatic sensitivity, matrix metering.

Portrait
Recommended for portraits. Uses the following settings: spot metering, aperture fixed at f/2.4.
Landscape

Recommended for landscapes or scenery. Uses the following settings: matrix metering, aperture set to f/8.0. (The aperture automatically changes to f/2.4 when the subject is dim.)

Follow these steps to use programmed subject settings:

1. Set the camera to Program user mode. (See page 1-13 for instructions.)

2. Turn the camera dial to \( \mathcal{B} \). You see the View menu.

3. Press the bottom right button (under the Program setting) to cycle through the four subject settings.

4. Take your picture (See page 2-6 for instructions.)
Your camera has great shot-capturing capabilities that allow you to get the exact image you want. You can use the 2× digital zoom, frame your images as panoramas, or focus in on close objects with macro mode. You can also manually focus the camera.

- Taking digital zoom pictures
- Taking digital panoramic pictures
- Taking close-ups with macro mode
- Adjusting the focus manually

**Taking Digital Zoom Pictures**

Digital zoom pictures are magnified two times (2×). The automatic cropping effect makes file sizes smaller.
Follow these steps to take digital zoom pictures:

1. Turn the camera dial to \( \circ \). You see the View menu:

   ![Normal Frame](image)

   **NOTE**
   This example shows the View menu when the user mode is set to Full Auto. Depending on the user mode setting, your View menu may look different.

2. Press the bottom left button (next to Normal Frame) three times.

3. Press the shutter button halfway to lock the auto focus and exposure. When the camera locks its settings, the camera status light stops flashing and you see a green circle \( \circ \) on the screen. If you want, you can reframe your picture while holding the button down.

4. Press the button all the way down to capture the image.

   The digital zoom format remains active until you change it or turn off the camera.

The words **DIGITAL ZOOM** appear on your LCD briefly. A yellow frame appears around the previewed image, and the mode setting changes to \( \times 2 \).
Since the digital zoom mode crops the image and magnifies it, it’s best to print the image in a smaller format such as 2 × 2 inches, a good size for photo identification cards.

**Taking Digital Panoramas**

Images in the panorama format are long and narrow, although they are not captured at a wider angle than normal images. Strips at the top and bottom of the image area are cropped out. Smaller file sizes mean you can store more pictures in the panorama format.

Here are the steps to take panoramic pictures:

1. Turn the camera dial to the panorama mode.

You see the View menu. The current frame setting appears in the lower left corner.

You can’t select standard image quality when taking panoramic pictures. For more information about image quality, see page 2-10.

**NOTE**

This View menu illustrates what you see if your user mode is set to Full Auto. Your View menu will look different if the user mode is set to Program or Manual.
2 Press the bottom left button (next to the current setting) to cycle through the frame settings (Normal Frame, Macro, and Panorama).

For a few seconds, the word PANORAMA appears on the LCD screen, and a black frame appears around the previewed image. Also, the panorama mode icon [P] appears in the lower left corner of the screen.

3 Press the shutter button halfway to lock the auto focus and exposure. When the camera locks its settings, the camera status light stops flashing and you see a green circle on the screen. If you want, you can reframe your picture while holding the button down.

4 Press the button all the way down to capture the image. The Panorama format remains active until you change it or turn off the camera.

**Taking Close-Ups With Macro Mode**

You can use the camera’s macro mode to take pictures as close as 8 inches (20 cm). Follow these steps:

1 Turn the camera dial to . You see the View menu.
NOTE
This View menu illustrates what you see if your user mode is set to Full Auto. Your View menu will look different if the user mode is set to Program or Manual.

2 Press the bottom left button (next to the current frame setting).

For a few seconds, the word MACRO appears on the LCD screen, and a green frame appears around the previewed image. Also, the macro mode icon ☰ appears in the lower left corner of the screen.

3 Press the shutter button halfway to lock the auto focus and exposure. When the camera locks its settings, the camera status light stops flashing and you see a green circle ☰ on the screen. If you want, you can reframe your picture while holding the button down.

4 Press the button all the way down to capture the image.

Macro mode remains active until you change it or turn off the camera.

NOTE
When you take macro close-ups, you should use a tripod (as described in Appendix A) and disable the flash. Otherwise, your pictures may appear blurry and washed out.

Adjusting the Focus

The PhotoPC 850Z lets you adjust the distance of the focal point. Follow these steps:

1 Make sure that the camera is set to Manual user mode. (See page 1-13 for details.)
2. Turn the camera dial to 📷.  

3. If you want to use the macro feature or take panoramas, press the button next to Normal Frame until Macro or Panorama appears in the center of the screen.  

4. Press the bottom right button (under Menu Change) until the following screen appears:  

5. Press the + or – button (next to the up and down arrows) to select a manual focus setting.  
   
   If the camera is set to Normal Frame or Panorama, you can choose from the following settings:  
   
   AF  The camera determines the focus automatically.  

6. Press the shutter button halfway to lock the camera’s exposure settings. When the camera locks its settings, the camera status light stops flashing and you see a green circle 🟢 on the screen. You also see the shutter speed and F stop (aperture) at the top of the screen in yellow.  

7. Press the button all the way down to capture the image.  
   Your manual focus setting remains active until you change it or change your user mode.

---

4-6  Framing, Focusing, and Zooming
Light is one of the most important considerations for taking great photographs. Good color composition is also invaluable. Your PhotoPC 850Z gives you complete control over exposure, color, and other lighting condition settings. See the following sections to change your settings:

- Adjusting exposure
- Adjusting the sensitivity setting
- Adjusting the white balance setting
- Changing the metering method
- Exposure and color tips

NOTE
The settings in this chapter require that you set your user mode to Manual or Program. See page 1-13 to change the user mode for your camera.

Adjusting Exposure

Your camera normally adjusts exposure automatically. However, you may want to increase the exposure setting if you want to lighten your picture or if you’re taking pictures...
of an object against a bright background, such as sand or snow on a sunny day. Similarly, you may want to decrease it if you want to darken the picture, or if you’re taking pictures against a dark background.

With the PhotoPC 850Z, you can select automatic exposure settings, or you can fine-tune the exposure manually by setting the shutter speed and aperture setting.

**Changing the Automatic Exposure Value**

Follow these steps to select predefined exposure settings:

1. Make sure that the camera is set to Program or Manual user mode. (See page 1-13 for details.)
2. Turn the camera dial to  or  .
3. Press the + button (next to the up arrow) to increase the exposure setting, or the – button (next to the down arrow) to decrease it.

The setting appears in the status display panel next to the +/- mark and remains in effect while you take pictures.
In Program mode, you can select from nine settings in increments of 0.5, from −2.0 to +2.0 EV (Exposure Value).

In Manual mode, you can choose from 21 settings in increments of 0.2, from −2.0 to +2.0 EV.

**NOTE**

Exposure Value is a combination of shutter speed and aperture setting.

---

**Setting Shutter Speed and Aperture**

Experienced photographers can set the exposure manually by adjusting the shutter speed and aperture.

**NOTE**

To set either the shutter speed or the aperture setting and let your camera automatically determine the other exposure setting, you can use the Aperture Priority and Shutter Priority settings; see page 5-4.

Follow these steps to set the shutter speed and aperture:

1. Make sure that the camera is set to Manual user mode. (See page 1-13 for details.)

2. Turn the camera dial to 📷.
3 Press the top left button (next to Auto Exposure) to change the exposure mode to Manual.

4 Press the + button (next to the up arrow) to increase shutter speed, or the – button (next to the down arrow) to decrease it.

5 Press the W.B. and ISO buttons to change the aperture setting. (You can choose F2, F2.8, F4, F5.6, F8 or F11.)

NOTE
The camera detects the lighting conditions and warns you when exposure settings are outside the ideal range. If you see EV! on the LCD screen, your image may be under- or over-exposed.

Using Aperture Priority and Shutter Priority Settings
You may want to select a specific aperture or shutter speed setting for a desired effect, such as a fast shutter speed to capture an action photo. The camera will automatically select the other setting, based on the lighting conditions.

Follow these steps to set the shutter speed or aperture and let the camera automatically determine the other setting:

1 Make sure that the camera is set to Manual user mode. (See page 1-13 for details.)

2 Turn the camera dial to .
3. Press the top left button (next to Auto Exposure) to change the exposure mode to Shutter Priority or Aperture Priority.

4. If you are using Shutter Priority, press the W.B. button (under the right arrow) to increase shutter speed, or the ISO button (under the left arrow) to decrease it. (You can select a shutter speed from 4 to 1/800.)

   If you are using Aperture Priority, press the W.B. or ISO button to change the aperture setting. (You can choose F2, F2.8, F4, F5.6, F8 or F11.)

When you press the shutter button part way down to focus the camera, the camera shows the other exposure setting at the top of the LCD screen.

**NOTE**
You can change the automatic exposure value to have the camera select a lighter or darker range for the other exposure setting. (See page 5-2.)
Adjusting the Sensitivity Setting

With the PhotoPC 850Z's high sensitivity settings, you can take pictures of fast-moving subjects, or indoor or low light pictures without a flash. You can set the sensitivity from the camera's standard ISO equivalent of 100 to an ISO equivalent of 200 or 400.

---

**NOTE**

Since image quality is lower when you use high sensitivity settings, the standard setting is recommended for most pictures.

---

The arrow icons above the ISO button indicate the sensitivity setting:

- The standard setting is equivalent to ISO 100. This is the recommended setting for most pictures.
- The high sensitivity setting is equivalent to ISO 200.
- The super high sensitivity setting is equivalent to ISO 400.

Follow these steps to adjust sensitivity:

1. Make sure the camera is set to Program or Manual user mode. (See page 1-13 for instructions.)
2. Turn the camera dial to or .
3 If you are taking pictures using the viewfinder (with the camera dial set to ), press the ISO button on the back of the camera to cycle through the three sensitivity settings.

The arrow icons in the upper left corner of the status display panel indicate the sensitivity setting.

4 Do one of the following:

- If user mode is set to Program, the current sensitivity setting appears above the ISO button. (See the example above.) Press the ISO button to change the sensitivity setting.

**NOTE**
This View menu illustrates what you see if your user mode is set to Program. Your View menu will look slightly different if the user mode is set to Manual.
If user mode is set to Manual, press the bottom right button (under Menu Change). You see the following screen. Press the ISO button to change the sensitivity setting.

### Adjusting the White Balance Setting

Although the PhotoPC 850Z adjusts white balance for you automatically to ensure color accuracy, you may sometimes want to change this setting for special effects or lighting conditions.

The PhotoPC 850Z has the following white balance settings:

- **AUTO**
  Adjusts the white balance of your pictures automatically. This is the recommended setting for most pictures.

- **FIX**
  Locks the white balance setting at 5200 °K. This setting gives your pictures a warmer appearance under fluorescent lighting. It’s also a good choice for retaining the reds in a sunset.

- **CUST**
  Lets you customize the white balance setting. See page 5-10 to set the custom white balance.

Follow these steps to change the white balance setting:

1. Make sure the camera is set to Program or Manual user mode. (See page 1-13 for instructions.)

2. Turn the camera dial to ☀ or ☀.
3 If you are taking pictures using the viewfinder (with the camera dial set to), press the W.B. button on the back of the camera to cycle through the three settings.

The setting, which appears in the status display panel next to the W.B. mark, remains in effect while you take pictures.

NOTE
When nothing appears next to W.B. on the display panel, the camera is in the fixed white balance mode.

If you are taking pictures with the LCD screen, you see the View menu.

4 Do one of the following:

- If user mode is set to Program, the current white balance setting appears above the W.B. button. Press the W.B. button to select FIX or CUSTOM.
If user mode is set to Manual, press the bottom right button (under Menu Change). You see the following screen. Press the W.B. button to select FIX or CUSTOM, then press the bottom right button (under BACK) to save your setting.

Setting the Custom White Balance
Follow these steps to customize the white balance setting:

1. Turn the camera dial to \( \) to display the SETUP menu. If necessary, change to Program or Manual user mode.

2. Press the bottom left button (next to Shot SETUP) to go to the Shot SETUP menu.

3. Press the W.B. button (below New W/B).

4. You see a screen asking you if you want to save a new setting for the custom white balance mode. Press the bottom left button (next to Yes) to save a new white balance setting.
The camera’s lens moves out. You see a message with a framed area that the camera’s lens uses to set the white balance.

Focus the camera on a piece of white paper, or some other object to set the white balance by, and press the shutter button to save the setting.

Changing the Metering Method

If you’re using Manual mode, your camera lets you choose between matrix metering and spot metering.

With matrix metering, the camera automatically measures the available light and determines the correct exposure. If you’re an advanced photographer, you can use spot metering to choose a point that the camera samples to determine exposure.

Follow these steps to change the metering system:

1. Make sure that the camera is set to Manual user mode. (See page 1-13 for details.)
2. Turn the camera dial to 

Adjusting Exposure and Color Settings 5-11
3 Hold down the bottom right button (under Menu Change). You see the following screen. The current metering setting is in the lower left corner.

4 Press the bottom left button (next to Metering) to change the setting to spot or matrix metering.

When you take a picture, make sure the center of the camera’s lens is focused on the area by which you want it to read the light. If you can’t get the exact center by looking at the LCD screen, use the viewfinder to pinpoint the area. Once you press and hold the two-step shutter part way down to lock the exposure, you can look at the LCD screen again to frame your image. See Chapter 2 for details.

Exposure and Color Tips

Getting the right lighting in your shots can be complicated. These tips provide suggestions for various conditions.

If you are taking pictures in bright sunlight:

- Reduce the exposure setting.
- Use a fast shutter speed or smaller aperture setting.
- Avoid taking pictures while facing the sun.
- Use an optional filter with the camera’s included lens adapter to cut down on excessive light.
- Use the Solar Assist panel to save battery power.

If the sky is cloudy:

- Increase the exposure setting.
- Try using fixed white balance.
- Increase the sensitivity.
If there is complete cloud cover, avoid taking landscape photos. Portraits and closer shots are better choices under cloudy conditions.

If you are capturing a sunset or sunrise:
- Use the fixed white balance setting.
- Adjust exposure settings for different effects.
- Take several shots at different times to capture the changing colors. (To do this automatically, set up interval shooting as described in Chapter 3.)

If you are taking pictures in low light or at night:
- Increase the sensitivity setting.
- Increase the exposure setting.
- Use a wide aperture or slow shutter speed setting to let in more light.
- If your subject is in the shade with a sunny background, try using spot metering and focusing the camera on your subject.

For photographs taken at night, use the slow synchronized flash mode. The leading setting sets off the flash first, then exposes the subject and takes the picture. In this mode, hold the camera still or use a tripod (see Appendix A). The trailing setting flashes at the end of the exposure, allowing you to capture background motion while freezing your subject. (See Chapter 2 to change the setting to leading or trailing.)

If you are taking photographs under fluorescent lighting:
- Use custom or fixed white balance.
- Avoid taking portraits under fluorescent lights.
If you are taking portrait photos:

- Try using spot metering. Make sure you center your subject when you lock the exposure with the two-step shutter. Then you can move the subject off-center while you are holding the shutter button down. (See Chapter 2 for details on using the two-step shutter.)

- Try using the Portrait setting in Program mode (see Chapter 3).

- Be aware of lighting conditions and how they affect the appearance of your subject. Early morning, late afternoon, and cloudy skies provide more flattering light than direct sunlight.

- If you need to take a portrait under fluorescent or other unflattering indoor light, use the fixed or user-defined white balance.

- Use the red-eye reduction flash mode for portraits. If you are taking portraits in bright light, you still may want to use the flash to correct for the camera’s exposure adjustments.
Playing Back Photos

The LCD screen lets you play back your pictures one-by-one or in groups of four or nine. You can magnify or delete selected pictures and customize playback features. You can also view your pictures on a television as easily as on the camera’s screen. This chapter explains the following:

- Playing back pictures one-by-one or several pictures at a time
- Deleting pictures
- Locking pictures
- Adding, playing back, and deleting audio recordings
- Magnifying pictures
- Viewing detailed information about a picture
- Playing pictures as a slide show
- Playing back pictures on TV

NOTE
You can also use some of the playback functions while taking pictures with the LCD screen (see page 2-17).
Playing Back Pictures One by One

When you set the camera dial to 2, you see the last picture you took on the LCD screen:

Press the + button (next to the right arrow) to display the earliest picture taken. Continue pressing the + button to view your pictures in order. Press the – button (next to the left arrow) to move backward through your pictures.

NOTE

After a designated period of inactivity, the camera automatically shuts off to conserve battery power. If this happens, press any button on the back of the camera to “wake” the camera. If you are using the AC adapter, the camera doesn’t shut off.

Playing Back Multiple Pictures

You can play back your pictures in Multi mode to view small “thumbnail” versions of either four or nine pictures at once.

Follow these steps to play back multiple pictures:

1. Turn the camera dial to 2. You see the last picture you took on the LCD screen.

2. Press the ISO button (below Multi).

Small thumbnail images of the last four pictures you took appear on the screen, with the currently selected image framed in white.
If you want to display nine pictures as once, press the ISO button (under 1x9) again.

Press the + and – buttons to move the white selection frame through the images on screen, or hold one of these buttons down to move through the images quickly.

When the frame passes the first or last image of the current group, the previous or next three images are displayed in the group.

To switch back to displaying one picture at a time, press the ISO button again.

Deleting Pictures
The LCD screen provides two different methods for deleting images after you play them back:

- You can delete the currently displayed picture
- You can select multiple pictures for deletion, or “lock” pictures to protect them from deletion

You can also delete images from the quick playback screen in View mode (see page 2-17), or through your software when the camera is connected to your computer (see Chapter 8).

Deleting the Currently Displayed Picture
Make sure the camera dial is set to 0, then follow these steps:

1. Press the + or – button (next to the right and left arrows) to display the image you want to delete.

   NOTE
   To make choosing images easier, you can display four or nine images at a time by pressing the ISO button (under Multi) once or twice.
2 Press the bottom left button (next to Delete). A confirmation message appears.

3 Press the top left button (next to Yes) to delete the image, or the bottom right button (next to No) to cancel.

NOTE
If you try to delete a locked image, you see a warning message. Press the bottom right button (under BACK) to save the image. To remove the lock and delete the image, press the bottom left button (next to Cancel Delete).

Deleting All Pictures
To delete all the images from your memory card, make sure the camera dial is set to {Full}, then follow these steps:

1 Press the W.B. button (under Select Image).

2 Press the top left button (next to Select All) to select all the images in your card.

3 Press the ISO button (under Delete) to delete the images. A confirmation message appears.

4 Press the top left button (next to Yes) to delete the images, or the bottom right button (next to No) to cancel.

5 Press the bottom right button (under BACK) twice to return to the main playback menu.

NOTE
If any images are locked, you see a message asking if you want to delete them (instead of the message from step 3). Press the button next to No to delete only the unlocked images, or next to Yes to delete the locked images too. See page 6-8 for instructions on unlocking images.
Deleting Selected Pictures
You can select two or more images and then delete them all at once. Make sure the camera dial is set to ️, then follow these steps:

1. Press the ISO button (under Multi) once to display four pictures on the screen, or twice to display nine. A white frame appears around one of the pictures.

2. Press the W.B. button (under Select Image) to see the image selection screen:

3. Press the + or − button (next to the right and left arrows) to move the frame to an image you want to delete. Then press the bottom left button (next to Select). A red frame appears around the image and the word Select changes to Release.

   NOTE
   If you change your mind, press the button next to Release to deselect the image. The red frame disappears.

4. Repeat step 3 to select any additional images.

Playing Back Photos 6-5
5  After you’ve finished selecting images, press the ISO button (under Delete) to delete them.

A confirmation message appears. Press the top left button (next to Yes) to delete the selected images, or the bottom right button (under No) to cancel.

**NOTE**

If any images are locked, you see a message asking if you want to delete them (instead of the message from step 3). Press the button next to No to delete only the unlocked images, or next to Yes to delete the locked images too. See page 6-8 for instructions on unlocking images.

6  Press the bottom right button (under BACK) twice to return to the main playback menu.

---

### Locking Pictures

The lock feature allows you to keep your images from being accidentally deleted. You can lock selected images or all the images in the camera. Make sure the camera dial is set to $\circ$, then follow these steps to lock pictures:

1  Press the ISO button (under Multi) once to display four pictures on the screen, or twice to display nine. A white frame appears around one of the pictures.

2  Press the W.B. button (under Select Image) to see the image selection screen:
3 Do one of the following:

- If you want to lock all images, press the top left button (next to Select All). (If you change your mind, press the same button [Release All] to deselect all images.)

- If you want to lock just one or some of the images, press the + or − button (next to the right and left arrows) to move the frame to an image you want to lock. Then press the bottom left button (next to Select). A red frame appears around the image and the word Select changes to Release. Repeat this step to select any additional images.

4 Press the W.B. button (under the padlock icon). You see the following on your screen:

5 Press the top left button (next to Lock) to lock the images you have selected.
A padlock icon appears in the upper right corner of each locked image.

2 Press the W.B. button (under the padlock icon). You see the following:

3 Press the bottom left button (next to Release). The selected images are unlocked. If an image is successfully unlocked, the padlock icon disappears from the upper right corner of its frame.

4 Press the bottom right button (under BACK) to save your settings.

Unlocking Pictures
After you have locked some of your pictures, you can unlock selected pictures or all the pictures in the camera.

Make sure the camera dial is set to  ‘,

1 Repeat steps 1 through 3 of “Locking Pictures” to select the images you want to unlock.

2 Press the bottom right button (under BACK) to save your settings.

6-8 Playing Back Photos
Adding Audio Recordings
You can add audio recordings to images stored on your memory card.

Follow these steps to add a recording to an existing image:

1. Turn the camera dial to to select playback mode.

2. Press the + or – button (next to the right and left arrows) to move to the photo to which you want to add a recording. (If you’re displaying multiple images, you’ll see a white frame around the currently selected photo.)

3. Press the bottom right button (under Menu Change) until the screen changes, then press the top left button (next to Sound).

   You see the following:

4. Press the button next to your desired recording time. A countdown of the recording time appears on the screen.

   Playing Back Photos 6-9
NOTE
If an image is locked, you see a warning message. Press the bottom left button (next to Release) to unlock the image. Then press the top left button (next to Yes) when you are ready to record a message. Or, press the bottom right button (under BACK) to return to playback mode.

If there’s already a message on the selected photo, a confirmation message appears after you choose the recording time. To erase the old recording and make a new one, press the top left button (next to Yes). Or press the bottom right button (under No) to cancel.

5 Speak clearly into the microphone on the back of the camera. (Press the button next to Cancel to stop recording and delete the message at any time.)

A microphone icon appears in the upper right corner of the image to indicate that a recording has been added.

6 Press the bottom right button (under BACK) twice to return to the main playback menu.

Playing Back Recordings

Your camera has a speaker that allows you to play back your recordings. You can also play audio recordings in your camera’s slide shows (see page 6-14) and when you play back images from View mode (see page 2-17).

Make sure your camera dial is set to 📺, then follow these steps:

1 Press the + or – button (next to the right and left arrows) to move to the photo for which you want to hear a recording.

2 Press the bottom right button (under Menu Change). You see the following:
3 Press the top left button (next to Sound).

4 Press the W.B. button (under Sound Play). If you want to stop the playback, press the W.B. button again.

Deleting Audio Recordings
You can also delete audio recordings that you’ve added to the pictures on your memory card.

Make sure your camera dial is set to , then follow these steps:

1 Use the + or – button (next to the right and left arrows) to move to an image whose attached recording you want to erase. (If you’re displaying multiple images, you’ll see a white frame around the currently selected photo. You’ll see a microphone icon in the upper right corner if the image has a recording attached.)

2 Press the bottom right button (under Menu Change).

3 Press the top left button (next to Sound).

You see the following:

4 Press the ISO button (under Sound Delete) to delete the recording for the picture. A message appears asking you to confirm the deletion.

NOTE
If you see a message that the selected image is locked, press the button next to Release to unlock it.

5 Press the button next to Yes to confirm, or under No to cancel.

6 Press the bottom right button (under BACK) twice to return to the main playback menu.
**Magnifying a Picture**

You can zoom in to enlarge a portion of your image on the LCD screen and view it in greater detail. Then you can use the camera’s buttons to scroll the image and display another section (up to nine sections for regular images and three sections for panoramic images).

The sections of your image that can be viewed are demonstrated in the figure below:

Make sure the camera dial is set to 

To enlarge the currently displayed image, press the top left button (next to **enlargement**).
A magnified view of the center section of the picture appears. An icon in the top right corner of the screen indicates which section of the image is currently displayed.

2 To view different sections of the magnified image, press the + and − buttons (next to the up and down arrows) to move up or down, or the ISO and W.B. buttons (under the left and right arrows) to move left or right.

**NOTE**
When you magnify a panoramic picture, it’s divided into three parts. You can only scroll left and right.

3 To exit the enlargement screen, press the bottom right button (under BACK).

**Viewing Picture Information**
You can use the LCD screen to view detailed information about individual images, including date and time taken, shutter speed, exposure settings, aperture and white balance settings, and metering method. To display image information, follow these steps:

1 Turn the camera dial to  play, then press the bottom right button (under Menu Change). You see the following:
2 Press the W.B. button (under INFO) to display information for the currently selected image.

3 Press the bottom right button (under BACK) twice to return to the main playback screen.

### Playing Your Pictures as a Slide Show

You can use the LCD screen to play back your pictures in a continuous “slide show.” You can even control the slide show’s speed and pauses. Follow these steps:

1 Turn the camera dial to ç. Then press the bottom right button (under Menu Change).

2 Press the bottom left button (next to SLIDE SHOW).

3 Press the + button to select the slide show speed. You can have the image change automatically every 3, 5, or 10 seconds, or you can choose to change the images manually. (For images with audio, the camera stays on the image until the entire recording has played.)

**NOTE**

You can also turn sound on or off, rotate the images, or exclude certain images from your slide show. See the following sections for instructions.
4 Press the bottom left button (next to Start) to begin the slide show.

To pause the slide show, press the bottom right button; then press the bottom right button again to restart it. While the slide show is paused, you can view the last image by pressing the ISO button (under BACK). You can also exclude the currently displayed image by pressing the top left button (next to Exclude).

To stop the slide show, press the bottom left button (next to Quit).

NOTE
At the end of the slide show, a black screen with the message “fin!” appears. Then the camera shuts off. Press any button on the back of the camera to turn it back on in playback mode.

Playing Sounds With Your Slide Show
You can turn the audio recordings for your images on or off when you display your slide show. Follow these steps:

1 Turn the camera dial to . Then press the bottom right button (under Menu Change).

2 Press the bottom left button (next to SLIDE SHOW).

You see the following:

3 Press the top left button (next to Sound Play OFF) to turn the sound on. (If the setting is Sound Play ON, you can press the same button to turn it to Sound Play OFF.)
Excluding Pictures From a Slide Show

All pictures saved in your camera’s memory card are automatically included in the slide show. To exclude any pictures from the slide show, follow these steps:

1. Turn the camera dial to \( \mathcal{E} \). Then press the bottom right button (under Menu Change).
2. Press the bottom left button (next to SLIDE SHOW). You see the following:

3. Press the \(-\) button (next to SlideSelect). The slide selection screen appears:

4. Press the + or – button (next to the right and left arrows) to select the picture you want to exclude from the slide show. (If you want, press the ISO button to display multiple pictures.)

5. Do one of the following:
   - Press the bottom left button (next to Exclude) to exclude the selected picture.
   - Press the top left button (next to Excl All) to exclude all pictures.
The number that normally appears in the top right corner of each slide show image disappears for excluded photos.

NOTE
If you change your mind, move the white frame to the picture you want to include again and press the bottom left button (next to Select). Or press the top left button (next to Select All) to include all pictures.

6. When you're finished, press the bottom right button to return to the slide show menu.

NOTE
Once you exclude images, the camera only plays the ones that were not excluded. If you take new photos and want to play them in your slide show, select them or press the button next to Select All to include all the pictures in the camera.

Rotating Pictures in a Slide Show
You can display pictures in your slide show rotated 90 degrees to the right or left. Follow these steps:

1. Turn the camera dial to to display the playback menu, then press the bottom right button (under Menu Change).

2. Press the bottom left button (next to SLIDE SHOW). You see the slide show menu:
3 Press the – button (next to Slide Select) to display the slide selection screen:

4 Press the + or – button (next to the right and left arrows) to frame the image you want to rotate.

5 To rotate the image 90 degrees to the left, press the W.B. button (under Rotate) once. (Press it two more times to rotate the image back.)

To rotate the image 90 degrees to the right, press the W.B. button twice. (Press it once more to rotate the image back.)

NOTE
You can’t rotate images that have been excluded from the slide show. If you want to include an excluded image, press the button next to Select and then rotate it.

6 Repeat steps 3 through 5 to select and rotate more pictures. When you’re finished, press the bottom right button (under BACK) to save your changes and return to the slide show menu.

Playing Back Pictures on TV

You can display your pictures and play back audio recordings on a regular television or VCR by using the video cable that came with your PhotoPC 850Z. You may want to use the optional AC adapter when you play back your pictures on a TV. See page A-2 for instructions.
Follow these steps to play back your pictures on TV:

1. Make sure the camera and TV (and VCR) are turned off.

2. Open the camera’s connector cover and connect the black end of the video cable to the AV OUT port, as shown.

3. Connect the yellow end of the cable to the VIDEO IN port and the white end of the cable to the AUDIO IN port on the television or VCR.

4. Turn on the TV (and VCR) and switch to the correct video mode.

5. Turn the camera dial to \( \mathbf{B} \). The last picture you took appears on the TV screen. You can use all of the camera’s playback features when your pictures are displayed on TV.
NOTE
The LCD screen is blank when the camera is connected to a TV.

6 When you're done playing back pictures, switch back the video mode, if necessary. Turn your camera dial to Off and turn off the TV (and VCR). Then disconnect the cables.

TIP
You can videotape your pictures and sounds to share them without using a computer. After you connect the camera to your VCR, press the Record button on the VCR and use the camera's slide show feature, as described on page 6-14.
Your camera has many options that you can change to configure the camera to work exactly the way you want. This chapter describes the following:

- Setting the auto power off time
- Adjusting the LCD brightness
- Turning the camera alert sounds on or off
- Setting the camera volume
- Setting the time and date
- Setting the language
- Setting the broadcast signal system

### Setting the Auto Power Off Time

The automatic power off feature saves battery power by automatically turning your camera off when it's idle for a designated period of time. You can set the camera to turn off after 10 seconds, 30 seconds, one minute, three minutes, or five minutes.

**NOTE**

You can also set the camera’s clock and automatic power off feature from your computer. See Chapter 12 for details.
Follow these steps to change the power off interval:

1. Push the camera dial lock in and turn the dial to 1. You see the SETUP menu:

2. Press the ISO button (below Camera SETUP) to go to the Camera SETUP menu. The current power off setting appears in the upper left corner of the screen.

3. Press the top left button (next to the current setting) to select a new setting.

**NOTE**
Automatic power off is in effect only when you’re using batteries to power the camera.
Adjusting the LCD Brightness

To adjust the brightness of the LCD screen, follow these steps:

1. Turn the camera dial to < to display the SETUP menu. Then press the ISO button (under Camera SETUP). You see the Camera SETUP menu:

   ![Camera SETUP Menu]

2. Press the + or − button (next to the up and down arrows) to adjust the screen brightness.

Turning the Camera Alert Sounds On or Off

Normally, the camera clicks to let you know when an image has been captured and makes sounds whenever you press any of its buttons. However, you can turn the alert sounds off, or set the camera to click only when it captures an image. To set the alert sounds, follow these steps:

1. Turn the camera dial to < to display the SETUP menu. Then press the ISO button (under Camera SETUP). You see the Camera SETUP menu (shown to the left).

2. Press the ISO button (under Beep) to cycle through these choices:
   - Shutter: The camera clicks when an image is captured.
   - Never: Turns all sounds off.
   - Always: The camera makes sounds whenever you press a button and clicks when the camera captures images.
3 Press the bottom right button (under BACK) to return to the SETUP menu.

**Setting the Camera Volume**
You can change the camera’s volume for playing back audio recordings and alert sounds. Follow these steps:

1 Turn the camera dial to  to display the SETUP menu. Then press the ISO button (under Camera SETUP). You see the Camera SETUP menu:

2 Press the lower left button (next to Volume) to change the setting to Hi or Low.

3 Press the bottom right button (under BACK) to return to the SETUP menu.

**Setting the Time and Date**
The camera remembers the time and date settings you made when you formatted your memory card, unless it goes without battery power for more than a couple of hours.

If you need to reset the time and date for any reason, follow these steps:

1 Turn the camera dial to  to display the SETUP menu. You see the camera date and time settings in the upper left corner of the screen.
2. Press the top left button (next to the setting) to display the following screen. The month is highlighted in red.

3. Press the + or − button (next to the up and down arrows) to adjust the setting, then press the W.B. button (under the right arrow) to highlight the day.

4. Repeat step 3 for each item you want to change. (To return to a previous setting, press the ISO [left arrow] button.)

5. When you're done, press the bottom left button (next to SET) to save the setting and return to the SETUP menu.

To return to the SETUP menu without changing the setting, press the bottom right button (under BACK).

Setting the Language

You can choose from eight languages for information displayed on the LCD screen.

Follow these steps to change the language setting:

1. Turn the camera dial to  to display the SETUP menu.

2. Press the W.B. button (under the icon) to go to the language setting screen.
3 If necessary, press the W.B., ISO, + or – buttons (under and next to the arrows) to highlight English.

4 Press the bottom left button (next to SET) to save the setting and return to the SETUP menu.

   To return to the SETUP menu without changing the setting, press the bottom right button (under BACK).

**Setting the Broadcast Signal System**

If you will be using your camera with a television, you can make sure the camera has the correct broadcast signal setting. Follow these steps:

1 Turn the camera dial to 1 to display the SETUP menu.

2 Press the W.B. button (under the icon) to go to the language setting screen.

   ![Setting the Broadcast Signal System]

3 If necessary, press the top left button (next to Signal System) to change the setting to NTSC (the U.S. broadcasting standard).

4 Press the bottom left button (next to SET) to save the setting and return to the SETUP menu.

   To return to the SETUP menu without changing the setting, press the bottom right button (under BACK).
Getting Photos Into Your Computer

When you’re finished taking pictures, you can connect the camera to your computer and transfer the images. Then you can use the pictures on your Web site, in presentations, or in just about anything you create on your computer. This chapter describes the following:

- Connecting the camera
- Transferring photos and audio files with Image Expert
- Getting images into TWAIN-compliant applications
- Getting images that you can import

**NOTE**

If your computer has a Type II PCMCIA card slot, you can transfer your pictures by copying them directly from your memory card with an optional adapter. See page A-7 for instructions.

Connecting the Camera

This section describes how to connect the camera to a Windows PC (using the serial cable), a Macintosh (using the Macintosh serial cable), and to a USB-compatible PC or Macintosh (using the USB cable). Note the following before you start:

- You can conserve battery life by using the optional AC adapter when you connect the camera to your computer. See page A-2 for instructions.
- When you connect the camera, make sure your system is not exposed to sources of electromagnetic interference, such as stereo speakers or the base units of cordless telephones.
Connecting to a Windows PC

Follow these steps to connect the camera to your Windows 95, 98, or NT system with the included serial cable:

1. Locate the Windows serial cable that came with the camera, then turn off the camera and your computer.

2. Locate a serial port on the back of your computer. You may have two serial ports labeled COM1 and COM2, or the ports may be labeled with icons. If you have two serial ports available, use COM1 (port 1) to connect your camera.

   NOTE
   If you have a 25-pin serial port, you can use a 9- to 25-pin adapter.

3. Line up the serial connector on the cable with one of the serial ports on your computer, and insert the connector. Then tighten the screws.

4. Open the connector cover on the side of the camera. Carefully insert the connector on the other end of the cable into the camera’s interface port.

   NOTE
   To disconnect the cable from the camera, squeeze and hold the two connector lock buttons on the sides of the connector while you pull the cable out.
Connecting to a Macintosh

Follow these steps to connect the camera to your PowerPC with the Macintosh serial cable that came with your camera:

1. Locate the Macintosh serial cable that came with the camera, then turn off the camera and your computer.

2. Locate the modem port or printer port on the back of your Macintosh. You can use either port to connect the camera.

**NOTE**

If you're sharing a serial port that you use for another device, make sure AppleTalk™ is turned off. Your Macintosh may not recognize the camera if AppleTalk is on. Also, if you have problems connecting to the printer port, use the modem port instead.

5. Turn on the camera by turning the camera dial to , then turn on your computer system.

**NOTE**

If you have problems connecting to the COM port you have selected, check your computer’s COM port configuration and try again. If your computer has a high-speed serial board, you may be able to transfer your pictures at the rate of 230.4KB per second. If your camera software doesn’t set this speed automatically, you can set it manually. See page 12-5.
3 Open the connector cover on the side of the camera. Carefully insert the connector on the other end of the cable into the camera’s interface port.

4 Turn on the camera by turning the camera dial to ( ), then turn on your Macintosh system.

**8-4 Getting Photos Into Your Computer**

On a PowerPC or PowerMac G3, you may be able to transfer your pictures at the rate of 230.4KB per second. If your camera software doesn’t set this speed automatically, you can set it manually. See page 12-5.

**Connecting the Camera with the USB Cable**

You can connect the camera to your USB-enabled Windows 98 system, iMac, or PowerMac G3 system using the USB cable that came with your camera.

**NOTE**

- If you’re using Windows 98 and you see the New Hardware Found screen, follow the instructions on page 1-16.
- If your iMac is running OS 8.1, you’ll need to update your operating system before connecting to your camera using the USB cable. Download and install the iMac Update 1.0 or later from Apple at [http://swupdates.info.apple.com](http://swupdates.info.apple.com). Contact Apple if you have problems installing the update. If your iMac is running OS 8.5 or 8.5.1, Apple recommends that you download and install iMac Update 1.1. To find out which operating system your iMac is running, select About This Computer in the Apple menu.
Follow these steps to connect the camera to your system using the USB cable:

1. Locate the USB cable that came with the camera, then turn off the camera and your computer.

2. Plug the connector on the USB cable into the USB port on your computer, or into a port on a USB hub.

**NOTE** Although you can use a USB hub, it’s recommended that you connect the camera directly to the computer’s USB port.

3. Open the connector cover on the side of the camera. Then insert the connector on the other end of the USB cable into the camera’s interface port.

**NOTE** To disconnect the cable from the camera, squeeze and hold the two connector lock buttons on the sides of the connector while you pull the cable out.

4. Turn on the camera by turning the camera dial to 🌽.
Transferring Photos and Audio Files

The PhotoPC 850Z provides several different ways to transfer your pictures from the camera’s memory card to your computer. The simplest method is to use the Image Expert software that came with your camera. This lets you view small thumbnail images of your pictures, and then quickly transfer them to an album (folder) on your hard disk drive.

If you haven’t installed your software, do it now. (See Chapter 1.) Make sure the camera is connected to your computer and the camera dial is turned to "

NOTE
Although these instructions apply to Windows 95 and 98, the same basic steps can be used with a Macintosh or Windows NT 4.0 system.

1 In Windows, Start Image Expert: Click Start, point to Programs, point to Image Expert, and click Image Expert.

On a Macintosh, open the Image Expert folder and double-click the Image Expert icon.

If you see the Image Expert Quick Tour screen, click Close. (This screen does not appear on the Macintosh.)

You see a window like the following:

2 Click View Pictures in the Camera. You see a window displaying “filmstrips” of your images. (If you see an error message instead, see page 8-9.)
Click the button to transfer all the images to your hard drive. To transfer a single image, select it, then click the button.

**NOTE**

- To select more than one image, hold down the Ctrl key while you click. To deselect, click another image.
- You must click the button to transfer images. When you view images on your computer, they are not yet transferred.
Image Expert will automatically create an album (folder) for your pictures with the current date as its name. You can type your own name for the album if you want, or choose an existing album.

4 Click Open (or OK on a Macintosh) to begin transferring your pictures. You see a confirmation message asking if you want to download selected images only.

5 Click Selected to download the selected images, or All to download all images. A window like the following shows you the progress of each image:

6 When you're finished, close the filmstrip window.

7 To erase all images from the camera’s memory card, select Erase All Images from the Camera menu. To erase a particular image, click the image to select it and choose Delete from the Edit menu. You see a confirmation message.

8 Click Yes to erase the image(s), or No to cancel.

You can double-click an image to open it in Image Expert. You can display your images one by one, edit, print, and copy them to diskettes, or place them in your documents and presentations. See Chapters 9, 10, and 11 for more information about working with images in Image Expert.
What To Do if You See an Error Message

When you click the button to view images in the camera’s memory card, you may see a message like the following:

Follow these tips to get your camera connected correctly:

1. Make sure the camera is turned on and has not shut off automatically. If it has, turn the camera dial to Off, then to.

2. Check the cable and make sure the connections are secure. Make sure the pins inside the connector are not bent.

3. Make sure your batteries have enough power, or your AC adapter is connected.

4. Click Retry. If you see the Connection Failed message again, click Connection. You see the following dialog box:

5. Select another image source from the Connection Via list, if necessary. If you’re using a PCMCIA adapter to access images from a PC card slot, select PC Card.

6. Select another port if necessary. In most cases, it’s best to leave the Port setting at Auto because Image Expert can detect the camera connection automatically.

   If you have a serial device connected to one port and an internal modem on the other, you can try setting the Port to COM3 or COM4.
If you have a USB port, select Serial/USB, then remove the USB cable from your computer and reconnect it.

7 Select a slower speed. Image Expert automatically chooses the fastest speed that works with your system, but this may actually be too fast for the configuration of your port. Try setting the speed to 57600. You may need to experiment to choose the best speed.

8 When you are finished, click OK.

**Getting Images Into TWAIN-Compliant Applications**

If you use Photoshop® or other TWAIN-compliant applications, you can transfer your pictures directly into your program from the camera. Follow these steps:

1 Start your application.

2 Choose Import, then Select TWAIN_32 Source if you’re running Windows (or Import, then TWAIN Select if you have a Macintosh) from the File menu.

3 For your TWAIN source, choose EPSON Photo!3 Ver.1 (Windows), or Photo!3 Ver.1 (Macintosh).

4 For Windows, choose Import, then TWAIN_32 from the File menu. For Macintosh, select Import, then TWAIN_Acquire.

The EPSON Photo!3 screen appears, with thumbnail images of your photos. (If you see the message The Camera Is Not Responding, see page 8-14.)
Select the picture you want and click Get Photos to transfer the picture. Or click Select All and then Get Photos to transfer all the pictures.

**NOTE**
To select more than one image, hold down the Ctrl key while you click. To deselect, click another image.

You can also select a picture and do the following before you transfer it:

- Click View Photo to see a full-size image.
- Click one of the rotation buttons to turn the picture 90 degrees.
- Click Photo Info to see the capture time and date, image resolution, and other information.
- Check PhotoEnhance to automatically improve the picture during transfer. (You can select and enhance all the pictures at once. However, this feature makes the transfer take significantly longer. The optional AC adapter is recommended for this feature.)

After transferring, click Erase Photos if you want to remove the picture(s) from your camera.

If necessary, click Close to exit the EPSON Photo!3 screen and return to your application. You see the picture or pictures in the work area.

Getting Photos Into Your Computer 8-11
Getting Images That You Can Import

Most methods of transferring images from the camera save your pictures as JPEG files. If your word processor or other application doesn’t support the JPEG format, you have to convert the files one by one. Or you can use the export feature of EPSON Photo!3 to automatically convert the files as you transfer them.

Follow these steps to export and convert your pictures with EPSON Photo!3:

1. Start your EPSON Photo!3 software. Under Windows 95 or 98, click Start, and then point to Programs, EPSON Photo!3 Ver.1, EPSON Photo!3 Ver.1.

You see a screen like the one below. (If you see a Setup screen that says The Camera Is Not Responding, see page 8-14.)

2. Click the picture you want, or click Select All.

You can also view, rotate, or enhance the picture(s) or see picture information before you export, as described on page 8-11.
3 Click the **Export Photos** button. The Save As dialog box appears:

4 Type a file name. If you’re exporting more than one image, the software will add numbers to identify each one.

5 Select the file type from the drop-down menu. You can choose any of the following formats:
   - PICT (Macintosh only)
   - JPEG
   - Bitmap (BMP)
   - PCX

6 Click **Save**. Your pictures are transferred one by one.

7 Click **Erase Photos** if you want to remove the pictures from your camera.

---

**NOTE**

You cannot open exported photos in EPSON Photo!3. Use Image Expert to view and edit the exported images.
Here are some additional things you can do with EPSON Photo!3:

- Select the Folder tab and click Browse to locate and display pictures you have downloaded. You can then select a picture and click Upload to transfer a picture from your computer to the camera or an optional memory card. See Chapter 13 for more information.

- Select the Controls tab to change camera settings or view a live preview and take pictures from your computer. See Chapter 12 for more information.

- Set the camera’s date and time from the Setup tab, or change your computer connection settings. See Chapter 12 for more information.

8 Click Close to exit EPSON Photo!3.

You can now insert your exported pictures in documents and other projects. For instructions, see page 9-2.

What To Do If the Camera Is Not Responding

When you try to acquire pictures from the camera or start the EPSON Photo!3 application, you may see a screen like the following:
Follow these steps to fix your camera connection:

1. Check the cable and make sure the connections are secure. Make sure the pins inside the connector are not bent.

2. Make sure your batteries have enough power, or your AC adapter is connected.

3. Click Test Connection. If you see the same screen, continue with step 5.

4. Select another port if necessary. In most cases, it’s best to leave the Port setting at Auto because EPSON Photo!3 can detect the camera connection automatically. If you have a serial device connected to one port and an internal modem on the other, you can try COM3 or COM4.

   If you’re using a USB port, try selecting USB, then remove the USB cable from your computer and reconnect it.

5. Select a slower speed. EPSON Photo!3 automatically chooses the fastest speed that works with your system. This may actually be too fast for the configuration of your port. Try setting the speed to 57600. You may need to experiment to choose the best speed.

6. Click Test Connection again. If you still don’t see your pictures, see Chapter 16 for more troubleshooting tips.
PhotoPC 850Z provides several methods for getting your pictures into presentations, letters, and other projects. You can drag and drop a picture from an Image Expert album into a document or presentation. You can also import an image into your application, or copy and paste it. With Windows, you can use the Camio™ Viewer to drag a picture directly from the camera and drop it into your project. This chapter describes the following:

- Importing images into documents
- Getting images with copy and paste
- Using drag and drop from an album
- Getting images with the Camio Viewer
Although most of the instructions and illustrations in this chapter apply to Windows 95 and 98, you can follow the same steps in Windows NT 4.0 or on a Macintosh.

**Importing Images Into Documents**

Once your pictures are transferred and saved on your hard drive, you can import them into your applications. You may need to convert your images if you didn’t export them from the camera (as explained in Chapter 8) and your application can’t import JPEG files. Or you can use the Save As feature of Image Expert to convert image files.

*NOTE*

Your picture may display poor image quality on the screen after you import it. However, in most cases it will print correctly.

Follow these steps to import a PhotoPC 850Z picture into your document:

1. Start your application.
2. Open the document where you want to use the picture.
3. Select the point where you want to place your picture.
4. Select Picture from the Insert menu. (In some applications you may need to select a different command, such as Import Picture, which is usually in the File menu.)

   An Insert Picture dialog box appears (your dialog box may look different, depending on your application):

5. Locate and select the image you want to insert. In some applications you can see a preview of your picture.
Click OK (or Insert, Import, or whatever command your application uses) to insert your picture. The picture appears in your document.

NOTE
In some applications, you can add a frame around the picture if you want to move it around on the page or resize it. In other applications, you create a frame first and then place the picture in it. For instructions, see your application’s online help or documentation.

Getting Images With Copy and Paste
You can use this method to place a picture in just about any type of document or project. You should already have transferred your picture from the camera to your hard disk. Follow these steps:

1. Start Image Expert. (See page 8-6.)
2. Click View Pictures from an Existing Album. Or, from the Image Expert screen, click the Open Album button or select Open Album from the File menu.
You see a dialog box like the following:

3 Locate the album you want and double-click it to open it. When a filmstrip of album images appears in the Image Expert window, click the picture you want to copy.

4 Click the Copy button or select Copy from the Image Expert Edit menu.

5 Start your word processor or other application.

6 Open the document where you want to use the picture.

7 Choose Paste (or Paste Special) from your application’s Edit menu. A copy of the picture appears in your document.

Using Drag and Drop From an Album (Windows Only)

Once you have transferred your pictures into albums, you can easily drag and drop them into documents or other projects.

**NOTE**

Dragging and dropping an image into a document works only with OLE-2.0-compliant applications, such as Microsoft Word®, PowerPoint®, WordPerfect®, or Lotus SmartSuite®. Depending on how well your application supports OLE 2.0, your images may not look as good when you drag and drop them as when you import them.
Follow these steps:

1. Start Image Expert as described on page 8-6.

2. Click View Pictures from an Existing Album, or click the Open Album button from the Image Expert screen.

3. Locate the album you want and double-click it to open it.

4. Start your word processor or other application.

5. Open the document where you want to use the picture.

You should have both the Image Expert album and the document displayed on your screen, as shown:

6. Click the image you want.

7. While holding down the mouse button, drag the image to the location where you want it in your document.

8. Release the mouse button. The picture appears in your project or document.
If you want to edit or modify the picture, just double-click it on the Image Expert window to bring up the Image Expert menus and toolbar.

**Getting Images With the Camio Viewer (Windows)**

The Camio Viewer is a quick and easy way to get pictures from the camera. You can transfer all images to your computer, or just display the pictures in the camera. Then you can drag a picture directly into a presentation or document.

**NOTE**

Dragging and dropping an image with the Camio Viewer works only with OLE-2.0-compliant applications running under Windows 95, Windows 98, or Windows NT.

First you need to connect the camera to your computer as described in Chapter 8. Then follow these steps:

1. Double-click the camera icon on the right end of your Windows taskbar.

You see the Camio Viewer Startup Options dialog box:
2 Choose one of the following options:

- **View images in the Camera**
  Displays a filmstrip of your pictures. You can then select an image to drag and drop into a document or presentation. (The image will be embedded in your document, and will not be available as a separate file.)

- **Copy all images from the Camera to the Computer**
  Transfers your pictures to an album (folder) on your hard drive. You can then select an image to drag and drop.

- **Copy all images and delete them from the Camera**
  Transfers your pictures to an album (folder) on your hard drive and deletes them from the camera. You can then select an image to drag and drop.

3 Continue with the steps in one of the following sections, depending on the option you chose in step 2.

### Dragging and Dropping a Picture Into a Document

Follow these steps if you chose View images in the Camera:

1 Click OK. Your pictures appear in a strip of thumbnail images:

2 Open the application and document where you want to use the picture.
Click the picture you want to use. Without releasing the mouse button, drag the picture to your document. When your pointer is over the location where you want the picture to appear, release the mouse button. The picture is downloaded from the camera, and it appears in your document.

If you want to edit or modify the picture, just double-click it in the Camio Viewer filmstrip to bring up the Image Expert menus and toolbar. For more information about the Camio Viewer, choose Quick Tour from the Image Expert Help menu.

NOTE
When you drag and drop with the Camio Viewer, your picture is not saved as a separate image file on your hard drive. You have to transfer your image first if you want it to be available as a separate image file.

Transferring Images Before Placing Them
Follow these steps if you chose Copy all images from the camera to the computer:

1. Click OK to copy your pictures to an album named with the current date. Or, type a new name for the album and click OK. Your pictures are transferred one by one. They appear in a strip of thumbnail images, as shown on the previous page.

2. Follow steps 2 and 3 in the previous section to drag and drop a picture into a document or other project.
10 Working With Photos and Albums

You can use Image Expert albums to organize and display your pictures. You can print using dozens of predefined layouts. On Windows systems, you can also record sounds for each image, copy an album to diskette, use your images as wallpaper, and more. This chapter covers the following:

- Organizing Image Expert albums
- Printing an image or album
- Adding sound to an image
- Displaying albums as slide shows
- Using an album as a screen saver
- Setting an image as wallpaper
- Copying to diskette or Zip™ disk
- Sending pictures and sound by e-mail
Organizing Image Expert Albums
Image Expert albums provide a convenient way to organize your pictures. Here are some of the things you can do:

- Organize pictures in albums
- Rename a picture
- View picture information

Copying and Moving Pictures in Albums
Although Image Expert initially sorts your pictures by date, you can easily drag and drop images between albums to organize them by subject matter or in any way you want.

Follow these steps to copy or move images from one album to another:

1. Open the album you want to copy the images to and the album where the pictures are located.

2. Select the image or images you want to move or copy. Hold down the Ctrl (Option on Macintosh) or Shift key to select multiple images.

3. To copy or move images, click inside one of the selected images and hold down the mouse button.

4. Drag the image(s) to the other album.

If you want to create a new album, click the New Album button or select New Album from the File menu.
5 When the second album is highlighted, let go of the mouse button.

The images are copied to the album. You can sort the pictures and save or rename the new album.

**Renaming a Picture**

You can easily rename a picture displayed in an Image Expert album. Follow these steps:

1 Click the picture to select it, then click the name that appears above the picture. The name is highlighted.

2 Type in the new name and press Enter or click outside of the name area. The new name appears above the picture and is saved.

**Viewing Picture Information**

You can display information about any image file and the camera settings that were used to capture it. Follow these steps:

1 Click the picture to select it, or double-click it to open it.

2 Click the Properties button or select Properties from the Image menu. You see the following information:

![Image Properties](image.png)
3. Click the Camera Settings tab to display the following information:

4. Click another image to view its information, or close the Properties box.

### Printing an Image or Album

Image Expert offers many choices for printing an individual picture or album with titles, labels, or any text you want to add. You can print an image at full size (one per page) or choose the number of prints per sheet of paper. You can also specify a size, or print combinations with standard sizes for framing.

Follow these steps to print:

1. Open the image or album you want to print.

2. Click the Print Layout button or choose Print Layout from the File menu. The Print Layout window appears with a preview of your printout.
3 Follow the instructions in the sections below to choose your layout style, add text, select album images, and adjust the printed area for your images.

4 When you’re finished designing your layout, click the Print button to print your picture(s).

**Choosing the Layout Style**
You can choose portrait or landscape orientation and select from a variety of layouts.

Follow these steps:

1 Click the Print Setup button if you need to select your printer or paper size. Otherwise, all layouts are set up for a standard letter-size sheet.

2 Click the Portrait button or Landscape button to change the orientation of the page.

3 Click the down arrow next to the size box to display the drop-down list of sizes and layout choices:

4 Choose the size and number of images you want per page. If you need a custom size, choose Custom Size. You can then enter exact dimensions for your picture, or size it in the layout window.
5 When the preview shows the layout you want, you can click the Print button or follow the instructions in the next sections to make other adjustments to your printout.

Adding Text
If you want to have image labels or page headers or footers printed with your pictures, follow these steps:

1 Click the Edit Text button. The Change Print Text dialog box appears:

2 Select Page Header, Page Footer, or Image Label, and then type the text you want to use in the Left, Center, or Right boxes (depending on how you want it to display). You can type different text for each box.

3 Click Change Font to set the font size, style, color, and so on for your header, footer, or labels.

4 Click Insert Special Text to choose one of the following for your header, footer, or labels (only some of the choices are available for each):

5 When you're finished designing your text, click OK. The text is previewed on your layout in the center of the screen.
Choosing Album Images
If you’re printing an album, Image Expert uses as many pages as necessary to print the entire album. If you don’t want to print all the images, you can choose the ones you want and position them in your layout. Follow these steps:

1. Click the Pick Images button. Your album appears in a “filmstrip” on the right side of your screen.

2. Choose the images you want to print, and drag each one where you want it to appear in the layout.

You may notice that some images are cropped. If you want to adjust the cropping, or zoom an image in or out, follow the instructions in the next section.

Adjusting the Printed Area
You can zoom in on an image, and then move it around to display just the portion you want. Follow these steps to adjust the printed area:

1. Double-click the image you want to adjust.
The other images fade out, and the sizing tools on the left side of the screen become active.

2 Click the **Zoom In** tool and then click on an image to enlarge and crop it.

You can also click the **Zoom Out** tool to reduce your image and display more of it.

3 Click the **Move** tool and then click on an image to move it and choose the portion you want to display.

4 Click the **Reset Size** button to return to the default size and layout.

5 When the preview shows the layout you want, you can click the **Print** button to produce your printout.

### Adding Audio to an Image

If your Windows system includes a microphone and a 16-bit sound card with speakers, you can add voice or musical annotations to your pictures. Follow these steps to add an audio recording to a picture in Image Expert:

1 Select an image in an album or open an image.

2 Click the **Record** button on the left side of your screen or select **Record Audio** from the Annotation menu to open the Record dialog box:
3 Select the option you want:

➤ To add audio to an image, choose **Record New**.
➤ To add additional sound to an existing audio clip, choose **Record Additional**.
➤ To end your recording, choose **Stop**.
➤ To listen to your new recording, choose **Play New**.
➤ To listen to your original recording, choose **Play Original**.

4 If you like your new recording, click **OK**. Otherwise, click **Undo** to delete the new recording, then repeat step 3 to make a new recording.

### Playing Back Sounds

When you open an image that has audio attached to it (indicated by a musical note), the audio clip automatically plays.

You can also select an image and use the buttons on the left side of the Image Expert window to listen to its audio clip:
Editing Sounds
You can use Image Expert to modify your recorded sounds by cutting or copying and pasting from one clip to another. Follow these steps:

1. Select an image that has an audio clip.
2. Click the **Edit Audio** button or choose **Edit Audio** from the Annotation menu. The sound wave window opens:

3. Click and drag to select a section of the audio clip, or the entire clip. You can perform the following operations:
   - Click the **Play** button to hear the section you selected.
   - Select **Cut** from the Edit menu to remove it.
   - Click **Copy** from the Edit menu to copy it.
   - Select another image and click **Paste** from the Edit menu to add the sound clip to the new image.

   **NOTE**
   To adjust recording or playback volume or modify other features, select **Audio Properties** from the Annotation menu. You can also click the sound icon on your Windows taskbar. Use the volume control on your speakers to quickly adjust playback volume.

Deleting Sounds
To delete an audio clip, follow these steps:

1. From an album, select the image with the sound you want to delete. (Don’t open the image.)
2. Select **Delete** from the Edit menu, or press the **Delete** key on your keyboard. The following message appears:
3 Check the **Only delete the audio** box, then click **Yes**.

### Displaying Albums as Slide Shows
When you display an Image Expert album as a slide show in Windows, you can have it play automatically with various transition effects between images. Follow these steps:

1 Open your album.

2 Click the Slide Show button or select **Slide Show** from the View menu.

   The first image appears on your screen with the slide show controls:

3 Click the Play button to see the slide show.

4 To change the look of your slide show, click the Options button.

   The Slide Show Options dialog box appears:

5 Set any of the following options and click OK:
   - To stretch your pictures across the whole screen, click **Fit to Screen**.
   - To change the display period for each picture, change the number in the **Seconds Between Pictures** box.

---

*Working With Photos and Albums 10-11*
To play the slide show only once, click Continuous Repeat to deselect it.

To hide the titles of your pictures, click Show Titles to deselect it.

To turn off the fades and dissolves that play between pictures, click Show Transition Effects to deselect it.

To turn off audio clips attached to your images, click Play Sounds to deselect it.

6 Click the Close button to stop the slide show.

Using an Album as a Screen Saver

If you're using Windows, it's easy to make your own screen saver with your favorite pictures. Follow these steps:

1 Open the Image Expert album you want to use.

2 Choose Set Screen Saver from the File menu. Image Expert asks you to confirm your choice.

3 Click Yes.

Windows will play a slide show of your album whenever your system is idle.

NOTE
The screen saver slide show doesn’t include controls. If you want to change the way your pictures are displayed, you have to use the screen saver settings in your Control Panel. See your Windows documentation or Help system for more information.

Setting an Image as Wallpaper

If you're using Windows, you can use one of your own pictures as your desktop background. Follow these steps:

1 Open or select your image in an Image Expert album.
2 Choose Set As Wallpaper from the File menu. The following dialog box appears:

![Set Wallpaper dialog box]

3 Choose Center to place your picture in the middle of the screen or Tile to fill the screen with copies of your picture.

4 If you want the image to be stretched across the whole screen, click Resize to fit screen.

5 Click Yes. (If you change your mind, click Remove Wallpaper.)

You can minimize Image Expert to see your new wallpaper.

---

**Copying to Diskette or Zip Disk**

If you’re using Windows, you can copy Image Expert albums or individual images to diskettes or Zip disks. You can also include a player, so your friends and business associates can view your pictures on their computers. This makes your images and albums completely portable.

Follow these steps:

1 Insert a diskette into your diskette drive or a Zip disk into your Zip drive.

2 Open the Image Expert album you want to copy.

If you don’t want to include all of your images, select the images you want to add. To select more than one image, hold down the Ctrl or Shift key.
3 Select Save To Floppy from the File menu. You see the following dialog box:

![Save To Floppy dialog box]

4 Make sure your diskette drive or Zip drive letter appears in the Copy images to box.

5 To include a slide show player to view the pictures, make sure Include Slide Show Player is checked.

6 If you want to copy the whole album, make sure there is no check mark next to Selected Images Only.

7 Click OK to copy your files.

### Viewing the Pictures on Diskette or Zip Disk

To run the slide show player, double-click the player icon or player.exe file on your diskette or Zip disk. The pictures appear on your screen with the slide show controls, as shown below:

![Slide show player]

The slide show player works the same way that the slide show works in Image Expert. See page 10-11 for instructions on setting slide show options.
Sending Pictures and Sound by E-mail

If you’re using Windows and your e-mail application complies with the MAPI (messaging application programming interface) standard, you can send a picture directly from Image Expert. For example, you can use Inbox or Microsoft Exchange. You need to set up Microsoft Exchange to work with your Internet service.

NOTE
If you can’t e-mail pictures directly from Image Expert, you can always send an e-mail message as you do normally and attach one or more image and sound files.

Before you start, make sure your modem and Internet service are working correctly and your e-mail application is configured. Then follow these steps:

1. Open an album in Image Expert.

2. Select or open the image(s) you want to send. Some e-mail systems may limit the number of images you can send in a single message.

   NOTE
   If no images are selected, all images in the album will be sent.

3. Choose Send from the File menu. You see the Choose Profile dialog box:

   Click New if your Internet service has not been set up to work with Microsoft Exchange. For more information about setting up Microsoft Exchange, see your Windows documentation or Help system.

Working With Photos and Albums 10-15
5 Click **OK**. Your e-mail application opens, and the image(s) you selected appear as attachments.

6 Type the e-mail address where you’re sending the picture(s). You can also type in a subject heading and message if you want.

7 When your e-mail is ready, click whatever button your application uses to send. The picture(s) are mailed.

Your e-mail application closes, and Image Expert becomes active again.
You can edit your images to enhance their appearance, crop, rotate, and resize them, or create special effects.

This chapter describes the following Image Expert features:

- Viewing and selecting images
- Applying Quick Fix
- Correcting an image
- Cropping an image
- Resizing an image
- Rotating and flipping an image
- Applying special effects
- Changing the number of colors
Viewing and Selecting Images

When your image is displayed in an album, you can rotate it or do a quick fix. However, to use any other editing features, you need to open the image by double-clicking it or selecting Open Image from the File menu.

Before you edit your image, you may want to use the Zoom and selection tools on the left side of your screen.

- Click Zoom, and then click anywhere on your image to enlarge your view. Right click or hold down the control key and click to zoom out.
- Use one of the three selection tools (Select Rectangle, Select Ellipse, Select Freehand) to isolate a part of your image before you edit it. Click the tool, then click and drag on your image to select the portion you want to work on.
- Click Select All to select your entire image or all the images in an album.
- Click Select None to deselect your image or images.

NOTE
For more information about any of the editing tools described in this chapter, use the Help menu.
Applying Quick Fix
The easiest way to improve your image is to have Image Expert automatically “correct” it with the Quick Fix command. Follow these steps:

1. Double-click your image to open it in the Image Expert window.

2. Click the Quick Fix tool or select Quick Fix from the Image menu.

If you don’t like the results, simply select Undo Quick Fix from the Edit menu.

NOTE
If you Quick Fix an image displayed in an album (without opening it in the Image Expert window), you can’t undo it.

Correcting an Image
To fine-tune an image, follow these steps:

1. Double-click your image to open it.

2. Click the Corrections tool or choose Corrections from the Image menu. You see a window like the following:
3 Click the tabs at the top of the screen to make these kinds of corrections:

- **Contrast and Brightness**
  For adjusting the amount of light in your image and the difference between light and dark areas.

- **Color**
  For correcting color casts and adjusting the balance of cyan (blue), magenta (red), and yellow; and red, green, and blue in your picture.

- **Hue/Saturation**
  For adjusting colors around the “color wheel,” the strength or purity of color, and the brightness of your image.

- **Sharpness**
  For emphasizing or de-emphasizing edges and details.

- **Equalization**
  For increasing and brightening detail in dark areas of your image.

Each dialog box tab includes sliders for quickly and easily correcting your image. Simply move the slide indicator left or right to make your edit.

The preview window shows your image with the original view on the left and the corrected image on the right. If you want to adjust the division between the original and edited image, click and drag the triangle below the image. You can also zoom in on your image to see more detail.

4 Do one of the following:

- Click **Apply** to make your changes on the current tab. Your edited image becomes your new original and the slide indicators move to the center of the range.

- Click **OK** to save the changes you made on all the Corrections tabs and return to the main screen.

- Click **Cancel** to cancel the changes on the current tab and return to the main screen.
**Cropping an Image**

If you want to save only part of your image, use the crop function to cut out the rest of the image. Follow these steps:

1. Double-click your image to open it in the Image Expert window.
2. Click one of the selection tools.
3. Click and drag the mouse over the area you want to save. A dashed border indicates the area you selected.
4. If you change your mind about which part of the image to crop, simply click anywhere outside the selected area of the image and repeat step 3.
5. Click the Crop tool or choose Crop from the Image menu. The part of the image that was outside the dashed line disappears.

**Resizing an Image**

You can resize your image by changing the number of pixels. This lets you maintain the image's original resolution or pixels per inch.

1. Double-click your image to open it in the Image Expert window.
2 Choose **Resize** from the Image menu. You see a dialog box like the following:

![Image Resize dialog box](image)

3 Type a new number for the width or height.

To maintain your image’s proportions, both numbers change together. If you want to distort your image, click **Preserve Aspect Ratio** to deselect it.

**Rotating an Image**

You can click the Rotate tool to quickly rotate a picture to the right. For more options, open the image you want to change and select **Rotate** from the Image menu.

**NOTE**

If you rotate an image displayed in an album (without opening it in the Image Expert window), you can’t undo it.

You can choose one of the following:

- **Left** (90 degrees counterclockwise)
- **Right** (90 degrees clockwise)
- **Exact** (specify the degree of rotation)
- **Free** (interactive rotation, as described below)
If you want to experiment with rotation, choose Free and follow these steps:

1. Click on your image and hold down the mouse. Your pointer turns into the rotation tool.

   A rectangular outline of your image and an arrow appear, as shown:

   ![Rotation Tool Image](image)

2. Move the pointer to rotate your image.

3. Release the mouse when your picture is at the angle you want.

**Flipping an Image**

You can reverse your image by following these steps:

1. Double-click your image to open it in the Image Expert window.

2. Do one of the following:
   - Select Flip Horizontal from the Image menu. (This is useful for printing T-shirt transfers.)
   - Select Flip Vertical to turn your image upside down.
Applying Special Effects

To transform or distort your images in interesting ways, follow these steps:

1. Open your image in the Image Expert window, then choose Effects from the Image menu. You see a dialog box like the following:

![Image Effects dialog box]

2. Click the tabs at the top of the screen to add these effects:

   - **Ripples**
     For an underwater effect. You can create whirlpool effects or just a slight distortion.
   - **Glass blocks**
     You can change the number and size of the blocks.
   - **Edges**
     To sharpen edges. You can also blend the image into a light or dark background.
   - **Fisheye**
     To distort the center of the image, as if looking through a glass ball.
   - **Invert**
     To create a negative of your image, or to “solarize” it.

11-8 Editing Images
Each dialog box tab includes sliders for applying the effect. Slide the indicator to the right to increase the distortion. You can combine several filters for even more unusual effects.

The preview window shows your image with the original view on the left and the distorted image on the right. If you want to adjust the division between the original and filtered image, click and drag the triangle below the image. You can also zoom in on your image to see more detail.

3 Do one of the following:

- Click **Apply** to make your changes on the current tab. Your distorted image becomes your new original and the slide indicators move to the center of the range.
- Click **OK** to save the changes you made on all the Effects tabs and return to the main workspace.
- Click **Cancel** to cancel the changes on the current tab and return to the main workspace.

### Changing the Number of Colors

To convert the color format of your image, open it and select **Number of Colors** from the Image menu. You can choose from the following:

- **24 Bit** (Millions of Colors)
  The way your images are originally captured.
- **8 Bit** (256 Colors)
  For low-resolution display systems or certain types of software.
- **Grayscale** (256 Shades of Gray)
  For printing in black and white.

If you save your image as 8 Bit or Grayscale, you cannot switch back to 24 Bit color.

**NOTE**

Unlike the other editing options, changing the number of colors applies to the whole image. You can’t change the number of colors for a selected area only.
When the camera is connected to your computer, you can take pictures with a live preview on your computer screen to help you frame each shot. You can also set the camera’s clock and adjust a number of other settings from your computer.

This chapter covers the following:

- Taking pictures from your computer
- Adjusting camera settings from your computer

**NOTE**
You can use either Image Expert or EPSON Photo!3 to take pictures from your computer, adjust camera settings, and transfer images. PhotoPC 850Z allows you to choose the application that best meets your needs and preferences.

**Taking Pictures From Your Computer With Image Expert**

When you connect the camera and take pictures from your computer, you see a live preview of each shot before you capture it. You can control camera settings from your computer, and even set the shutter speed.

**NOTE**
If you have the optional AC adapter, you can save on batteries by using it when you connect the camera to your computer. The AC adapter should be available where you bought your PhotoPC 850Z, or you can order it from EPSON Accessories. See page A-2 for more information.
Follow these steps to take pictures from your computer:

1. Connect the camera to your computer as described in Chapter 8.

2. Position the camera facing the subject. Using a tripod will give you the most control when setting up your shots. See page A-3 for instructions.

3. Turn on your computer, then turn the camera dial to either or .


5. If necessary, close the Quick Tour and the Image Expert tip screen.

6. Click the Camera Controls button or choose Controls from the Camera menu.

You see a dialog box like the following:

7. Click Continuous Update to activate the live preview feature. The image you see is updated every 8 to 10 seconds, depending on your connection speed. You may need to move the camera or your subject until you see the image you want to capture.

The colors in your live preview image may appear pale and washed-out. This will not affect the colors in your actual photograph.
You can click the Flash and Resolution buttons on the screen to adjust these settings just as you would by using the buttons on the camera. For more information about the flash and resolution (image quality) settings, see Chapter 2.

**NOTE**
When the camera is connected to your computer, you can’t use any of the control buttons or the shutter button on the camera. You can operate these features only through your computer.

8 When your shot is ready, click Take Picture. The image is captured and processed.

9 Click Close when you’re finished taking pictures from your computer.

**NOTE**
The live preview feature quickly drains your batteries. Make sure you turn it off as soon as you’re finished, or use the optional AC adapter.

---

**Using the Self Timer**
You can use this feature to have your computer take a picture automatically, after a delay period that you can set. This allows you to take self-portraits and other specialized shots.

Follow these steps:

1 Click **Self Timer**. You see the following dialog box:

![Self Timer dialog box]

2 Enter a number for the delay period you want to use. You can set up to a 120-second delay.

3 Click **Start/Stop** to start the countdown and take the picture. The red timer light on the camera remains on for the delay period you entered. Then the light flashes rapidly for 2 seconds and the shutter is released.

The camera clicks and processes your picture.
Taking Pictures With EPSON Photo!3

You can use your EPSON Photo!3 application to take pictures from your computer, in the same way as Image Expert.

1. Connect the camera to your computer as described in Chapter 8, and then position the camera facing the subject.

   **NOTE**
   Using a tripod will give you more control when setting up your shots. (See page A-3 for instructions on using a tripod.)

2. Turn on both your camera and your computer, then open the camera lens. Make sure the camera dial is set to or .

3. Start EPSON Photo!3. (Click Start, and then point to Programs, EPSON Photo!3 Ver.1, EPSON Photo!3 Ver 1.)

4. Click the Controls tab. You see a dialog box like the following:

5. Click Start to display the live preview.

   The colors in your live preview image may appear pale and washed-out. This will not affect the colors in your actual photograph.
You can use the **Mode**, **Flash**, **Self Timer**, and **Macro** controls on the screen to adjust these settings just as you would by using the buttons or LCD menus on the camera.

6. When your shot is ready, click **Take a Picture**. The image is captured and processed.

7. Click **Close** when you’re finished taking pictures from your computer.

The Auto-Stop Timer shuts off the live preview after one minute to save battery power. You can set the timer from 30 seconds to 5 minutes.

---

**NOTE**
If you have an external flash unit attached and have changed the flash setting to **EXT** (external), you can’t change the flash mode. To change the setting back to **INT** so you can use the camera’s built-in flash, see page A-5.

---

**Adjusting Camera Settings From Your Computer**

You can use either Image Expert or EPSON Photo!3 to change the following camera settings:

- **Time**
- **Date**
- **Camera ID**
- **Connection Port**
- **Connection Speed**

**Changing Settings With Image Expert**

You can change settings in Image Expert while you’re viewing pictures in the camera. Follow these steps:

1. Connect the camera to your computer as described in Chapter 8.

2. Turn the camera dial to [ ], then turn on your computer system.

*Operating the Camera From Your Computer 12-5*
3 Start Image Expert, then select **Properties** from the **Camera** menu. The Camera Properties menu appears:

- Enter a new **Description** of the camera to change the default. This might be useful if you have more than one camera and you want to record its description in your picture data.
- Type in the **Camera Time** box to change the time and date. Or, click **Set Camera to Computer Time** to automatically synchronize your camera to your computer.

4 Click **OK** to save your settings and exit the Camera Properties dialog box.

5 If you want to adjust your port settings, select **Connection** from the **Camera** menu. You see the Connection dialog box:

- If necessary, select a new source. The standard selection is **Serial/USB**. If you're using a PCMCIA adapter to access a PC card slot, select **PC Card** in the **Connect Via** drop-down list. (**FlashPath** is not implemented on the PhotoPC 850Z.)
Select another port if you want to change your connection. In most cases, it’s best to leave the Port setting at Auto because Image Expert can detect the camera connection automatically.

Select a different communication speed. Image Expert automatically chooses the fastest speed that works with your system. This may actually be too fast for the configuration of your port. You may need to experiment to choose the best speed. (See your Windows documentation or help system to change the port speed for your computer.)

Click OK to save your settings and exit the Connection dialog box.

Changing Settings With EPSON Photo!3
You can also change settings in EPSON Photo!3 while you’re viewing pictures in the camera. Follow these steps:

1. Connect the camera to your computer as described in Chapter 8.
2. Turn the camera dial to , then turn on your computer system.
3. Start EPSON Photo!3, then click the Setup tab to display the following dialog box:
4 Change any of the following **Computer Connection** settings:

- Select another port if you want to change your connection. In most cases, it's best to leave the Port setting at **Auto** because EPSON Photo!3 can detect the camera connection automatically.

- Select a different communication speed. EPSON Photo!3 automatically chooses the fastest speed that works with your system. This may actually be too fast for the configuration of your port. You may need to experiment to choose the best speed.

5 Click **Test Connection** to make sure your new settings work with your system.

6 Click the **Set Time** button to change the camera’s time and date settings.

You see a dialog box like the following:

```
Enter new values for the settings, or click Copy from Computer to have your camera automatically synchronized to your computer. Click **OK** to return to the Setup dialog box.
```

7 Enter a new **Camera ID** if you want to change the default. This might be useful if you have more than one camera and you want to be able to have its ID recorded in your picture data.
You can connect your camera to a multimedia projector or television and show not just photos, but also text and graphics. The EPSON Photo File Uploader3 lets you transfer images and sounds from your computer to your camera’s memory card. Anything you can display on your computer screen can be captured, converted, and uploaded. You can create and show a presentation without printing overhead transparencies or slides, and without a laptop computer.

This chapter explains the following:

- Uploading images to the camera’s memory card
- Converting presentations
- Projecting your presentation

Uploading Images to the Camera

The EPSON Photo File Uploader3 software allows you to convert any image or presentation slide to the EPSON Photo file format and upload it to your CompactFlash memory card.

You can upload images in 640×480 pixel, 1600×600 pixel, or 1600×1200 pixel sizes. EPSON Photo File Uploader3 automatically converts images from their original size to whichever of these sizes you choose.

NOTE 
Images that have been cropped will display black strips in the areas that have been cropped out.
Uploading Images From Your Windows PC

Before you start, make sure the camera is connected to your computer, the computer is on, and the camera dial is turned to . Then follow these steps:

1. Start the EPSON Photo File Uploader3 program. Click Start, point to Programs, EPSON PhotoFile Uploader3, then click EPSON Photo File Uploader3. You see a screen like the one on the right.

   NOTE
   Only one application at a time can access the camera. Make sure neither EPSON Photo!3 nor Image Expert are running.

2. Use the Drive and Folder lists to locate the folder containing the images you want to upload. Double-click the folder to select it.

   The images in the folder are listed in the File Name box.

   NOTE
   If you want to upload images from a network drive, you may need to map the drive before opening the EPSON Photo File Uploader3 software. See your Windows documentation for more information.
3 Select the format of the images you want to upload from the Files Type list.

4 Select the images you want to upload in the File Name list. Then click the –> button. If you want to upload all the images in the list at once, click the >> button.

As you select files, they appear in the Selected Files List in the order they will be uploaded. This determines the sequence in which you can display the images.

- To rearrange the uploading (and display) order, select the image you want to reorder, then click the ↑ or ↓ sort arrow.
- If you want to change your selection, click the <- button to remove selected files or click the << button to remove all the files from the Selected Files List.
- If you want to preview a selected image and confirm its size, click the Preview checkbox.

5 For each file in the Selected Files List, choose an image size from the Image Size box. The File Uploader resizes your files during the transfer process.

If you want to save copies of the converted files on your computer, click the Save file to checkbox. Click Browse, then select the folder where you want to save the files. Click OK. The folder you selected is displayed to the right of the Browse button.
6 If you want to upload an audio recording with a file, highlight the file name in the Selected Files List and click the **Select Sound** button. From the Open dialog box, select your sound file and click **Open**. If you want, click the **Play Sound** button to play the sound or the **Delete Sound** button to remove it.

7 Click the **Start** button. EPSON Photo!3 opens and displays the images you selected:

Depending on the number of images, you may have to wait a minute or so for EPSON Photo!3 to open.

8 Click **Select All** to select all the images, or select individual images by clicking the thumbnails in the image selection window.

9 Click **Upload/Copy**.

The Upload/Copy Photos dialog box appears:

13-4 *Using Your Camera for Presentations*
10 Click **Upload into the Camera** to upload the images to your camera’s memory card, or click **Copy to a Memory Card in a drive** to upload to a memory card installed in your computer’s PCMCIA drive; then click **OK**.

**NOTE**

If your camera’s memory card can’t hold all the images, you can purchase a larger card. See Appendix A for details.

The images are uploaded to the destination you selected. If you clicked the **Save file to** checkbox in step 5, the converted images are also saved to the folder you specified.

### Uploading Images From Your Macintosh

Follow these steps to upload images to your camera from your Macintosh:

1. Make sure the camera is connected to the computer, the computer is turned on, and the camera dial is turned to 📸.

2. Double-click the **EPSON Photo File Uploader 3** icon in the **EPSON Photo File Uploader** folder. The **EPSON Photo File Uploader3** dialog box opens, as shown on the next page.

**NOTE**

Only one application at a time can access the camera. Make sure neither **EPSON Photo13** nor **Image Expert** are running.

3. Click **Add**. The Select Files dialog box appears.

4. Double-click the folder containing the images you want to upload, then select each file you want to upload and click **Select**.

**Using Your Camera for Presentations 13-5**
If you want to preview a selected image and confirm its size, click the **Preview** checkbox. It takes a few seconds longer to select images with previews displayed.

5 When you finish selecting image files, click **Done** to close the Select Files dialog box. The selected images appear in the **Selected File List** in the order they will be uploaded. This determines the sequence in which you can display the images.

- To rearrange the uploading order, select the image you want to reorder, then click **Up** or **Down**.
- To remove files from this list, select the file(s) and click **Remove**.

6 For each file in the **Selected File List**, select an image size from the **Image Size** box. The File Uploader will resize your files during the transfer process.

   If you want to save copies of the converted files on your computer, click the **Save file to** checkbox. Click **Browse** to open the Select Folder dialog box, then select the folder where you want to save the files. Click **Select** to close the Select Folder dialog box. The folder you selected is displayed to the right of the **Browse** button.
If you want to upload an audio recording with a file, highlight the file name in the Selected Files List and click the Select Sound button. From the Open dialog box, select your sound file and click Open. If you want, click the Play Sound button to play the sound or the Delete Sound button to remove it.

Click Upload. A window opens to show you the progress of the file conversion. Then EPSON Photo!3 opens and displays the images you selected:

9 Click Select All to select all the images, or select individual images by clicking the thumbnails in the image selection window.

10 Click Upload. The Upload/Copy Photos dialog box appears.

11 Click Upload into the Camera to upload the images to your camera, or click Copy to a Memory Card in a drive to upload to a memory card installed in the PCMCIA drive of your Macintosh; then click OK. The images are uploaded to the destination you selected.
If you clicked **Save file to** in step 6, the converted images are also saved to the folder you specified.

12 Click **Close** to exit EPSON Photo!3.

### Converting Presentations

If you want to upload a presentation or document that is not saved as a standard image file, you can make a “screen capture” of your computer desktop with the file open. This lets you turn any document or presentation into a series of image files that you can convert and upload to your camera’s memory card.

**NOTE**

If you want to upload a PowerPoint presentation, you don’t need to use this conversion procedure. You can save the slides as JPG files in PowerPoint, and then upload them into the camera. Choose **Save As** from the PowerPoint File menu and choose **JPEG File Interchange Format** as the file type.

Windows users can make screen captures from within the EPSON Photo File Uploader3 utility; Macintosh users need to use the standard Macintosh screen capture function.

### Capturing Windows Screens

Before you start, make sure the camera is connected to your computer, the computer is turned on, and the camera dial is turned to **. Then follow these steps:

1. Start the EPSON Photo File Uploader3 program. Click **Start**, point to **Programs**, **EPSON Photo File Uploader3 Ver.1**, then click **EPSON Photo File Uploader3**. You see the EPSON Photo File Uploader3 window.

**NOTE**

Only one application at a time can access the camera. Make sure neither EPSON Photo!3 nor Image Expert is running.

2. Click the **Screen Capture** tab. The Screen Capture dialog box appears, as shown on the next page.
3. Use the Drive and Folder lists to select the folder where you want to save the screen capture. To create a new folder for the images, click the New Folder button.

4. Specify the key combination you want to use for screen captures in the Hot Key setting box. Click the ALT, CTRL, or SHIFT checkbox, then select a function key from the hot key list. The default hot key is F5.

5. Click Start to activate the key combination. When the key combination is activated, the Start button changes to a Stop button. The key combination remains active only for the current session. To deactivate the hot key combination, press the Stop button.

6. Start your application and open the file to the page or image you want to capture.

**NOTE**
The entire screen is captured, not just the active window. Make sure you maximize your presentation before you capture it. If you set your application to “slide show” mode (or the equivalent) you can capture just the image you want, without menus and other screen elements.

7. Press the hot key combination you selected. Your screen capture is assigned a file name and saved to the folder that you specified.

You can make as many screen captures as you’d like; simply open each file you want to capture and press your screen capture key combination again.

*Using Your Camera for Presentations 13-9*
When you're finished, close your application and click the **Stop** button on the Screen Capture dialog box. The key combination you selected is erased.

If you want to upload your screen captures to the camera’s memory card right away, click the **Upload To Camera** tab. The screen capture files appear in the **File Name** list. Then follow the uploading instructions starting with step 4 on page 13-3.

**Tip**

*Presentations using large fonts (at least 18 point) work best.*

### Capturing Macintosh Screens

EPSON Photo File Uploader3 for the Macintosh does not have a screen capture feature. However, you can make screen captures using your Macintosh system software, then use EPSON Photo File Uploader3 to upload the screen captures to your camera’s memory card.

The procedure may differ slightly, depending on your Macintosh. See your computer manual for more information.

Make sure the camera is connected to your Macintosh, the computer is turned on, and the camera dial is turned to 📷. Then follow these steps:

1. Start EPSON Photo File Uploader3. Double-click the **EPSON Photo File Uploader 3** icon in the **EPSON Photo File Uploader** folder. The EPSON Photo File Uploader3 dialog box appears.
2. Start your application and open the file for the image you want to capture.
3. Press the **Command**, **Shift**, and **3** keys on your computer keyboard at the same time. Your Macintosh names and saves the screen shot on your hard drive (not in a folder).

You can make as many screen shots as you’d like; simply repeat this step.
If you’re running OS 8.0 or later, you can capture just the active window. Press the Command, Shift, and 4 keys at the same time, then click the window you want to capture, or drag the cursor around that portion of the screen you want to capture.

If you’re running OS 7.5x, the entire desktop is captured, not just the active window. Make your document window as large as possible before you capture it. If you set your application to “slide show” mode (or the equivalent), you can capture just the image, without other screen elements.

When you’re finished, close your application.

To upload your screen shots to the camera, click the EPSON Photo File Uploader3 window to make it active, then follow the uploading instructions starting with step 3 on page 13-5.

Projecting Your Presentation

You can display the uploaded images and sounds on a multimedia projector, television, or other video output device. Use the video cable that came with your camera.

NOTE

Using the optional AC adapter is highly recommended when you project your presentation. See page A-2 for instructions and ordering information.

Follow these steps:

1. Make sure your camera and TV or video projector are turned off.

2. Open the camera’s connector cover and connect the black end of the video cable to the AV Out port, as shown below:
3 Connect the yellow end of the video cable to the VIDEO IN port and the white end of the cable to the AUDIO IN port on the TV or projector.

4 Turn on the TV or video projector and switch it to video mode.

5 Turn the camera dial to 📸.

The last image that you uploaded to the camera is projected. If you are using the optional AC adapter, you can also see the image on the LCD screen.

You can use the camera’s slide show feature to play your images and sounds automatically, or play them one at time using the navigation buttons. You can use all of the camera’s other playback features to show your presentation.

13-12 Using Your Camera for Presentations
Your PhotoPC 850Z camera lets you print your pictures directly to any of several EPSON Stylus® color ink jet printers, without using a computer. You can choose from a number of layout options, select the type and size of the paper you want to use, and print using optional filters and print modes. You can print directly from the camera to any of the following printers:

- EPSON Stylus Photo
- EPSON Stylus Photo 700
- EPSON Stylus Photo EX
- EPSON Stylus Photo 750
- EPSON Stylus Photo 1200
- EPSON Stylus COLOR 740

NOTE
Using the optional AC adapter is highly recommended when you’re printing from the camera. The adapter should be available where you bought your camera. Or, see Appendix A for information on ordering an adapter from EPSON Accessories.

This chapter includes the following information about using the Direct Print program, which comes preinstalled in your camera:

- Connecting the camera to the printer
- Starting Direct Print
- Printing
- Removing and reinstalling the Direct Print program
- Reading error and status messages
Connecting the Camera to the Printer

Before you start, make sure you have the Macintosh/Direct Print serial cable that came with your camera. Then follow these steps to connect your camera to the printer:

1. Make sure both the camera and printer are turned off.
2. Connect the round end of the serial cable to the serial connector on the back of the printer. Make sure the arrow on the connector faces up.
3. Open the connector cover on the side of the camera.

NOTE
The Direct Print program is designed to print on special ink jet media, including Photo Quality Ink Jet paper or cards, glossy film, Photo Paper, and photo stickers. If you use plain paper, your pictures will not print with the highest quality. See your printer manual for information on special ink jet media available from EPSON.
4 Align the connector on the square end of the serial cable and the camera’s serial port. Then insert the connector.

NOTE
To disconnect the cable from the camera, squeeze and hold the two connector lock buttons on the sides of the connector while you pull the cable out.

Starting Direct Print

Follow these steps to start Direct Print:

1 Make sure the printer is turned off.

2 If you have the optional AC adapter, connect it to the camera to save battery power (see page A-2).

3 Turn the camera’s dial to

4 DirectPrint appears on the LCD screen. Press the button next to DirectPrint.

You see the Direct Print main menu:

Follow the steps in the next section to print different types of projects.

NOTE
You can usually press the bottom right button (under Back) to return to the previous screen while using Direct Print.
Printing
You can print any selected image(s) or all the images in your camera on various types of paper. You can print full size images, sticker sheets with multiple copies of the same image, and greeting cards. You can even create an album of your images with descriptive text next to each photo. The Direct Print main menu offers these choices:

<table>
<thead>
<tr>
<th>Print format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print All</td>
<td>Prints all the images stored on the memory card. You can print more than one copy of selected images.</td>
</tr>
<tr>
<td>Print</td>
<td>Lets you select the image(s) you want to print. You can print more than one copy of selected images.</td>
</tr>
<tr>
<td>Index</td>
<td>Prints a small thumbnail image of every picture on your memory card on contact sheets.</td>
</tr>
<tr>
<td>Album</td>
<td>Lets you print an album of selected pictures, with up to three different images on one sheet of paper. You can print one copy of each image.</td>
</tr>
<tr>
<td>Sticker</td>
<td>Prints 16 small copies of selected images on sheets of EPSON Photo Stickers.</td>
</tr>
</tbody>
</table>

The following sections explain how you use these print formats to set up and print different types of projects.

Printing Single and Multiple Images
The Print and Print All formats let you print both single and multiple images on a page. These formats allow the greatest variety of options. You can print on different paper sizes with an assortment of layouts, and you can use any of the available filters, paper types, or print modes. The following table shows the way the printout appears for different paper sizes.

<table>
<thead>
<tr>
<th>Layout options</th>
<th>Paper Size options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Letter</td>
</tr>
<tr>
<td>3.5 × 5</td>
<td></td>
</tr>
<tr>
<td>5 × 7</td>
<td></td>
</tr>
<tr>
<td>6.5 × 8.5</td>
<td></td>
</tr>
<tr>
<td>8 × 10</td>
<td><img src="image5" alt="Image" /></td>
</tr>
<tr>
<td>10 × 12</td>
<td><img src="image8" alt="Image" /></td>
</tr>
</tbody>
</table>
Turn on the printer and load your paper following the instructions in your printer manual, then follow these steps:

1. On the Direct Print main menu (shown on page 14-3), select your print format. If you want to print all the images on your memory card, press the top button (next to Print All). If you want to print selected images, press the + button (next to Print). You see a screen similar to the following:

2. Select your Paper Size and Layout settings by pressing the button next to the setting. For example, to select Letter as the Paper Size setting, press the button next to Paper Size (the top left button) until you see Letter displayed beneath the setting.

3. Press the ISO button (below the down arrow) if you want to change the Information or Filter settings. You see a screen similar to the following:

Press the top left button (next to Information) to change the Information setting. When the Information setting is On, your pictures print with the date and time they were taken.

NOTE
The Paper Size and Layout settings are linked, so sometimes you’ll see the Layout setting change as you cycle through the available Paper Size options.
Press the + button (next to Filter) if you want to modify the color of your printout. You can choose Monochrome to print your images in black and white, Blue to print them in blue tones, or Sepia to print them in brown tones for an old-fashioned look. If you select None, your color images print in color and your black and white images print in black and white.

4 When you’re done making changes to the Information and Filter settings, press the ISO button again to return to the previous screen.

5 If you want to select specific images (or print more than one copy of some images), press the bottom left button (next to Photo Selection).

You see thumbnail images of the first nine photos in the camera’s memory card, with the currently selected image framed in white:

NOTE
You don’t have to select images if you’re using the Print All format. However, you can choose to print more than one copy of some images.

6 To select a different picture, press the ISO button (below the left arrow) or the W.B. button (below the right arrow) to move the selection frame backward or forward through your pictures.
7 Now select the number of copies of your picture that you want to print (up to 99 for Print or Print All, one for other formats). Press the + button (next to the up arrow) or the − button (next to the down arrow) to increase or decrease the number of copies. A checkmark appears on your selected photo. (If you select 0 copies, the checkmark disappears.)

8 To rotate the photo 90 degrees in either direction, press the bottom left button (next to Rotation) once (clockwise) or twice (counter-clockwise). An icon appears on the image, indicating the orientation of the photo when printed.

**NOTE**
Some formats don’t allow you to rotate the image.

9 When you’re finished selecting your picture(s), press the bottom right button (under Back). You see a confirmation of your selection. If your selection is correct, press the bottom left button (next to Done).

If you need to change your selection(s), press the bottom right button (under Back or Select All) and repeat steps 6 through 9.

**Producing Your Printout**
Before you print, you’ll need to make a few more Direct Print settings. Follow these steps:

1 Press the W.B. button (beneath Print). The current print settings appear on the screen (your settings may vary).
2. Press the + button (next to Paper Type) to select the type of paper or film you loaded in the printer. (The Paper Size setting you previously selected is displayed beneath this setting.)

3. Press the bottom left button (next to Print Mode) to select either Normal, Fine, or Fast printing mode. Fine print mode produces a higher-resolution, slower printout. Fast print mode produces a quicker, lower-resolution printout.

4. If you need to adjust the printing position of your paper, press the top left button (next to Adjust). You see an adjustment screen like this one:

5. Press the + button (next to the up arrow) or the – button (next to the down arrow) to adjust the vertical position. Press the ISO button (under the left arrow) or the W.B. button (under the right arrow) to adjust the horizontal printing position.

   The position moves 0.2 mm each time you press a button, and the current adjustment distance is displayed on the screen. You can adjust the position up to 10 mm in any direction.

6. When you're finished, press the bottom right button (under Back) to return to the print settings menu.

7. Press the W.B. button (under Print) to begin printing. You see a confirmation message, then the LCD screen goes blank. The status light begins blinking and star icons march across the status display panel on top of the camera. Depending on the Print Mode option, it may take a moment for your printer to begin printing.

   If you see an error message while printing, see page 14-17 for instructions.
NOTE
If you need to cancel printing, hold down the MENU button. The status light turns red and a cancellation message appears briefly on the LCD screen. You see the print settings screen again. Repeat step 7 to resend your print job.

8 When you finish printing, the print settings screen reappears on the camera’s LCD screen. Press the bottom right button (under Back) several times to exit Direct Print. Then turn the camera dial to Off and turn off the printer.

Printing a Card
You also use the Print format to print cards. EPSON Photo Quality Ink Jet cards are perfect for snapshots, photo postcards, and many other uses. The following table shows the available paper sizes and layouts for your cards.

<table>
<thead>
<tr>
<th>Layout options</th>
<th>Paper Size options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Letter</td>
</tr>
<tr>
<td>Card Top</td>
<td>—</td>
</tr>
<tr>
<td>Card Middle</td>
<td>—</td>
</tr>
<tr>
<td>Card Bottom</td>
<td>—</td>
</tr>
<tr>
<td>PhotoCard</td>
<td>—</td>
</tr>
</tbody>
</table>
Follow these steps:

1. On the Direct Print main menu (shown on page 14-3), press the + button (next to Print) to select your print format. You see a screen similar to the following:

   ![Screen Screenshot]

   - Paper Size
   - A6
   - Layout
   - Photo Card
   - Print Size
   - 128x89mm
   - Information
   - Off
   - Filter
   - None
   - Photo Selection
   - Print
   - Back

2. Select your Paper Size and Layout settings by pressing the button next to the setting. Available paper sizes for cards are A6 and PhotoCard. (If your Paper Size is set to PhotoCard, the Layout is automatically set to PhotoCard.)

3. Press the ISO button (below the down arrow) if you want to change the Information or Filter settings. (See page 14-5.) When you’re done, press the ISO button again to return to the previous screen.

4. Press the bottom left button (next to Photo Selection) to select your image. Select a single image for your card. If your Paper Size setting is A6, you can rotate your image. (See page 14-7.)

5. When you’re ready to print your card, follow the steps on page 14-7.
Printing Album Images
The Album print format lets you print an “album” of selected images on Letter or A4-size paper. Up to three images are lined up on the left side of the page. If the Information setting is On, descriptive information about each image is automatically added on the right. The following table lists Layout and Paper Size options, and shows the way your printouts appear:

<table>
<thead>
<tr>
<th>Layout options</th>
<th>Paper Size options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Album</td>
<td>Letter or A4</td>
</tr>
</tbody>
</table>

Load your paper in the printer, then follow these steps to print album images:

1. On the Direct Print main menu (shown on page 14-3), press the bottom left button (next to Album) to select your print format. You see a screen similar to the following (the Paper Size setting defaults to A4 or Letter):

2. Select your Paper Size setting by pressing the button next to the setting. (The Layout setting is automatically set to Album.)
3 Press the ISO button (below the down arrow) if you want to change the Information or Filter settings. (See page 14-5.) When you’re done, press the ISO button again to return to the previous screen.

4 Press the bottom left button (next to Photo Selection) to select your images. (See page 14-6.)

5 When you’re ready to print your album, follow the steps under “Producing Your Printout” on page 14-7.

### Printing Stickers

When your print format is set to Sticker, you can print 16 small copies of a single image on sheets of EPSON Photo Stickers. You can select the following Paper Size and Layout settings:

<table>
<thead>
<tr>
<th>Layout options</th>
<th>Paper Size options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stickers 4</td>
<td>Sticker 16</td>
</tr>
<tr>
<td>1 photo x 16</td>
<td>—</td>
</tr>
<tr>
<td>2 photos x 8</td>
<td>—</td>
</tr>
<tr>
<td>4 photos x 4</td>
<td>—</td>
</tr>
</tbody>
</table>

**NOTE**
You can order EPSON Photo Stickers (product code S041144) from EPSON Accessories at (800) 873-7766. Stickers 4 sheets are not available in the U.S.
Load your photo sticker sheets in the printer, following the instructions that came with the stickers. Then follow these steps:

1. On the Direct Print main menu (shown on page 14-3), press the ISO button (under Sticker) to select your print format. You see a screen similar to the following (your Paper Size setting defaults to Sticker 16):

2. Select your Paper Size setting by pressing the top left button (next to Paper Size).

3. Press the + button (next to Layout) to select your sticker Layout. You can choose 1 photo × 16, 2 photos × 8, or 4 photos × 4.

4. Press the bottom left button (next to Photo Selection) to select the image you want to print on your stickers. You see thumbnail images of the first nine photos on the camera’s memory card, with the currently selected image framed in white.

5. To select a different picture, press the ISO button (beneath the left arrow) or the W.B. button (beneath the right arrow) to move the selection frame backward or forward through your pictures.

6. When you’ve selected your image, press the + button (next to the up arrow) to select 1 Copy. (You can’t rotate the image.) Then press the bottom right button (under Back). You see a confirmation of your selection.

NOTE
You can’t turn Information On or select a filter when the print format is set to Sticker.
7 If your selection is correct, press the bottom left button (next to Done). If you need to change your selection, press the bottom right button (under Reset) and repeat steps 4 and 5.

8 When you're ready to print your stickers, follow the steps on page 14-7. You may want to make a test print to make sure your pictures are aligned properly. Then you can use the Adjust setting to align them for your final printout.

NOTE
For stickers, the Paper Type setting is automatically set to Glossy Film and you can choose only Fine or Normal print modes.

Printing an Index of Your Images

The Index print format lets you print a contact sheet with thumbnail images of all the images on your memory card. The following table shows how your printout will look:

<table>
<thead>
<tr>
<th>Layout options</th>
<th>Paper Size options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Letter or A4</td>
</tr>
<tr>
<td>Index</td>
<td>A6</td>
</tr>
</tbody>
</table>

14-14 Printing Directly From the Camera
Follow these steps to print an index of all your images:

1. On the Direct Print main menu (shown on page 14-3), press the − button (next to Index) to select your print format. You see a screen similar to the following (your Paper Size setting will be different):

2. Select your Paper Size setting by pressing the top button (next to Paper Size). You can choose Letter, A6, or A4. The Layout setting is automatically set to Index.

3. If you want to print information for each image, press the ISO button (under the down arrow) to go to the following menu. Then press the top left button (next to Information) to turn it On.

   ![Screenshot of Direct Print menu]

   **NOTE**
   You can’t apply special filters when you’re using the Index print format.

4. When you’re done, press the ISO button again to return to the previous menu.

5. When you’re ready to print your index, follow the steps on page 14-7.
Removing the Direct Print Program

Direct Print comes pre-installed on your camera, but you can use the EPSON Program Uploader to remove it if you don’t plan to use it. You can always install the program later, if you need it. Follow these steps:

1. Connect the camera to your computer. (See Chapter 8 for instructions.) Then turn the camera’s dial to 📷.

2. Start EPSON Program Uploader: Under Windows, click Start, then point to Programs, EPSON Photo!3, EPSON Program Uploader. You see a screen similar to the following:

3. Select Direct Print V3.0 in the Applications in Camera listbox.

4. Click Remove. You see a confirmation message asking if you’re sure you want to remove it.

5. Click Yes to remove the program, or No to cancel. Then click Close to exit Program Uploader.

Reinstalling the Direct Print Program

Follow these steps to reinstall the Direct Print program to your camera:

1. Connect the camera to your computer and turn the camera’s dial to 📷.

2. Insert the PhotoPC 850Z CD-ROM in your drive. If the install program starts automatically, close it.

3. Start EPSON Program Uploader:

   Under Windows, click Start, then point to Programs, EPSON Photo!3, EPSON Program Uploader.
On a Macintosh, double-click the EPSON Program Uploader icon in the EPSON Photo!3 folder.

You see a screen similar to the following:

4 Click Browse to navigate to the root directory of your CD-ROM drive.

5 Select Direct Print V3.0 in the Applications in Folder listbox.

6 Click the Upload button. You see a progress meter, and after a moment Direct Print V3.0 appears in the Applications in Camera listbox. Click Close to exit.

---

Reading Error and Status Messages

If you see an error or status message on the camera’s LCD screen or status display panel, check the following tables to respond to the message.

**LCD screen messages**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Photos in Memory.</td>
<td>This message appears when there are no photos in memory. Press the button next to OK to return to the previous screen.</td>
</tr>
<tr>
<td>Please select at least one photo to print.</td>
<td>There are no photos selected to print. Press the button next to OK to return to the previous screen and select a photo.</td>
</tr>
<tr>
<td>Unsupported printer model.</td>
<td>The camera is connected to an incompatible printer. Connect the camera to one of the compatible EPSON Stylus models listed on page 14-1. Hold down the MENU button to cancel printing. You selected a paper size that your printer does not support. Select an appropriate paper size. (For information on paper sizes, see your printer’s documentation.)</td>
</tr>
<tr>
<td>Connection or printer error.</td>
<td>Printing stopped because of a printer error. Check your printer and clear the error (you may need to turn the printer and camera off and then on again), then restart printing from the beginning. (See your printer manual for troubleshooting information.)</td>
</tr>
</tbody>
</table>
## LCD screen messages (Continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK to erase printing settings?</td>
<td>You are about to erase the current print settings. Press the button next to YES (the bottom button) to erase the settings, or press the button next to NO (the top button) to save the settings and return to the previous menu.</td>
</tr>
<tr>
<td>Batteries are low. Use AC adapter.</td>
<td>Battery power is almost out. If you have the optional AC adapter, connect it to continue. Otherwise, replace the batteries with batteries that have been fully charged.</td>
</tr>
<tr>
<td>Error. Settings reset to default.</td>
<td>An unknown error occurred and your settings were returned to their defaults. Press the bottom button to return to the main menu and enter your print settings again.</td>
</tr>
<tr>
<td>Insert a Memory Card in the camera.</td>
<td>No memory card is installed in the camera, or the memory card is not fully inserted into its slot. Insert a memory card as described on page 1-8.</td>
</tr>
<tr>
<td>Printing canceled.</td>
<td>You held down the MENU button to cancel printing. The message disappears after three seconds.</td>
</tr>
<tr>
<td>Printing canceled. Reset printer and camera.</td>
<td>A printing error occurred. The message disappears after three seconds. Turn off the camera and printer, then turn them on and try printing again.</td>
</tr>
</tbody>
</table>

## Status display panel messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E51: Another interface is active</td>
<td>The printer is receiving a print job from another source (through a different interface). When that print job is finished, the printer begins printing from Direct Print automatically.</td>
</tr>
<tr>
<td>E55: No ink</td>
<td>Printing has stopped because the printer ran out of ink. Replace the ink cartridges and restart printing from the beginning. See your printer manual for instructions on replacing ink cartridges.</td>
</tr>
<tr>
<td>E56: No paper or paper jam</td>
<td>Make sure paper is loaded in the printer, then press the printer’s Load/Eject button to begin printing. If paper is jammed in the printer, follow the instructions in your printer manual to clear the jam. Then restart printing from the beginning.</td>
</tr>
</tbody>
</table>

**14-18 Printing Directly From the Camera**
Creating DPOF Files for Processing

Your PhotoPC 850Z includes the Print Mark program that lets you set up your images for printing, so you can drop off your CompactFlash card at a photo finishing lab and get the exact printouts you need.

This chapter includes the following sections:

- Introduction to the DPOF standard
- Making the DPOF file
- Confirming and changing DPOF file settings
- Deleting DPOF files
- Removing and Reinstalling the Print Mark program
- Reading error messages

Introduction to the DPOF Standard

The Digital Print Order Format (DPOF) is a new digital print standard that lets you create a file containing all the information a photo finishing lab needs to print your photos. Simply select the photos you want to print, specify the number of copies, and store the information in a DPOF file on your camera’s CompactFlash card. Give the card to any photo finishing lab capable of printing with the DPOF standard, and you’ll get the exact printouts you want.

NOTE
The DPOF standard is new, and may not be available at your local photo finishing lab yet.
Making the DPOF File

The Print Mark program on your PhotoPC 850Z lets you make a Digital Print Order Format file and save it on your camera’s CompactFlash card in one of two formats:

- Standard layout prints one photo per sheet
- Index layout prints several thumbnail photos per sheet

When you select Standard layout, you can choose to have an index sheet printed with your standard photo sheets, if you want.

Only one DPOF file can be stored on your camera’s CompactFlash card at a time. However, you can always add or delete images in the file or change the way it is set up before printing.

Follow these steps to make a new DPOF file in Standard or Index layout:

1. Turn the camera’s dial to 📸.

2. Press the button next to PrintMark. The Print Mark program’s main menu appears on the screen:

3. Press the top left button (next to New settings).

   If you’ve previously made a DPOF file, you see a message asking if you want to delete it. Press the top left button (next to Done) to delete it and set up a new file, or press the bottom left button (next to Cancel) to save your settings and return to the main menu.

4. Press the + button (next to Standard) to select Standard layout for printing one photo per sheet. Or, press the – button (next to Index) to print several thumbnails of your photos on each sheet.
5 If you are using the Index layout and you want to print only selected images, press the + button (next to Index print), then go to step 6. If you want to print all your images in the index, skip to step 12.

For Standard layout, go to step 6 to select images.

6 Press the bottom left button (next to **Select Image**). You see your saved images:

To enlarge a selected picture, press the top left button (next to the magnifying glass). Press the bottom right button (under **BACK**) to return to the selection screen.

7 Press the ISO and W.B. buttons (under the left and right arrows) to select photos. A white frame indicates your selection, and the number at the bottom of the screen shows the picture number.

8 Press the + or – button to specify how many copies (0 to 99) of each selected photo you want to print. When you select one or more copies for a photo, a checkmark appears in its upper right corner.

9 Repeat steps 6 and 7 to set the number of copies for each image you want to print. Once you have finished selecting photos, press the bottom right button (under **BACK**).

---

**NOTE:**
The Print Mark program displays up to 1000 pictures. Even if more pictures are stored in your memory card, the program displays only the first 1000.
You see a screen confirming the number of original photo frames you have selected to print:

When you press the button next to Done, you see a screen like the following:

10 Press the bottom left button (next to Done) to save your selections. If you want to change your selections, press the bottom right button (under BACK). If you want to quit Print Mark and keep your previous file settings, press the top left button (next to Cancel).

11 If you want to add an index print to a Standard layout file, press the – button (next to Add Index). (If you are creating an Index layout file, go to step 12.)

Press the + button (next to Index print) to select None, Selected (the images you have selected for your index print), or All.
12 Press the ISO and W.B. buttons (under the left and right arrows) to select the number of copies (up to 99) for your index print. (If you are creating an index for a Standard layout file, press the bottom right button [under BACK].)

13 Press the top left button (next to Save).

14 At the Confirmation screen, check your settings and press the W.B. button (under Save) to save your DPOF file.

15 Press the bottom right button (under Exit) to quit the Print Mark program.

**Confirming and Changing the DPOF File**

Follow these steps to confirm or change a file:

1 Turn the camera’s dial to 📷.

2 Press the + button (next to PrintMark). The Print Mark program’s main menu appears on the screen:

3 Press the + button (next to Confirm). You see the confirmation screen:

   ◗ To check the frame selections, press the W.B. button (under Conf. frame).

   ◗ To change the settings, press the ISO button (under Change) and follow steps 6 through 15 under “Making the DPOF File.”

4 Press the bottom right button (under BACK) to return to the Print Mark main screen.

Creating DPOF Files for Processing  15-5
Deleting the DPOF File

Follow these steps to delete a DPOF file:

1. Turn the camera’s dial to 📸.
2. Press the + button (next to PrintMark). The main menu appears:

   ![Main Menu](image)

3. Press the bottom left button (next to Delete). You see a confirmation message.
4. Press the top left button (next to Done) to delete the DPOF file. To keep the file and return to the main menu, press the bottom left button (next to Cancel).

5. Press the bottom right button (next to Exit).

Removing the Print Mark Program

You can use the EPSON Program Uploader to remove Print Mark if you don’t plan to use it. You can always install the program later, if you need it. Follow these steps:

1. Connect the camera to your computer. (See Chapter 8 for instructions.) Then turn the camera’s dial to 📸.
2. Start EPSON Program Uploader: Under Windows, click Start, then point to Programs, EPSON Photo!, EPSON Program Uploader. You see a screen similar to the following:

   ![Program Uploader](image)
3 Select PrintMark V2.0 in the Applications in Camera listbox.

4 Click Remove. You see a confirmation message asking if you’re sure you want to remove it.

5 Click Yes to remove the program, or No to cancel. Then click Close to exit Program Uploader.

**Reinstalling the Print Mark Program**

Follow these steps to reinstall the Print Mark program to your camera:

1 Connect the camera to your computer and turn the camera’s dial to 🎏.

2 Insert your PhotoPC 850Z CD-ROM in your drive. If the install program starts automatically, exit the program.

3 Start EPSON Program Uploader:

   - Under Windows, click Start, then point to Programs, EPSON Photo!3, EPSON Program Uploader.
   - On a Macintosh, double-click the EPSON Program Uploader icon in the EPSON Photo!3 folder.

   You see a screen similar to the following:

   ![EPSON Program Uploader](image)

4 Click Browse to navigate to the root directory of your CD-ROM drive.

5 Select PrintMark V2.0 in the Applications in Folder listbox.
6 Click the Upload button. You see a progress meter, and after a moment PrintMark V2.0 appears in the Applications in Camera listbox.

7 Click Close to exit.

Reading Error Messages

If you see an error message on the camera’s LCD screen, check the following table to respond to the message.

**LCD screen messages**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Photos in Memory.</td>
<td>This message appears when there are no photos in memory. Press the button next to OK to return to the previous screen.</td>
</tr>
<tr>
<td>You can no longer select an image.</td>
<td>You have selected the maximum number of photos that the program will allow you to print.</td>
</tr>
<tr>
<td>No memory Card Inserted.</td>
<td>No memory card is installed in the camera, or the memory card is not fully inserted into its slot. Insert a memory card as described on page 1-8.</td>
</tr>
<tr>
<td>Error! Unable to access DPOF file.</td>
<td>This message appears if the memory card is removed while using the Print Mark program. (Never remove a memory card during any operation, otherwise you may be unable to use the photos in the card.) Turn off the camera and re-insert the memory card.</td>
</tr>
</tbody>
</table>

**LCD screen messages (Continued)**

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batteries are low. Use AC adapter.</td>
<td>Battery power is almost out. If you have the optional AC adapter, connect it to continue. Otherwise, replace the batteries with batteries that have been fully charged.</td>
</tr>
<tr>
<td>You lost last print settings. Are you sure?</td>
<td>There is already a DPOF file saved on the memory card. If you create a new file, you overwrite the saved print settings.</td>
</tr>
<tr>
<td>DPOF file made by other writer exists.</td>
<td>This message appears if the Print Mark program tries to read a DPOF file made by a different camera. Delete the file or create a new file.</td>
</tr>
<tr>
<td>Unable to save DPOF file. No memory space in card.</td>
<td>The memory card doesn’t have enough space to save a DPOF file. To create a DPOF file, delete any unnecessary photos and try again.</td>
</tr>
</tbody>
</table>
Your PhotoPC 850Z requires only basic care. Before you perform any maintenance procedures, be sure to read the safety instructions in Appendix C. Then follow these guidelines:

Cleaning the Camera and Battery Charger
- Unplug the battery charger before cleaning.
- Use a clean, dry cloth to wipe the camera free of dust.
- Use a damp cloth for cleaning the battery charger.
- Keep the battery charger terminals clean by wiping them with a dry cloth.
- Don’t use harsh or abrasive cleaners. Don’t use liquid or aerosol cleaners.
- To clean the lens, first blow off any loose dust or dirt. Then breathe on the lens and wipe off all moisture with a soft, lint-free cloth or lens cleaning tissue. To avoid scratching the lens, don’t press too hard.

Caring for the Camera and Battery Charger
- Caring for the camera and battery charger
- Solving camera problems
- Solving picture problems
- Where to get help
If necessary, clean the battery contacts with a dry cloth.
If the LCD screen gets fingerprints or smudges on it, use a soft, damp cloth to lightly wipe the screen.

**Storing the Camera**
- When you’re not using the camera, make sure the camera dial is set to **Off**.
- When the camera is not used for long periods of time, remove the batteries and store them at a low temperature in a dry location. This prevents damage to the camera from battery leaks or corrosion.

Do not store the camera in the following locations:
- Where it will be exposed to direct sunlight, for example, on a car dashboard
- Near sources of bright light or high humidity
- Near heat sources or in a closed car or trunk
- In areas of excessive dirt or dust
- Where it will be exposed to strong vibrations or magnetic fields

**Solving Camera Problems**

Before you call for help, check this list of problems and possible solutions:

**The camera has no power.**
- If you’re using batteries, the camera may have shut off automatically to conserve battery power. If your camera dial is set to 📷, 📸, or 🎥, press the shutter button to turn the power back on. If your camera dial is set to 📷, 📸, or 📸, press any button on the back of the camera to turn the power on. (You can also turn the power on by turning the camera dial to **Off** and then back to its former position.)
- Check the batteries and make sure they’re installed correctly and charged. The included batteries need to be charged before you can use them (see Chapter 1). Recharge or replace the batteries.
- If you are using the AC adapter, make sure it’s plugged into a working outlet.
You can’t take a picture with the camera.

- The flash may be recharging. Wait until the status light (beside the viewfinder) turns green, and try again.
- Make sure you’ve installed the CompactFlash memory card in your camera. If it’s already installed, you may need to format or eject it (see Chapter 1). Check to see if a message is displayed on the camera’s LCD screen.
- The CompactFlash memory card may be full. Check the picture counter on the display panel. Erase some pictures (see Chapter 6), or transfer the pictures to your computer and then erase them (see Chapter 8). Or replace your memory card with a new one.
- The batteries may be low. If you see the low battery icon, recharge or replace the batteries (see Chapter 1) or use the optional AC adapter (see Appendix A).
- The camera may be connected to your computer. When it’s connected, you can’t use any of the controls on the camera itself. See Chapter 12 for instructions on taking pictures from your computer.

The camera takes too long to take a picture.

- You may be pressing the shutter all the way down at once. This forces the camera to focus, make exposure adjustments, and capture the image all at once. By pressing the shutter button partially to focus, then the rest of the way to capture the image, your camera can process pictures more quickly (see Chapter 2).
- You can turn on quick shot mode to take pictures quickly (see Chapter 3).

The flash doesn’t work.

- Make sure the flash is not set to the flash off setting.
- Check the batteries and make sure they’re installed correctly. Recharge or replace the batteries if necessary.
- You can’t use the flash in continuous shooting mode.
Check to make sure your camera’s flash setting is not set to use the optional external flash (see Appendix A).

**Nothing appears on the LCD screen.**
- Check your batteries and make sure they’re installed correctly. Recharge or replace the batteries if necessary.
- Make sure you’ve installed and formatted the CompactFlash memory card.
- The camera may have shut off automatically. If your camera dial is set to 📸, 🎞, or 🎥, press the shutter button to turn the power back on. If your camera dial is set to 📸, 🎞, or 📸, press any button on the back of the camera to turn power on. (You can also turn power on by turning the camera dial to Off and then back to its former position.)
- Make sure the camera is not in 📸 viewfinder mode.
- The LCD screen turns off automatically when the camera is connected to a TV, or when you are using EPSON Photo!3.

**The image on the screen is too dark.**
- Adjust the brightness of the screen using the Camera Setup menu. See page 7-3 for instructions.
- Make sure the Solar Assist panel is not open. Set the panel’s switch to 📸.

**The menus disappear while you’re taking pictures with the LCD screen.**
- The menus disappear when you press the MENU button. Press the MENU button again to make them reappear.

**You can’t take certain types of pictures or make all the settings you want.**
- Some of the camera’s settings and features can’t be used at the same time. For example, you can’t use quick shot mode and set the image quality to HyPict at the same time.
To adjust certain settings like white balance, exposure, and sensitivity settings, you need to set your user mode to Program or Manual. See page 1-13 for details.

**Nothing appears on the television or the sounds don’t play when you connect your camera to it.**

- Make sure the video and audio cables are connected correctly, as described on page 13-11, and the camera and TV are turned on.
- Make sure your camera dial is set to  .
- If your TV has both Video and S-Video modes, make sure it is set to Video mode. See the manual for your television if you need help.
- Check your batteries and make sure they’re installed correctly. Recharge or replace the batteries if necessary.
- Make sure your camera is set to the correct broadcast signal system (see Chapter 7). Also see your television’s documentation for possible solutions.
- Check your playback settings to make sure the sound setting is turned on (see Chapter 6).

The “pictures remaining” number on the display panel doesn’t decrease after you take a picture.

- Your camera is operating correctly. The total number of pictures you can store depends on your pictures’ content. The number doesn’t always change, especially when you’re using standard image quality.

**You get an error message when you try to transfer your pictures to the computer.**

- Make sure the cable is connected correctly as described in Chapter 8.
- Make sure your camera is turned on and the batteries have enough power.
- Check the serial port settings in your Image Expert or EPSON Photo!3 software. You may need to change the Port and Speed serial connection settings to Auto.
- If you’re using a Windows system and have trouble connecting to the COM port, check the computer’s COM port settings. Make sure the port is properly
configured and that the Base I/O port address and the Interrupt Request Number (IRQ) assigned to the port are not in conflict with any other devices.

◗ Check the port setting in your Windows Control panel. You may need to set your port to a faster speed, lower the FIFO buffer size (advanced serial port configuration), or adjust the speed in your software. See “Adjusting Camera Settings From Your Computer” on page 12-5 for more information.

◗ If you’re using a Macintosh and the camera is sharing a serial port with another device, turn AppleTalk off.

◗ If your camera is connected to a USB hub, try connecting the camera directly to your computer.

◗ Make sure you don’t have both Image Expert and EPSON Photo!3 open at the same time.

You get a “The Camera Is Not Responding” error message when you’re using your PhotoPC 850Z software with the camera connected to your computer.

◗ Make sure the cable is connected correctly as described in Chapter 8. Also make sure your camera dial is not turned off and the batteries have power.

◗ Check the serial port settings in your Image Expert or EPSON Photo!3 software. You may need to change the Port and Speed serial connection settings to Auto.

◗ If you were able to use the camera with the computer previously and then changed or added other settings on your system, you may have a COM port conflict. Try using a different COM port or reconfiguring the COM port settings. (See your Windows documentation for instructions.) If you were not able to use the camera with your computer previously, you may have an inoperable serial cable. Try using another cable.

◗ If your camera is connected to a USB hub, try connecting the camera directly to your computer.
Avoid opening or working with other software applications while the camera and computer are communicating.

You are unable to drag and drop photos into a document.

- If your system has less than 32MB RAM, you may not be able to use drag and drop. Make sure you don’t run too many applications at the same time. You may need to add memory to your system or use another method of getting photos into your documents.
- Your application may not support this method of adding pictures.

You are unable to copy and paste or import your photo into a document on your Macintosh.

- Try increasing your virtual memory using the Memory Control Panel. Also increase the memory allocation for your word processor or other application. (Select the application and choose Get Info from the File menu.)
- Try turning off any unnecessary extensions. See your Macintosh documentation for more information.

The pictures transfer to your computer too slowly.

- If your system has less than 32MB RAM, the transfer speed may be slow. Try using virtual memory. See your computer documentation or system help for more information.
- Check the port setting in your Windows Control panel. You may need to set your port to a faster speed. See your Windows documentation or help system for more information.
- If you’re transferring pictures to an application through EPSON Photo!3 and you use the PhotoEnhance feature, the transfer will take longer. Try transferring without PhotoEnhance.

You get a TWAIN error message when you try to transfer images with Adobe® Photoshop.

- Make sure you select TWAIN_32, not TWAIN.
You are unable to format or use a CompactFlash storage card with your camera.

- Make sure you’re using an ATA-compatible CompactFlash card. Other cards may not work with PhotoPC 850Z. If you need help with a card, call the appropriate manufacturer’s number. Some are listed below:
  - Lexar Media, (800) 789-9418
  - SanDisk, (408) 542-0595
- Make sure you’ve installed the card correctly. The card’s label should be facing the front of the camera, and the arrow(s) on the label should point down.

Your notebook computer’s PCMCIA drive can’t access a CompactFlash storage card with a PCMCIA adapter.

- If you’re using an IBM® Thinkpad™ you may need an updated driver for your PCMCIA port. Call IBM technical support.

When you upload pictures to a storage card in your computer, your system appears to hang.

- Check the status bar at the bottom of your screen. If it shows that the transfer is complete, your system is operating correctly. You may have to click your mouse to change the hourglass icon to a normal pointer.

When you copy image files from your computer to a storage card in your PCMCIA drive, the camera can’t access the images.

- You can’t use this method to upload pictures to the camera. You have to use the EPSON Photo File Uploader3 to convert and upload your images.
Solving Picture Problems

If you’re not satisfied with some of the pictures you get from the PhotoPC 850Z, you may need to adjust some of the camera settings. Read the suggestions below.

Your pictures display poor image quality on the screen or when you print them out.

- PhotoPC 850Z captures images in 24-bit color (16.7 million colors). Your pictures will not display maximum image quality if your monitor or computer’s video controller doesn’t support this color depth. You may need to upgrade your system to achieve the best possible image quality.

- If your pictures look better on the screen than when you print them out, you may need to upgrade your printer. An EPSON Stylus ink jet printer, for example, provides excellent image quality. Also see your printer manual to change your print settings, if necessary.

- If you used drag and drop to insert your pictures, they may appear grainy. Try importing them into your documents instead.

When you preview images on your computer, they look distorted.

- If you are using an STB® Velocity 128 video card and have a screen resolution of 800 × 600 or 640 × 480, you may notice this phenomenon. Slowing down the acceleration on your video card may solve this problem: Click Start, point to Settings, click Control Panel, then double-click System Properties. On the Performance tab, click the Graphics button. Select a slower acceleration and click OK. See your Windows documentation or help system for more information.

The colors in your picture don’t look right.

- When you take pictures under certain artificial lighting conditions, the colors may be slightly distorted. You can adjust your camera’s white balance setting to correct the colors while you are taking photos (see Chapter 5). If
you have already taken photos, you can use your Image Expert software to adjust their colors, as described on page 11-3.

Your picture is blurry or out of focus.

◗ Make sure your subject is within the camera’s range. You should be at least 20 inches away to take a picture without the flash, and 20 inches to 8 feet away to take a picture with the flash. You can take a picture from as close as 8 inches in macro mode.

◗ When you take macro close-ups, make sure you have adequate lighting. Using a tripod will help you capture sharp pictures.

◗ Make sure that your subject isn’t moving and that you hold the camera steady after you press the shutter button (until the camera status light or photo capture light starts flashing).

◗ If you want to photograph a moving subject, try increasing the shutter speed. See Chapter 5 for information about how to change the shutter speed.

◗ Make sure your flash is not set to flash off $\$$.

◗ When you focus on a nearby object, your picture’s background may appear blurry. Try changing your focus.

Your picture is too dark (underexposed).

◗ You may need to use the flash. Make sure the setting is not flash off $\$$.

◗ If you’re using the flash, make sure your subject is within the range of 8 feet.

◗ Use Image Expert to adjust the picture’s brightness and contrast, as described on page 11-4.

◗ Try adjusting the camera’s exposure or sensitivity settings (Use the Manual user mode). See Chapter 5 for details.

◗ If you’re taking pictures in the Manual user mode, look for the EV! warning that appears on your LCD screen when you are taking pictures out of the ideal exposure range. If you have trouble setting both the aperture and
shutter speed manually, try adjusting one setting and letting the camera choose the other setting with Shutter Priority or Aperture Priority (see Chapter 5).

- If you’re using the macro mode to take a close-up photo, be sure to provide adequate lighting for your subject.
- If you’re taking a picture at night and you want to light up the background as well as your subject, use the camera’s slow synchronized flash mode.
- If you need more light, attach an optional external flash to the camera’s hot shoe (see Appendix A).

Your picture is too light (overexposed).

- If you’re using the forced flash setting, it may be too bright. Try setting the flash to Auto.
- If you’re facing a bright light source, you may need to shoot your picture from a different angle.
- Use Image Expert to adjust the picture’s brightness, as described on page 11-4.
- Set user mode to Manual and adjust the camera’s exposure setting (see Chapter 5).

Part of your picture is missing.

- Make sure you’re not blocking the lens with your finger, wrist strap, clothing, or other object.

A horizontal or vertical red line appears on your picture.

- Red lines are caused by glare. Avoid photographing shiny surfaces that reflect excessive amounts of light into your lens.
- Try using the red-eye reduction flash mode when you are photographing areas that have shiny surfaces.

The wrong date and/or time are displayed on your pictures.

- When you change the batteries in your camera, you may need to reset the clock. You can use the LCD screen SETUP menu or set the camera’s clock from your computer. See Chapter 7 or Chapter 12 for more information.

Your pictures don’t look as good as they used to.

- Your camera’s lens may be dirty or dusty. Try cleaning it by following the instructions on page 16-1.
The area captured in the photo is different from what you saw in the viewfinder.

- Make sure you look straight through the viewfinder. Keep in mind that the area visible through the viewfinder is slightly smaller than the area captured in the photo.
- If you’re taking a close-up or macro mode picture, turn the camera dial to so that you can use your LCD screen to preview your picture.

Where To Get Help

EPSON provides technical assistance through electronic support services and automated telephone services 24 hours a day.

The following tables list the contact information:

**Electronic support services**

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Wide Web</td>
<td>From the Internet, you can reach EPSON's Home Page at <a href="http://www.epson.com">http://www.epson.com</a>.</td>
</tr>
<tr>
<td>EPSON Internet FTP Site</td>
<td>If you have Internet FTP capability, use your Web browser (or other software for FTP downloading) to log onto <a href="">ftp.epson.com</a> with the user name anonymous and your e-mail address as the password.</td>
</tr>
<tr>
<td>EPSON Forum on CompuServe®</td>
<td>Members of CompuServe can type GO EPSON at the menu prompt to reach the Epson America Forum. For a free introductory CompuServe membership, call (800) 848-8199 and ask for representative #529.</td>
</tr>
</tbody>
</table>

**Automated telephone services**

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON SoundAdvice®</td>
<td>For pre-recorded answers to commonly asked questions about EPSON products 24 hours a day, seven days a week, call (800) 922-8911.</td>
</tr>
<tr>
<td>EPSON FaxAdvice™</td>
<td>Access EPSON’s technical information library by calling (800) 922-8911. You must provide a return fax number to use this service.</td>
</tr>
<tr>
<td>EPSON Referral Service</td>
<td>For the location of your nearest Authorized EPSON Reseller call (800) 922-8911.</td>
</tr>
</tbody>
</table>
To speak to a technical support representative, dial (562) 276-4303 (U.S.), or (905) 709-3839 (Canada), 6 AM to 6 PM, Pacific Time, Monday through Friday. Toll or long distance charges may apply.

Before you call, please have the following information ready:

- Product name
- Product serial number
- Computer configuration
- Description of the problem

You can purchase manuals and accessories from EPSON Accessories at (800) 873-7766 (U.S. sales only). In Canada, please call (800) 873-7766 for dealer referral. Or visit our website at www.epsonsupplies.com (U.S. sales only).

Software Support

If you are having problems with a software application included with the camera, you can call one of the following numbers for technical support:

- (800) 501-8902 for Sierra Imaging Image Expert software questions. Available weekdays 9 AM to 5 PM, Pacific Time. Or email support@sierraimaging.com. Worldwide support number is (831) 461-4710.
- (562) 276-4303 for the EPSON Photo!3 application and TWAIN driver, the EPSON Photo File Uploader, the EPSON Photo!3 Program Uploader, and the Direct Print software.

Software Licensing

You can install EPSON Photo!3, the EPSON Photo File Uploader, and the EPSON Photo!3 Program Uploader on multiple computer systems. If you want to install Image Expert on multiple computer systems, please contact Sierra Imaging at (800) 501-8902 regarding the licensing fee.
Optional Accessories

You can use a variety of options with the PhotoPC 850Z to enhance its capabilities and convenience. This chapter describes how to use your camera with the following options:

- AC adapter
- Tripod
- Optional lenses and filters
- External flash
- PCMCIA adapter
- Image Authentication System software (for verifying that a photo has not been altered)

You can also purchase an additional NiMH Battery Pak (with 4 batteries) or replacement NiMH Power Pak (which contains a battery charger and 4 batteries). With a backup set of charged batteries, you'll have plenty of battery power. Additional CompactFlash memory cards are also handy to have to store more pictures. Your camera accepts Type I and Type II cards.

These options should be available where you bought your PhotoPC 850Z.
You can order the following options directly from EPSON Accessories at (800) 873-7766 (U.S. sales only) or (800) 873-7766 (in Canada, for dealer referral).

<table>
<thead>
<tr>
<th>Accessory</th>
<th>Product code</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Universal AC Adapter</td>
<td>B867081</td>
</tr>
<tr>
<td>NiMH Battery Pak (4 batteries)</td>
<td>B818113</td>
</tr>
<tr>
<td>Universal NiMH Power Pak (charger and 4 batteries)</td>
<td>B818172</td>
</tr>
<tr>
<td>EPSON Image Authentication System (IAS)</td>
<td>PPC8-IAS</td>
</tr>
</tbody>
</table>

CompactFlash memory cards are available from the various manufacturers like:

- Lexar Media, (800) 789-9418
- SanDisk, (408) 542-0595

Make sure you purchase the correct size card. The PhotoPC 850Z will accept ATA-compatible Type I and Type II CompactFlash cards up to 96MB.

### Using the Optional AC Adapter

The universal AC adapter allows you to connect your PhotoPC 850Z to any standard (110/230 V) outlet. You should use the AC adapter when you are previewing images, transferring images and operating the camera from your computer, or using Direct Print and Print Mark. It is also convenient if you are taking indoor portrait photos.

The adapter powers the camera but does not charge the batteries.

**WARNING**

- Use only the AC adapter designed for the PhotoPC 850Z. Using any other adapter could cause fire, electrical shock, or injury.
- Do not use the AC power cable and the adapter for any purpose other than powering your PhotoPC 850Z.
- If the AC plug doesn’t fit your outlet, have a proper outlet installed by a qualified electrician.
- To avoid radiation danger, do not expose or remove the ferrite core.
To avoid losing any images or settings, make sure the camera has finished processing and is turned off before you connect or disconnect the AC adapter. Then follow these steps:

1. Open the connector cover on the side of the camera.
2. Plug the adapter cable into the DC port on the camera.
3. Plug the AC adapter into an electrical outlet.

Using a Tripod

Follow these steps to use the camera with any standard tripod:

1. Assemble and set up the tripod according to the manufacturer’s instructions. Make sure the tripod is well-balanced on a flat surface.
2. Find the opening for the tripod screw on the bottom of your camera.
3. Carefully place the camera on the tripod. Screw the camera on until it is firmly in place.
4. Adjust the tripod to view your subject as desired.
Attaching an Optional Converter Lens

You can attach a 49 mm telephoto or wide-angle converter lens to the camera using the lens adapter that came with your camera. You can also use 49 mm close up lenses and filters.

You can order accessory Tiffen® lenses and filters from DC Pro Digital Camera Accessories at (800) 522-7835 or (516) 434-8800. For more information, see the brochure that came in your box.

Screw the lens adapter onto the camera’s lens, and then screw the converter lens on it.
Attaching an Optional Flash

You can attach an optional flash unit to the camera to significantly increase the brightness of your images in dark environments. It also works well for portrait photography.

EPSON recommends the following external flash (available through photo specialty shops and mail order catalogs):

   Brand: Metz  
   Model: 32Z-2

Follow these steps to attach the flash and set up your camera to use it:

1. Make sure the camera and flash are both turned off.
2. If necessary, insert batteries into the flash unit as described in the manufacturer’s instructions.
3. Slide the flash onto the top of the camera’s hot shoe as shown below. (See the manual for the flash if you need more detailed instructions.)
4. Turn your camera dial to 1. You see the SETUP menu.

5. Press the bottom left button (next to Shot Setup). You see the Shot Setup menu.

6. Press the + button (next to the Flash Select setting) to change the setting to EXT (external).

7. Turn the camera dial to the setting you want to take a picture.

8. Turn on the flash.

Now you are ready to start using your camera with the flash.

**NOTE**
The camera’s flash modes are disabled when using the external flash. See the flash documentation for information on any available settings.
Using a PCMCIA Adapter

If your desktop or notebook computer has a Type II PCMCIA card slot, you can use a PCMCIA adapter to access images stored on CompactFlash cards.

**NOTE**

- If you don’t have an adapter, you can use Image Expert to transfer photos to your computer. See Chapter 8.
- If you can’t access a card in your notebook computer, contact the computer manufacturer. See page 16-8 for more information.

If you’re using a Macintosh, you must enable PC Exchange extension software to access files on CompactFlash cards. See your Macintosh documentation for information.

For information on installing, formatting, and removing memory cards from your camera, see Chapter 1.

Installing the PCMCIA Adapter

Follow these steps to install the adapter:

1. Insert the memory card all the way into the adapter.
2. Insert the adapter into your computer’s Type II PCMCIA slot.
Transferring Photos With the Adapter

Once the adapter and card are installed in your computer’s PCMCIA slot, you can transfer photos by simply copying them to your hard drive. This is the fastest way to get pictures into your computer. The image files are stored in the DCIM/100epson folder on the card.

- In Windows, use My Computer or the Windows Explorer to drag and drop image files to your hard drive.
- On a Macintosh, use the Finder to drag and drop image files to your desktop or hard drive.

Image Authentication System

If you want to verify the authenticity of photos taken with your camera, you can purchase the EPSON Image Authentication System (IAS). This software detects when even a single bit of digital data in a picture has been altered. Because IAS doesn’t change the file format, it has no effect on your ability to store and display pictures, or to use them in other applications.

For ordering information, see page A-2.
## Specifications

### Camera

<table>
<thead>
<tr>
<th>Physical Dimensions</th>
<th>Power Sources</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width</strong> 4.9 in (125 mm)</td>
<td>Includes 4 AA rechargeable NiMH batteries and charger. Also accepts 4 AA batteries (single-use lithium or rechargeable NiCad)</td>
</tr>
<tr>
<td><strong>Height</strong> 3.1 in (80 mm)</td>
<td>Optional Universal AC adapter (B867081)</td>
</tr>
<tr>
<td><strong>Depth</strong> 2.8 in (70 mm)</td>
<td>Battery life</td>
</tr>
<tr>
<td><strong>Weight</strong> 14.1 oz (400 g) without batteries, strap, and CompactFlash card</td>
<td>Over 2000 minutes using the viewfinder</td>
</tr>
<tr>
<td></td>
<td>Over 1000 minutes using the LCD screen</td>
</tr>
<tr>
<td></td>
<td>Approximately 2 hours playback</td>
</tr>
</tbody>
</table>
## B-2 Specifications

<table>
<thead>
<tr>
<th>Technical</th>
<th>Product type</th>
<th>2.11 megapixel CCD (charged coupled device) still frame auto focus camera</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CCD</strong></td>
<td>0.5 inch color area CCD (2.1 million pixels)</td>
<td></td>
</tr>
<tr>
<td><strong>Image resolution</strong></td>
<td>1600 × 1200 pixels (fine and super fine)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>640 × 480 pixels (standard)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1600 × 600 pixels (panoramic fine)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1600 × 600 pixels (panoramic super fine)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1984 × 1488 pixels* (HyPict)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1984 × 744 pixels* (HyPict panorama)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>* Interpolated</td>
<td></td>
</tr>
<tr>
<td><strong>File format</strong></td>
<td>JPEG</td>
<td></td>
</tr>
<tr>
<td><strong>Bit depth</strong></td>
<td>16 million colors, 24-bit</td>
<td></td>
</tr>
<tr>
<td><strong>Serial communication speed</strong></td>
<td>Up to 230.4 Kbps with high-speed serial port (19.2 Kbps or higher), 1.8 Mbps when connected to EPSON printers</td>
<td></td>
</tr>
<tr>
<td><strong>Serial interface</strong></td>
<td>14-pin dual line terminal to camera, RS-232C-compatible connector to computer (9-pin D SUB connector to PC, 8-pin mini-DIN male connector to Macintosh or printer)</td>
<td></td>
</tr>
<tr>
<td><strong>USB cable</strong></td>
<td>14-pin connector (camera)</td>
<td></td>
</tr>
<tr>
<td><strong>USB connector</strong></td>
<td>USB connector (computer)</td>
<td></td>
</tr>
<tr>
<td><strong>USB communication speed</strong></td>
<td>Up to 12 Mbps</td>
<td></td>
</tr>
<tr>
<td><strong>Video out</strong></td>
<td>NTSC and PAL standards</td>
<td></td>
</tr>
<tr>
<td><strong>Internal ROM</strong></td>
<td>4MB flash program memory</td>
<td></td>
</tr>
<tr>
<td><strong>Expansion memory</strong></td>
<td>8MB CompactFlash storage card; also accepts optional 4MB to 96MB Type I and Type II storage cards</td>
<td></td>
</tr>
<tr>
<td><strong>Self-timer</strong></td>
<td>10 seconds</td>
<td></td>
</tr>
<tr>
<td><strong>Tripod mount</strong></td>
<td>Built-in</td>
<td></td>
</tr>
</tbody>
</table>
## Environmental

<table>
<thead>
<tr>
<th></th>
<th>Operating</th>
<th>Non-operating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>41 to 95 °F (5 to 35 °C)</td>
<td>-4 to 140 °F (−20 to 60 °C)</td>
</tr>
<tr>
<td>Humidity</td>
<td>30 to 90% (non-condensing)</td>
<td>10 to 90% (non-condensing)</td>
</tr>
</tbody>
</table>

## Safety

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>FCC Part 15 Subpart B Class B</td>
</tr>
<tr>
<td>Canada</td>
<td>CSA C108.8 Class B</td>
</tr>
</tbody>
</table>

## Photographic

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Lens</td>
<td>f = 6.5 to 19.5 mm (equivalent to a 35 to 105 mm lens on a 35 mm camera) F2.0 to 2.8</td>
</tr>
<tr>
<td>Auto-focus range</td>
<td>20 inches (50 cm) to infinity (normal) 8 inches to 20 inches (20 cm to 50 cm) (macro mode)</td>
</tr>
<tr>
<td>Manual-focus range</td>
<td>Three settings (approx. 3 ft., 10 ft., and infinity) for normal mode and two settings for macro mode</td>
</tr>
<tr>
<td>LCD screen</td>
<td>2.0-inch low temperature, poly-silicon TFT color LCD (110 thousand pixels) dual lighting: electric lighting and Solar Assist panel</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>Equivalent to ISO 100/200/400</td>
</tr>
</tbody>
</table>
Exposure control
Programmed auto exposure
Exposure value adjustment: −2 to +2 EV, in 9 or 21 steps
Manual shutter speed and aperture settings, and shutter-priority and aperture-priority settings
Spot metering and matrix metering

White balance
TTL automatic white balance
Fixed white balance (5200 °Kelvin)
User-defined white balance

Zoom
3× optical zoom
2× digital zoom

Shutter
Electric iris with mechanical shutter, 4 seconds to 1/800 second

Viewfinder
Real-image optical, with centering crosshair and edge border (view range approximately 90%)

Focus
Automatic focus from 20 inches (50 cm) to infinity
Automatic focus from 8 inches to 20 inches (20 to 50 cm) in macro mode

Aperture
f2 to f11, 1/3 EV steps (zoomed out)
f2.8 to f11, 1/3 EV steps (zoomed in)

Flash
Automatic luminance control flash mode

Flash modes
Forced flash, automatic, flash off, red-eye reduction, leading or trailing slow synchronized flash modes (leading or trailing can be set through the LCD menus), external flash mode for optional external flash (can be enabled through the LCD menus)

---

**Photo Processing Time (approximate)**

<table>
<thead>
<tr>
<th>Quality</th>
<th>Photo processing time</th>
<th>Photo processing time for quick shots</th>
<th>Photo processing time for replay</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>2.0</td>
<td>1.3</td>
<td>0.5</td>
</tr>
<tr>
<td>Fine</td>
<td>2.6</td>
<td>1.5</td>
<td>1.0</td>
</tr>
<tr>
<td>Super fine</td>
<td>3.2</td>
<td>1.5</td>
<td>1.5</td>
</tr>
<tr>
<td>HyPict</td>
<td>12</td>
<td>-</td>
<td>2.0</td>
</tr>
</tbody>
</table>

---

*B-4 Specifications*
Memory Card Picture Capacity

<table>
<thead>
<tr>
<th>Image Mode</th>
<th>#MB Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>120</td>
</tr>
<tr>
<td>Fine/Monochrome Fine</td>
<td>24</td>
</tr>
<tr>
<td>SuperFine/Monochrome</td>
<td>12</td>
</tr>
<tr>
<td>HyPict/Monochrome HyPict</td>
<td>10</td>
</tr>
</tbody>
</table>

NiMH Battery Charger

Physical Dimensions

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>3.0 inches (76 mm)</td>
</tr>
<tr>
<td>Height</td>
<td>4.5 inches (115 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>1.1 inch (28 mm)</td>
</tr>
<tr>
<td>Weight</td>
<td>Approximately 4.6 oz (130 g)</td>
</tr>
</tbody>
</table>

Technical

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>100 to 240 V, 50 to 60 Hz</td>
</tr>
</tbody>
</table>

Optional Universal AC Adapter

Physical Dimensions

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>1.7 inches (43 mm)</td>
</tr>
<tr>
<td>Height</td>
<td>1.22 inches (31 mm)</td>
</tr>
<tr>
<td>Depth</td>
<td>4.1 inches (104 mm)</td>
</tr>
</tbody>
</table>

Technical

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>DC 7 V/2.0 A</td>
</tr>
<tr>
<td>Input</td>
<td>100 to 240 V AC, 50 to 60 Hz</td>
</tr>
</tbody>
</table>

Charging time: 4 batteries: approximately 210 minutes

Power consumption: Approximately 8W

Charging temperature: 41 to 95 °F (5 to 35 °C)

Storage temperature: −4 to 86 °F (−20 to 30 °C)
CompactFlash Card

Storage Capacity
8MB

Physical Dimensions
- Width: 1.7 inches (42.8 mm)
- Height: 1.5 inches (36.8 mm)
- Depth: 0.13 inch (3.3 mm)

Minimum System Requirements
To transfer images to your computer and edit them, make sure your system meets these minimum requirements:

Windows Systems
- IBM-compatible PC with 486 or higher processor
- At least 32MB RAM
- Double-speed CD-ROM drive
- At least 40MB free hard disk space
- VGA or SVGA monitor with at least 256-color display (16-bit color or greater recommended)
- Mouse or other pointing device
- 16-bit sound card and speakers (for audio annotation only)

Serial Connection
- Microsoft Windows 98, Windows 95, or Windows NT 4.0 (Service Pack 3 or later recommended)
- Serial port with standard RS-232C interface (19200 bps or higher)

USB Connection
- Windows 98 PC with built-in USB port

Macintosh Systems
- At least 32MB RAM
- At least 30MB free hard disk space
- CD-ROM drive
- VGA monitor with minimum resolution of 640 × 480
16-bit sound card and speakers (for audio annotation only)

**Serial Connection**
- Macintosh PowerPC with System Software Version 7.5 or later
- Power Macintosh G3 with System Software Version 8.51 or later
- Macintosh modem/printer serial port (19200 bps or higher)

**USB Connection**
- iMac with System Software Version 8.1 and iMac Update 1.0, or iMac with Mac® OS Version 8.51, or later
- Power Macintosh G3 with System Software Version 8.51 or later
- Built-in USB port

---

**NOTE**
If your iMac is running OS 8.1, you’ll need to update your operating system before installing your camera software. Download and install the iMac Update 1.0 or later from Apple at [http://swupdates.info.apple.com](http://swupdates.info.apple.com). Contact Apple if you have problems installing the update. If your iMac is running OS 8.5 or 8.5.1, Apple recommends that you download and install iMac Update 1.1. To find out which operating system your iMac is running, select **About This Computer** in the Apple menu.
Regulatory Information and Warranty

This appendix includes the following important information:

- Safety instructions
- Declaration of Conformity
- FCC Compliance Statement
- Warranty

Safety Instructions

Read all of these instructions before using your camera and battery charger. Also follow all warnings and instructions marked on the camera, battery charger, and batteries.

- To reduce the risk of electric shock, do not remove the camera’s cover or open any of the compartments except as instructed in this User’s Guide.
- To prevent fire or electric shock, do not insert objects through any openings in the camera or battery charger. Do not expose the camera or battery charger to rain or moisture.
- To prevent fire or explosion, do not use the camera or battery charger where inflammable or volatile gas is stored.
- If the camera shows unusual signs such as noise, odor, or smoke, turn it off immediately. Remove the batteries and/or disconnect the AC adapter, and unplug the AC adapter from the electrical outlet.
- If the battery charger shows unusual signs such as noise, odor, or smoke, unplug it immediately.
To avoid damage to the optics of the camera, do not expose the lens to direct sunlight for extended periods of time.

Do not use the charger near water. Never insert or remove the charger’s power plug with wet hands.

Keep the charger away from heat sources. Do not use outside the temperature range of 41 to 95°F (5 to 35°C).

Do not use the charger within reach of children.

Do not insert batteries backwards.

Use only the types of power sources listed on the charger label and in this User’s Guide. Always supply power to the charger directly from a standard domestic electrical outlet.

Do not charge the batteries using an electrical outlet on an airplane.

Do not use the camera outdoors during adverse weather conditions.

Do not store the camera near sources of bright light, direct sunlight, high humidity, heat, excessive dirt or dust, or where it will be exposed to strong vibrations or magnetic fields.

To prevent possible eye injury, do not take flash pictures of faces at close range.

Avoid sudden temperature changes, which can cause moisture to condense on the camera. Keep the camera in a case or bag if you need to move it from a cold environment to a warm one. Allow time for the camera and its optional accessories to adjust to temperature changes before using them.

Do not use a frayed or damaged power cord with the AC adapter.

Remove batteries and/or unplug the camera and the AC adapter and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the camera; if the camera has been dropped or its exterior has been damaged.
damaged; if the camera or its optional accessories do not operate normally or exhibit a distinct change in performance.

- Adjust only those controls that are covered by the operating instructions.
- Do not attempt to service the camera or battery charger yourself. Refer all servicing to qualified service personnel.

If the liquid crystal solution contained in the display panel or in the LCD screen leaks out and gets on your hands, wash them thoroughly with soap and water. If it gets in your eyes, flush them immediately with water.
Declaration of Conformity

We: EPSON AMERICA, INC.
Located at: 20770 Madrona Avenue
MS: B2-11
Torrance, CA 90503
Telephone : (310) 782-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed, is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON
Type of Product: Digital Still Camera
Model: G770A
Product: EPSON PhotoPC 850Z
FCC Compliance Statement

FCC COMPLIANCE STATEMENT
FOR AMERICAN USERS
This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio and television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

▶ Reorient or relocate the receiving antenna
▶ Increase the separation between the equipment and receiver
▶ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected
▶ Consult an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels that exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces.
Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

FOR CANADIAN USERS
This Class B digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Warranty

EPSON AMERICA, INC.
LIMITED WARRANTY

What is Covered: Epson America, Inc. ("EPSON") warrants to the first end-user customer that the EPSON PhotoPC 850Z Digital Camera enclosed with this limited warranty statement, if purchased and used in the United States or Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship and materials for a period of one year from the date of original purchase. EPSON further warrants to the first end-user customer that the Nickel Metal Hydride Battery Charger and four Nickel Metal Hydride Batteries enclosed with this limited warranty statement will be free from defects in workmanship and materials for a period of ninety days from the date of original purchase.

What EPSON Will Do To Correct Problems: Should your EPSON product prove defective during the warranty period, please call EPSON at 562-276-4303 for warranty repair instructions and return authorization, if required. An EPSON service technician will provide telephone diagnostic service to determine whether the unit requires repair. If repair is required, EPSON will, at its option, repair or replace on an exchange basis the defective unit, without charge for parts or labor. If the product requires repair or replacement, it is your responsibility to package it in its original container or an equivalent, along with proof of the date of original purchase and ship it to EPSON. Packaging and shipping costs incurred in presenting your EPSON product for warranty service are your responsibility. Return shipping costs from the EPSON repair facility are EPSON's responsibility. When warranty service involves the exchange of the product or of a part, the item replaced becomes EPSON’s property. The exchanged product or part may be new or previously repaired to the EPSON standard of quality. Exchange or replacement products or parts assume the remaining warranty period of the product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal consumer use in the United States and Canada. This warranty does not cover damage to the EPSON product caused by parts or supplies not manufactured, distributed or certified by EPSON. This warranty does not cover third party parts, components or peripheral devices added to the EPSON product after its shipment from EPSON. EPSON is not responsible for warranty service should the EPSON label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-EPSON products, or service other than by an EPSON Authorized Servicer. If a claimed defect cannot be identified or reproduced in service, you will be held responsible for costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC., NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions. Some jurisdictions do not allow limitations on how long an implied warranty lasts and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights, and you may also have other rights which vary from jurisdiction to jurisdiction.

To locate the EPSON Authorized Reseller nearest you call:
(800) 922-8911
or write to:
Epson America, Inc. • P. O. Box 93012 • Long Beach, CA 90809-9941 • MS: 6-40
Index

A
AC adapter, 4, 2-3, A-2 to A-3, B-5
Accessories, 4, A-1 to A-8
Acquiring photos, TWAIN programs, 8-10 to 8-11
Adjusting camera settings, 2-10, 7-1 to 7-6
Albums
   adding sound to images, 10-8 to 10-9
   copying pictures, 10-2 to 10-3
   copying to diskette or Zip disk, 10-13 to 10-14
   deleting sounds, 10-10 to 10-11
   displaying as slide show, 10-11 to 10-12
   dragging pictures from, 9-4 to 9-6
   editing sound in pictures, 10-10
   moving pictures, 10-2 to 10-3
   organizing pictures, 10-2 to 10-3
   picture information, 10-3 to 10-4
   playing back sounds, 10-9
   printing from camera, 14-11 to 14-12

Albums (continued)
   printing Image Expert albums, 10-4 to 10-8
   renaming pictures, 10-3
   screen saver, 10-12
   setting pictures as wallpaper, 10-12 to 10-13
Alert sounds, setting, 7-3
Aperture priority, 5-4 to 5-5
Aperture setting, 5-3 to 5-5
AppleTalk, 8-3
Attaching neck strap, 1-7 to 1-8
Audio
   adding, 2-9, 2-16 to 2-17, 6-9 to 6-10, 10-8 to 10-9
   deleting, 6-11, 10-10 to 10-11
   editing, 10-10
   playing back, 2-19, 6-10 to 6-11, 10-9 to 10-10
Auto flash, 2-12
Automatic exposure value, 5-2 to 5-3
Automatic power off, setting, 7-1 to 7-2
Index

B
Batteries
  charging, 1-2 to 1-4
  checking, 2-2
  handling, 1-6 to 1-7
  installing, 1-4 to 1-5
  options, 1-6 to 1-7
  replacing, 4
  specifications, B-1
Battery charger, specifications, B-5
Bitmap (BMP) files, 8-13
Black and white pictures, taking, 2-15
Brightness
  correcting images, 11-3 to 11-4
  setting LCD brightness, 7-3
Broadcast signal system, 7-6
Buttons, adjusting settings with, 2-10

C
Cable
  Direct Print, connecting, 14-2 to 14-3
  Macintosh serial, connecting, 8-3 to 8-4
  USB, connecting, 8-4 to 8-5
  video, connecting, 6-18 to 6-20, 13-11 to 13-12
  Windows serial, connecting, 8-2 to 8-3
Camera
  dial settings, 2-1 to 2-2
  features, 1 to 3
  setting up, 1-1 to 1-14
  Camio Viewer, 9-6 to 9-8
  Caring for camera, 16-1 to 16-2
  Charging batteries, 1-2 to 1-4
  Cleaning camera, 16-1 to 16-2
  Clock, setting, 1-10 to 1-11, 7-4 to 7-5
  Close-ups, taking, 4-4 to 4-5
  Color
    correcting, 11-3 to 11-4
    depth, 11-9
    tips, 5-12 to 5-14
  CompactFlash storage cards, see Memory card
  CompuServe, 16-12
  Computer
    connecting camera to, 8-1 to 8-5
    taking pictures from, 12-1 to 12-5
Connecting
  camera, 8-1 to 8-5
  Direct Print cable, 14-2 to 14-3
  serial cable, 8-2 to 8-4
  USB cable, 8-4 to 8-5
  video cable, 6-18 to 6-20, 13-11 to 13-12
Continuous shooting, 3-2 to 3-6
  using interval shooting, 3-4 to 3-6
  using the timer, 3-3 to 3-4
Contrast, correcting, 11-3 to 11-4
Converter lens, A-4
Copying pictures
  in albums, 10-2 to 10-3
  into documents, 9-3 to 9-4
  to diskette or Zip disk, 10-13 to 10-14
Cropping images, 11-5
Custom white balance, 5-10 to 5-11
D
Date and time, setting, 1-10 to 1-11, 7-4 to 7-5
Deleting pictures
  using LCD screen, 6-3 to 6-6
  using quick playback, 2-19
Digital Print Order Format (DPOF) files
  confirming or changing, 15-5
  creating, 15-2 to 15-5
  deleting, 15-6
  description, 15-1
  error messages, 15-8
  reinstalling Print Mark, 15-7 to 15-8
  removing Print Mark, 15-6 to 15-7
Digital zoom, using, 4-1 to 4-3
Diopter, adjusting, 1-14
Direct Print
  connecting the cable, 14-2 to 14-3
  error messages, 14-17 to 14-18
  index, printing, 14-14 to 14-15
  multiple images, printing, 14-4 to 14-9
  photo stickers, printing, 14-12 to 14-14
  print formats, 14-4
  reinstalling, 14-16
  removing from camera, 14-16
  single images, printing, 14-4 to 14-9
  starting, 14-3
Diskettes, copying pictures, 10-13 to 10-14
Display panel
  messages, 14-17 to 14-18
  reading, 2-2 to 2-4
Distorting images, 11-7 to 11-9
Documents, getting pictures into, 9-1 to 9-8, 16-7
Downloading pictures, 8-1 to 8-14, 9-6 to 9-8
DPOF, see Digital Print Order Format
Drag and drop, 9-4 to 9-7
E
Edges, sharpening, 11-8
Index

Editing
    applying Quick Fix to images, 11-3
    images, 11-2 to 11-9
    sounds, 10-10
E-mail, sending pictures, 10-15 to 10-16
Environmental specifications, B-3
EPSON
    automated telephone services, 16-12
    Electronic support services, 16-12 to 16-13
    help, 16-12 to 16-13
    registration, 4
    World Wide Web site, 16-12
EPSON Photo File Uploader, 13-1 to 13-12
EPSON Photo!
    importing images, 8-10 to 8-14
    problems, 8-14 to 8-15
    support, 16-13
    taking pictures, 12-4 to 12-5
    using, 8-12 to 8-15
Equalization, 11-4
Erasing pictures from camera
    using computer, 8-8, 8-11, 8-13, 9-7
    using LCD screen, 2-19, 6-3 to 6-6
Error messages
    on camera display panel, 14-17 to 14-18, 15-8
    on computer, 8-9 to 8-10, 8-14, 16-5

Exporting images, 8-12 to 8-13
Exposure
    adjusting, 5-1 to 5-5
    aperture setting, 5-3 to 5-5
    predefined settings, 5-1 to 5-3
    shutter speed setting, 5-3 to 5-5
    tips, 5-12 to 5-14
F
FaxAdvice service, 16-12
Features, camera, 1 to 3
Files
    BMP, 8-13
    converting during transfer, 8-12 to 8-14
    JPEG, 8-12 to 8-13, 9-2, 9-3
    PCX, 8-13
    PICT, 8-13
    resizing, 11-5 to 11-6
    uploading, 13-1 to 13-8
    viewing information, 10-3 to 10-4
Filters, optional, A-4
Fine image quality, 2-11
Fisheye effect, 11-8
Flash
  optional, A-5 to A-6
  problems, 16-3
  using, 2-12 to 2-14
Flash off, 2-12
Flipping images, 11-7
Focus, adjusting, 4-5 to 4-6
Forced flash, 2-12
Formatting the memory card, 1-12, 16-8
FTP, 16-12
Full Auto mode, description, 1-13

G
Glass blocks effect, 11-8

H
Handling batteries, 1-6 to 1-7
Help, EPSON, 16-12 to 16-13
HyPict image quality, 2-11

I
Image Authentication System, 4, A-8

Image Expert
  albums, 9-4 to 9-6, 10-2 to 10-14
  audio tools, 10-9
  camera settings, changing, 12-5 to 12-7
  Camio Viewer, 9-6 to 9-8
  color correcting, 11-3 to 11-4
  color depth, changing, 11-9
  copying pictures to diskette, 10-13 to 10-14
  correcting images, 11-3 to 11-4
cropping, 11-5
documenting pictures, 11-1 to 11-9
d-mailing pictures, 10-15 to 10-16
derror messages, 8-9 to 8-10
flipping images, 11-7
picture information, 10-3 to 10-4
printing, 10-4 to 10-8
Quick Fix, 11-3
resizing images, 11-5 to 11-6
resolution, changing, 11-5 to 11-6
rotating, 11-6 to 11-7
screen saver, 10-12
selection tools, 11-2
slide shows, 10-11 to 10-12
sound, adding, 10-8 to 10-9
sound, deleting, 10-10 to 10-11
sound, editing, 10-10

Index 5
Image Expert (continued)
special effects, 11-7 to 11-9
taking pictures from computer, 12-1 to 12-3
transferring pictures, 8-6 to 8-10, 9-6 to 9-8
wallpaper, 10-12
zoom tool, 11-2
Image quality, setting, 2-10 to 2-11, B-2
Importing photos, 8-10 to 8-11, 9-2 to 9-3
Index, printing, 14-14 to 14-15
Information, displaying, 6-13, 10-3
Installing
batteries, 1-4 to 1-5
Direct Print in camera, 14-16
memory card, 1-8 to 1-10
PCMCIA adapter, A-7
Print Mark in camera, 15-7
software, 1-15 to 1-17
USB driver, 1-16
Internet, 16-12
Interval shooting, 3-4 to 3-6
Inverting images, 11-7

J
JPEG files, 8-12 to 8-13, 9-2, 9-3

L
Landscape subject setting, 3-7
Language, setting, 7-5 to 7-6
LCD screen
brightness, 7-3
deleting pictures, 6-3 to 6-6
magnifying pictures, 6-12 to 6-13
playing back pictures, 6-1 to 6-20
problems, 16-4
specifications, B-3
taking pictures with, 2-6 to 2-10
Leading flash, 2-13
Lenses, optional, A-4
Licensing software, 16-13
Live preview, 12-1 to 12-5
Locking pictures, 6-6 to 6-8

M
Macintosh
capturing screens, 13-10 to 13-11
connecting to camera, 8-1 to 8-4
installing software, 1-17
uploading pictures, 13-5 to 13-10
Macro mode, using, 4-4 to 4-5
Magnifying pictures, 6-12 to 6-13
Maintenance, 16-1 to 16-2
Manual mode, description, 1-14
Memory card
  capacity, B-5
  dimensions, B-6
  formatting, 1-12, 16-8
  installing, 1-8 to 1-10
  removing, 1-12
  uploading images to, 13-1 to 13-8
Metering method, changing, 5-11 to 5-12
Monochrome pictures, taking, 2-15

N
Neck strap, attaching, 1-7 to 1-8
Negative images, 11-8
NiMH Power Pak, ordering, 4

O
Optical zoom, 2-5, 2-8
Options
  AC adapter, 4, 2-3, A-2 to A-3
  AC adapter, specifications, B-5
  converter lens, A-4
  flash, A-5 to A-6
  Image Authentication System, A-8
  PCMCIA adapter, A-7 to A-8

Options (continued)
  tripod, using, A-3

P
Panoramic pictures, 4-3 to 4-4
PCMCIA adapter, A-7 to A-8
PCX files, 8-13
Photo File Uploader, 13-1 to 13-12
Photo processing time, B-4
Photo stickers, printing, 14-12 to 14-14
Photographic specifications, B-3
Physical dimensions, B-1
PICT files, 8-13
Picture counter, checking, 2-3 to 2-4
Pictures
  black and white, 2-15
  capturing from computer, 12-1 to 12-5
  close-ups, 4-4 to 4-5
  color correcting, 11-3 to 11-4
  color depth, changing, 11-9
  converting, 9-2 to 9-3
  copying in albums, 10-2 to 10-3
  copying to diskette, 10-13 to 10-14
  correcting, 11-2 to 11-4
  cropping, 11-5
  deleting with camera, 2-19, 6-3 to 6-6
Index

Pictures (continued)
- displaying information, 6-13, 10-3
- editing, 11-1 to 11-9
- e-mailing, 10-15 to 10-16
- erasing with computer, 8-8, 8-11, 8-13, 9-7
- exporting, 8-12 to 8-13
- flipping, 11-7
- locking, 6-6 to 6-8
- macro mode, 4-4 to 4-5
- magnifying, 6-12 to 6-13
- organizing in albums, 10-2 to 10-3
- panoramic, 4-3 to 4-4
- playing back, 6-1 to 6-3, 6-18 to 6-20
- printing from camera, 14-4 to 14-15
- printing from computer, 10-4 to 10-8
- problems, solving, 16-9 to 16-12
- quick shots, 3-1 to 3-2
- resizing, 11-5 to 11-6
- rotating, 11-6 to 11-7
- screen saver, 10-12
- selecting sections, 11-2 to 11-4
- slide shows, 6-14, 10-11 to 10-12
- special effects, 11-8 to 11-9
- transferring from camera, 8-1 to 8-14, 9-6 to 9-8
- unlocking, 6-8
- uploading, 13-1 to 13-8

using digital zoom, 4-1 to 4-3
viewing information, 10-3 to 10-4
wallpaper, 10-12
Playing back pictures, 2-17 to 2-19, 6-1 to 6-20
Portrait subject setting, 3-6
Power
- AC adapter, 2-3, B-5
- battery, see Batteries
- camera specifications, B-1
- problems, 16-2
- Power off interval, setting, 7-1 to 7-2
- Power Pak, ordering, 4
- Presentations, using camera for, 13-1 to 13-12
Print Mark
- error messages, 15-8
- reinstalling, 15-7
- removing from camera, 15-6 to 15-7
Printing photos from camera
- album format, 14-11 to 14-12
- cards, 14-9 to 14-10
- index of images, 14-14 to 14-15
- photo stickers, 14-12 to 14-14
- print formats, 14-4
- single images, 14-4 to 14-9
Printing photos from computer
   adding text, 10-6
   adjusting printed area, 10-7 to 10-8
   choosing album images, 10-7
   layout styles, 10-4 to 10-6
Problems
   camera, 8-14 to 8-15, 16-2 to 16-8
   Direct Print, 14-17 to 14-18
   EPSON Photo3, 8-14 to 8-15
   flash, 16-3
   LCD screen, 16-4
   picture, 16-9 to 16-12
   Print Mark, 15-8
Program mode
   description, 1-13
   using programmed subject settings, 3-6 to 3-7
Projector, playing back pictures and presentations, 13-11 to 13-12
Protecting pictures, 6-6 to 6-8
Q
   Quick Fix, 11-3
   Quick playback, 2-17 to 2-19
   Quick shots, taking, 3-1 to 3-2
R
   RAM, system requirements, B-6
   Recordings
      adding, 2-9, 2-16 to 2-17, 6-9 to 6-10
      deleting, 6-11, 10-10 to 10-11
      playing back, 2-19, 6-10 to 6-11
   Red-eye reduction flash setting, 2-12
   Registration, 4
   Removing Direct Print from camera, 14-16
   Removing memory card, 1-12
   Removing Print Mark from camera, 15-6 to 15-7
   Resizing files, 11-5 to 11-6
   Resolution, 2-10 to 2-11, 11-5 to 11-6, B-2
   Ripples effect, 11-8
   Rotating pictures, 11-6 to 11-7
S
   Safety instructions, C-1 to C-3
   Save to Floppy option, 10-14
   Screen captures, 13-8 to 13-11
   Screen saver, album as, 10-12
   Self timer, using, 2-14 to 2-15, 12-3 to 12-5
   Sending pictures by e-mail, 10-15 to 10-16
   Sensitivity, adjusting, 5-6 to 5-8
   Serial cable, connecting, 8-2 to 8-4
Serial interface, B-2
Setting up camera, 1-1 to 1-14
Settings
  adjusting, 7-1 to 7-6
  alert sounds, 7-3
  automatic power off, 7-1 to 7-2
  color/black and white, 2-15
  date and time, 1-10 to 1-11, 7-4 to 7-5
  exposure, 5-1 to 5-5
  focus, 4-5 to 4-6
  image quality, 2-10 to 2-11
  language, 7-5 to 7-6
  LCD brightness, 7-3
  macro mode, 4-4 to 4-5
  metering method, 5-11 to 5-12
  panoramic pictures, 4-3 to 4-4
  programmed subject settings, 3-6 to 3-7
  sensitivity, 5-6 to 5-8
  shutter speed and aperture, 5-3 to 5-5
  time and date, 7-4 to 7-5
  user mode, 1-14
  white balance, 5-8 to 5-11
Sharpness, adjusting, 11-4

Shutter
  adjusting speed, 5-3 to 5-5
  predefined exposure adjustments, 5-1 to 5-3
  snapping, 2-4
Shutter priority, 5-4 to 5-5
Signal, broadcast, 7-6
Slide shows
  excluding pictures, 6-16
  playing pictures, 6-14 to 6-18, 10-11 to 10-12
  playing sounds, 6-15
Slow synchronized flash, 2-13
Software
  included on CD-ROM, 3
  installing, 1-15 to 1-17
  licensing, 16-13
  support, 16-13
Sound
  adding, 2-9, 2-16 to 2-17, 6-9 to 6-10, 10-8 to 10-9
  deleting, 6-11, 10-10 to 10-11
  editing, 10-10
  playing back, 2-19, 6-10 to 6-11, 6-15, 10-9
  recording, 10-8 to 10-9
SoundAdvice, 16-12
Special effects, 11-8 to 11-9
Specifications
AC adapter, B-5
battery charger, B-5
environmental, B-3
memory card, B-5, B-6
photographic, B-3 to B-4
physical dimensions, B-1
power, B-1
safety, B-3
technical, B-2
Sports subject setting, 3-6
Standard image quality, 2-10
Status display panel
messages, 14-17 to 14-18
reading, 2-2 to 2-4
Stickers, printing, 14-12 to 14-14
Storing camera, 16-2
Strap, attaching, 1-7 to 1-8
Subject settings, 3-6
Super fine image quality, 2-11
Support
EPSON, 16-12 to 16-13
software, 16-13
System requirements
Macintosh, B-6 to B-7
Windows, B-6

T
Taking pictures
using the flash, 2-12 to 2-14
with the LCD screen, 2-6 to 2-10
with the timer, 2-14 to 2-15
with the viewfinder, 2-4 to 2-6
Technical support, 16-12 to 16-13
Television, playing back pictures, 6-18 to 6-20, 7-6
Time and date, setting, 1-10 to 1-11, 7-4 to 7-5
Timer, using, 2-14 to 2-15, 3-3 to 3-4, 12-3 to 12-5
Trailing flash, 2-13
Tripod, attaching, A-3
Troubleshooting, 16-2 to 16-11
TWAIN programs, acquiring photos, 8-10 to 8-11

U
Unlocking pictures, 6-8
Unpacking the camera, 1-1
Uploading pictures, 13-1 to 13-8
USB
installing driver, 1-16
system requirements, B-6 to B-7
USB cable, connecting, 8-4 to 8-5
User mode, setting, 1-14
V
VCR, playing back pictures, 6-18 to 6-20
Video cable, 13-11
Videotaping pictures, 6-18 to 6-20
Viewfinder, adjusting focus, 1-14
Voice recordings
adding, 2-9, 2-16 to 2-17, 6-9 to 6-10, 10-8 to 10-9
deleting, 6-11, 10-10 to 10-11
editing, 10-10
playing back, 2-19, 6-10 to 6-11, 10-9 to 10-10
Volume, setting, 7-4
W
Wallpaper, setting pictures as, 10-12 to 10-13
White balance
adjusting, 5-8 to 5-11
fixed, 5-8
user-defined setting, 5-8, 5-10 to 5-11
Windows
capturing screens, 13-8 to 13-10
connecting with serial cable, 8-2 to 8-3
connecting with USB cable, 8-4 to 8-5
installing software, 1-15 to 1-16
system requirements, B-6
uploading pictures, 13-2 to 13-5

World Wide Web, 16-12
Z
Zoom tool, Image Expert, 11-2
Zoom, optical, 2-5, 2-8
Zoom, using digital zoom, 4-1 to 4-3

12 Index